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Serendipity Megarip User Manual

Copyright © 2009 Serendipity Software Pty Ltd

Reproduction of any part of this user manual is strictly forbidden without prior written permission from Serendipity
Software Pty Ltd. All company names, product names and trademarks mentioned in this manual are the property of the
respective company.

Important Notice

Every effort is made to ensure the information contained within this user manual is correct. Serendipity Software Pty
Ltd cannot be held responsible for any errors contained within this user manual and will not enter into any
negotiations for claims of compensation relating to actions taken resulting from the information provided in this user
manual for any reason whatsoever.

Serendipity Software Pty Ltd is constantly making improvements to the software and as such, this user manual may not
contain the latest information. Every effort is made to maintain the user manual and for the latest version please check
the website:

http://www.serendipity-software.com.au

If you find any errors within this user manual, please detail them in an email to: support@serendipity-software.com.au

Supporting Tutorial and HowTo documentation is available on our website:

http://www.serendipity-software.com.au/support
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Serengipity Megarip

Product Overview

Serendipity Megarip is a high speed raster image processor (RIP) capable of accepting a variety of file formats, such as
Postscript Level 3, PDF, TIFF, JPEG, PNG, Scitex CT and EPS. It is used to proof post-RIP data to either an output device,
such as an Inkjet printer or to a file format, such as PDF.

Serendipity Megarip runs in a Server and Client configuration. The Server runs on a computer on the network and is
protected by a USB dongle. The dongle licenses the level of software and the input filters and output drivers purchased.

The Client can run on the same computer on the network, whether it is local (LAN) or remote (WAN). The Client
connects to the Server using the standard network protocol TCP/IP and is used as the configuration tool and
monitoring application to the Server. The Client is not licensed and can be run multiple times on the network.

Jobs are sent to Serendipity Megarip in a variety of ways to suit your workflows. Printers can be published on the
network in order for jobs to be printed from your usual desktop applications. Hot folders (Drop Folders) can be shared,
where files can be copied or saved for processing. Files can also be submitted directly from the Client or drop zones can
be created for dragging and dropping files in. Once a file is submitted it is spooled into the system, the file type is
detected and it is passed on for processing.

Imaging is the first process to take place. Imaging interprets the file format and samples the job’s resolution to change it
to that of the configured output format. By doing so, an intermediate file is generated, called the Imaged file. The
Imaged File can be viewed using the SoftProof utility. The file format maintains all the plates associated with the job
and is viewed at the full output resolution. The Imaged File can also be re-submitted at any time for processing to the
same or a different output. There is no need to spool and interpret the job again.”

After the imaging process has completed, the job is passed to the rendering engine. This takes the Imaged File and
creates the file ready for output. The process includes applying any output characteristics such as orientation, cropping,
colour management (ICC Profiles) and creation of the configured format, whether for an Inkjet printer or a file format,
such as PDF.

The Imaged File can be rendered as many times as desired. Each time, any of the output characteristics can be changed
prior to rendering.

Once the job is rendered, it is submitted for printing to the output device or file format. Multiple output queues can be
created and multiple devices can be printed to simultaneously. Most of the output devices supported use a direct
printer driver and therefore the Server has more control of options, such as, selecting specific media and printing
directions.

The Client monitors the whole process from start to finish, showing a jobs progress in a QueueManager and
QueueStatus window. Jobs can be managed separately by placing a job on hold, releasing a job, cancelling or promoting
as desired. The processes (queues) can be paused at any time, holding all jobs from spooling, imaging, rendering or
printing. If a job fails, the error can be examined, rectified and the job retried. There are logs reporting all Server and
Client functionality and job information from first detection on the RIP to final output. The logs can be searched, filtered
or saved to a file.

The system creates a database of all configurations, calibration curves and other settings. This database can be backed-
up on demand or automatically, so a working copy is always available. It can be copied to any other Serendipity
Megarip as a whole database or as individual items.

*This applies to any output characteristics.
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Installation

The installation section describes the process for each platform in turn.

The software is supplied on one CD for Macintosh, Linux and Windows versions. All versions come with a dongle and
require a dongle driver be installed. Existing installations of the software are given the opportunity to upgrade,
preserving any existing configurations.

What's on the CD?
The CD contains all elements required to run Serendipity Megarip and associated programs. They are divided into
directories, detailed below:

* Docs - Contains all documentation.

* Dongle - Contains the dongle drivers for Linux, MacOSX and Windows.

* Drivers - Contains the Megarip PPDs for all supported platforms.

¢ HTML - Contains the information required for the web browser install. This automatically launches the default
browser for installation to begin.

¢ Linux - Contains the Serendipity Megarip and AppleTalk installation packages for Linux.

* MacOSX - Contains the Serendipity Megarip installation package for MacOSX.

* Serendipity Client - Contains the Serendipity Client for all supported platforms.

* TestPrint - Contains Serendipity internal test prints.

* Windows - Contains the Serendipity Megarip installation package for Windows.

Windows Installation

If you are upgrading from version 4 to version 5, see “Windows - Upgrade from V4 to V5”.

Installing the Dongle Driver - Linux & Windows
The first step is to install the dongle driver.

To install:

Remove all USB SuperPro dongles.

On the CD, navigate to the dongle/windows directory.

Double click the Sentinel Protection Installer 7.5.0.exe file to launch the installer.
Follow the onscreen instructions to complete the installation.

Restart the computer when finished.

ik e

Installing Serendipity Megarip

The next step once the dongle driver is installed is to install Serendipity Megarip.
To install:

1. Either select and run the Megarip installer by clicking the link on the browser page (if it pops up as an Autoplay
when the disk is inserted), or go to the CD and navigate to the Windows directory to run the file megarip.msi

2. Select Next to continue.

3. Read the License Agreement and click Yes to continue. Click No if you do not agree with the License Agreement
to terminate the installation.

4. Click Next to choose the default installation location. If you wish to change the location, select Browse, choose
the location and click OK followed by Next to continue.

Note: You can type your own path and the installation program will make the folder for you, provided your chosen
location has valid permissions. Use back slashes (\) to separate directories.

5. Click Install to start the installation.
6. Click Finish once the installation has completed.

Serendipity Megarip User Manual - Version 5 6



Windows - Upgrade from V4 to V5

The Megarip Version 5 installer automatically upgrades the V4 database to the updated V5 format. As a precaution
however, when upgrading from version 4 it is strongly recommended that the database and ICC profiles are backed-up
prior to the install (See the “Backing-up V4” section).

Installing the Dongle Driver Update

Version 5 dongles (new or upgraded) require an up-to-date Safenet dongle driver in order to function.

To upgrade:

1.

N

AR

Make sure the Megarip Server and Client are not running and remove any Megarip (or any other SuperPro
USB) dongles from the computer.

On the Megarip installation CD, navigate to the dongle/windows directory and run the Sentinel Protection
Installer 7.5.0.exe file. Alternatively, download and run the latest driver installed from the Safenet website.
Run the Sentintel installer.

Select Upgrade and Next.

Follow the on-screen instructions to complete the upgrade.

Restart the computer.

Installing the Software Upgrade

1.
2.
3.

4,

v

On the CD, navigate to the windows directory and run the megarip.msi file.

Click Next to continue.

Read the License Agreement and click Yes to continue. Click No if you do not agree with the License Agreement
to exit the install.

Select the directory where Version 4 is installed and click Next.

Select Install to start the upgrade installation.

Click Finish when the installation has completed.
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Macintosh Installation
Administrator rights are required for the installation of the Macintosh version of Megarip. If you are upgrading from V4
to V5, see the “Mac OS X - Upgrade from V4 to V5” section.

Note: From Megarip version 4.2.01 onwards there is no separate dongle driver to install. The driver is installed as part
of the general installation package.

Installing Serendipity Megarip

1.

Vi W

No

Go to the MacOSX directory on the Megarip installation CD and double click the file Serendipity Megarip.pkg
to launch the installation.

Select Continue.

Read the License Agreement and click Continue.

Select Agree.

Choose the location to install the Software and click Continue. If you want to install to a folder that does not
exist, you need to create it through the Finder.

Click Install to begin the installation.

Click Close once the installation has completed.

Creating Dock Start Icons
To make it easy to start the Server and Client, it is recommended you create a Dock shortcut. To do this:

1.

Run the Megarip Server and Client applications from the installation location, wusually the
Applications/Serendipity Megarip directory.

Once the Server and Client icons appear in the dock, right click (or CTRL+click) the mouse and select Keep in
Dock from the menu.

Alternatively, drag the Server and Client icons directly onto the Dock before they have been launched.

To remove the Dock icons, drag them off the Dock onto the desktop and release.

Mac OS X - Upgrade from V4 to V5

The Megarip Version 5 installer automatically upgrades the V4 database to the updated V5 format. However, as a
precaution, when upgrading from version 4 it is strongly recommended that the database and ICC profiles are backed-
up prior to the install (See the “Backing-up V4” section).

To upgrade:
1. On the CD, navigate to the directory MacOSX and run the file Serendipity Megarip.pkg
2. Click Continue.
3. Read the License Agreement and click Continue.
4. Select Agree.
5. Select the drive and location to install the software. Choose the folder Serendipity where V4 Megarip is

N o

currently installed.
Select Upgrade to begin the installation.
Click Close when the installation has completed.
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Backing up V4
Before upgrading to Version 5, it is strongly recommended that you backup your current version of software. There are
a number of methods you can use to do this, which have been detailed below.

Using the Archiver
The Archiver application in Megarip can be used to create a backup of your configurations. To make a backup of your
entire database:

1. Select Application Menu > Archiver from the Client window.

2. Once the Archiver has opened, select Edit Menu > Add to Archive (All) to add all items to the archive file.
Alternatively, you can right click and select this option from the contextual (right click) menu.

3. Select Save Archive and choose an appropriate location to store the file.

If you need to import all or part of the database after the V5 upgrade install:

1. Open the Archiver application.
2. Select Open Archive > Add to Database and choose the items to add or add the whole archive.

For further information, see the main “Archiver” section within this user manual.

Saving the V4 Database and ICC Profiles
Another recommended method is to backup the Database and ICC profiles by copying them to another location before
upgrading,.

The Database items are held in a folder called defaultss.dbd in the following locations:

Macintosh: /Applications/Serendipity Megarip/lib/defaultss.dbd
Windows: C:\Serendipity\Serendipity Megarip\lib\defaultss.dbd
Linux/Sun/SGI: ~bmagic\lib\defaultss.dbd

ICC Profiles can be found in the following locations:

Macintosh: /Applications/Serendipity Megarip/lib/ICC
Windows: C:\Serendipity\Serendipity Megarip\lib\ICC
Linux/Sun/SGI: ~bmagic\lib\ICC

If you make a backup of these files you can restore them if the upgrade has any problems.

Using the Database from V4
The third method for upgrading and preserving the existing configurations is to make a fresh install in a new location,
leaving the previous version untouched.

Before starting the Server for the first time, copy the defaultss.dbd file and ICC profiles into the new installation. See
above for locations of V4 items.

As Version 5 starts for the first time, the Database will be converted to the new structure automatically.

Important Note: Pagesetup archives imported from Version 4 to Version 5 will automatically be split into Media and
Pagesetup data types for the relevant configuration settings. Version 5 archives cannot be opened or loaded into
previous versions of the software.

9 Serendipity Megarip User Manual - Version 5



Running the Software

Once the software has been installed, launch the Server and Client to begin the configuration. The Server should be
started first and allowed to complete its initialisation process before the Client is launched. If the Client is started first,
it will attempt to connect to an active Server. If none are present, a Connect to Server window will open, waiting for an
active Server to appear on the network.

Starting the Server
1. Plugthe dongle into a USB port.
2. Launch the Server by double clicking the Serendipity Megarip file in the install directory, or the
shortcut desktop/dock icon.

Serendipity Megarip

The Server window will appear showing information about the Server software and the initialisation
process will commence.

Note: The Server will not initialise if a recognised dongle is not present on the computer from which it is run. If the
dongle is removed at any point while the Server is running, all job processing will cease and the Server will stop shortly
afterwards. Once the dongle is reconnected, close and restart the Server.

Starting the Client
Once the Server has completed initialisation the Client application can be opened.

1. Launch the Client by double clicking the Serendipity Client file in the install & '»
directory, or the shortcut desktop/dock icon. Serendipity Client

The Client will connect to the active Server and display the factory default Monitor window in the centre of the screen.
From this point, configuration of the system or loading a pre-configured setup can be done.

On first setup, you will be required to select the default Display and Match ICC Profiles. Once this has been done, the
Monitor window will open and the Client will be ready for further configuration.

Choose Application Menu > System Settings

Select Server tab > Colour Management tab.

Click on Change System Specials and select Reference-Lab (or your own specials) and click OK.

Select the Client tab > General tab and choose your language under Internationalisation. English is the default.
Click OK to dismiss the System Settings window and apply the changes. A restart of the Client Application is
required if the language settings are changed.

ok wN

Configuring Manually
This section will explain how to setup a basic configuration to print a file to a printer and monitor the job throughout
the process. For more detailed information on specific modules, see the relevant sections of this user manual.

The factory default Monitor currently only has system queues. Specific queues will need to be configured for the
abovementioned process.

There are three (3) sections that need configuring in order to process jobs to the printer.
These are:

* APagesetup and Media where jobs are processed; and
*  An Output where the print job is sent.

Note: Before a Pagesetup can be created first create a Media and an Output, as each Pagesetup must be linked to a valid
one of each.

Serendipity Megarip User Manual - Version 5 10



Output Configuration
1. Inthe Serendipity Client, select Application > Workbench
2. Select the Output from the Data Types list and create a new output.
3. The name “Untitled” should be highlighted. If not, select it, type a new name and press Enter. This Output will
appear in the Pagesetup.

Now configure the output to your requirements:

4. Select the appropriate driver for your printer from the pull down list of licensed modules in the Queue section.

5. Choose a destination driver from the Destination section and enter the appropriate information, for e.g, the IP
address of the printer.

6. Configure any Collating or Nesting requirements as needed.

7. OPTIONAL - Once created, the Media can be assigned to the Output using the Change Media button. This will
only allow jobs submitted using the assigned Media to print. Refer to the “Media” section of this manual for
more information.

8. Save the setup.

Media Configuration
1. Inthe Serendipity Client, select Application > Workbench
2. Select the Media from the Data Types list and create a new output.
3. The name “Untitled” should be highlighted. If not, select it, type a new name and press Enter. This name will
appear in the Output and Pagesetup.

Now configure the Media to your requirements:

4. Select the appropriate driver for your printer from the pull down list of licensed modules in the Output Driver

section.

Configure your Resolution, Colourspace and any custom settings required.

6. Choose your ICC profiles and method of Output Screening to be applied. Colour Correction LUT’s may also be
assigned here.

7. Save the setup.

v

Pagesetup Configuration
Once an Output and a Media are configured and saved:

1. Choose Pagesetup from the Data Types list and create a new Pagesetup. This will automatically select the
Output created above.
2. The name “Untitled” should be highlighted. If not, select it, type a new name and press Enter.

Initially, the most important parts to configure are the Output and Media linked to the Pagesetup.

Assign the Output to the Pagesetup using the Change Output button.

Assign the Media to the Pagesetup using the Change Media button. This is the default Media for the Pagesetup.
Jobs will be printed using this Media unless another is chosen when the job is submitted.

Apply any Colour Correction Curves if required.

Go to the ICC Profiles section. Select files for RGB ICC & Press ICC profiles respectively.

Configure the other panels of the Pagesetup to suit your requirements.

Choose File > Save

-~ w

XN U

Further details on how to configure a calibrated Media and Pagesetup are available on our website, under the HowTo
Guides section: http://www.serendipity-software.com.au/support
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Monitor Configuration
Once base configuration is complete, the Monitor needs to be configured so jobs can be managed throughout the

system.

1.

From Menu, select Window > Monitor (if the Monitor is not running select Application > Monitor). Make sure
the Queues tab is selected in the Monitor window (top of screen).

The basic factory setup has a QueueManager, QueueStatus, Thumbnails and Logs that are set to look at default queues.
These are configured across two tabs.

The QueueManager (top half) needs to be configured to look at the Spool, Auto Detect, Image, Render and new Printer
(Output) queues to monitor and manage jobs through the system.

To configure:

2.

4,

Right click in the QueueManager section and
select Configure > Queue Order

Select all the queues on the left and drag them
across to the right list at the bottom.

Click OK.

Now configure the QueueStatus window in the bottom
left corner. These monitor the jobs progress in a
particular queue.

5.

6.

8.

Right click in the QueueStatus window
(bottom right) and select Queue Order.

Select Image, Render, Spool and new Printer
and drag them over to the right side. No need
to monitor Auto Detect here.

Select Spool in the right list and drag it to the
top of the list. The order should be Spool,
Image, Render, Printer.

Click OK when done.

Monitor - NFR (not for resale)@localhost:9100

( Queues | Logs

Show: | Jobs

#. Imaging: Idie

™

%) ™ Active # Waiting ™ Done

The Monitor now has a basic setup. Test it out by printing an internal test print.

9.

Choose Application Menu > Test Prints

10. Select your Pagesetup and Media, then tick the Quickcal checkbox and click Submit.

You should see the test print move through the various queues and be sent to the printer.

Serendipity Megarip User Manual - Version 5
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The Serendipity Megarip Server

The Megarip Server runs on the machine where the dongle is installed. The Server handles the processing of all jobs
through the system and must be started before the Client is launched.

As the Server starts, it checks to ensure a valid dongle is installed on the machine and which modules are enabled
(licensed). The Server calculates the speed of the machine it is running on and checks the integrity of the database
before loading it.

Once the Server is up and running, a clock keeps track of the duration the Server is operational.

Server Options
The window below displays the Server information and various options once it is running.

e 00 Serendipity Megarip

Serengdipity Megarip

Serendipity Megarip version 5.0 (Build 21029)
Copyright Serendipity Software Pty Ltd 1994 - 2009 All rights
reserved
Built: Jul 23 2009 10:01:03
NFR (not for resale) dongle detected
Dongle serial no: 4a0b7a45 Obf1

Listening for client connections on port 9100

Uptime: 00:00:36 ( Stop server Speed: 483.54

File Menu Options
* Stop Server - Stops the Server from running without quitting Serendipity Megarip.

e Start Server - Starts the Server if it is in a Stopped state. Stop server
* Restart Server - Restarts the Server. e ke
* Update Dongle - Allows users/administrators to update the dongle with activation Update dongle

strings to enable various input and output licenses.

* C(Close - Closes the window. If the Server is running you are warned and asked to
confirm Server shutdown.

* About - Shows information about the Server. Clicking More/Less info shows or hides valid dongle options,
including the versions of the current drivers.

Close BW

Startup Options

e Start Server on Launch - The Server will start once the application is
launched. v Start server on launch

* Restart Server After Crash - Restarts the Server automatically after a cr.ash. ~ Restart server on crash

¢ Start as Cluster Node - Allows the Serv-er to runasa slave or pode device. See Start as cluster node
the Cl_usterManager sec.tlon.for further information on Clustering. - Startin Eaheirnode

¢ Start in Safe Mode - This will start the Server but will not process any jobs or
poll any RIPs. This is a maintenance mode that allows configuration management if they become corrupt or
incorrectly configured. Once maintenance is complete the Server must be restarted in normal mode.
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Megarip Dongle Updater

The Serendipity Megarip dongle licenses the level of software and enables the use of any input filters and output
drivers. If any additional licenses (available for a fee) are activated, the relevant dongle will require updating with the
new strings in order to use the filters and/or drivers.

The Dongle Updater is now a built-in feature, accessed via the Server File Menu > Update Dongle option.
To avoid any abuse of the software, the dongle activation strings can only be used once. Any updating should be
completed by your relevant Server administrator.

Important Note: Before updating any dongles, please ensure your Server is in Stop mode.

Updating the Dongle

Before updating the dongle, you must have received a shipment email with the
new strings included. This will either come from Serendipity Software directly, or
via your Dealer contact.

Version 5 requires two (2) activation strings for entry in order to update the
dongle. The strings are separated in the email by a space.

To update a V5 dongle:

BN

v

6.
7.

8.

Dongle Updater

Key Code 1

Key Code 2

Plug the current V5 USB dongle into your computer.
Run the Megarip Server.

Go to File Menu > Update Dongle

A screen will appear asking to Enter Key Code 1 and Key Code. Refer to the shipment email for the details. The
first string in the “Dongle reprogram string” field is Key Code 1. The second string in the field is Key Code 2. The
codes are separated by a space.

Copy and paste both strings into their relevant fields.

Click on Update Dongle.

A confirmation message will appear when the dongle is successfully updated. You will be asked to restart the
Server.

Quit the Server application and restart.

VP
( Close )

To update a V4 dongle to V5:
It is assumed the Version 5 software has been installed before updating the dongle.

SRR .

7.
8.
9.

Plug the current V4 dongle into your computer.

Run the Megarip Server.

An error message will appear as the Server will fail to recognise the dongle as valid.

Click OK to discard the error message. Do not remove the dongle.

Go to File Menu > Update Dongle

A screen will appear asking to Enter Key Code 1 and Key Code 2. Refer to the shipment email for the details. The
first string in the “Dongle reprogram string” field is Key Code 1. The second string in the field is Key Code 2. The
codes are separated by a space.

Copy and paste both strings into their relevant fields.

Click on Update Dongle.

A confirmation message will appear when the dongle is successfully updated. You will be asked to restart the
Server.

10. Quit the Server application. Only restart once the below steps have been completed.

Before Restarting the Server (When updating from V4 to V5)

1.

oW

Go to the installation directory for your Serendipity Megarip on the computer (for e.g.
C:\Serendipity\Serendipity\Serendipity Megarip\)

Open the “lib” folder.

Open the “printers” folder.

Sort the files by date.

Delete all old files ending in *v.so

Once the files have been deleted, the Megarip Server can be restarted.

Failure to remove the old files from the printers directory will noticeably slow down the Server when it is restarting.
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The Serendipity Megarip Client

The Serendipity Client is a graphic user interface (GUI) used for configuration, maintenance and monitoring of the
Serendipity Megarip Server.

The Client can be installed and run locally on the same machine, or from any supported computer on the network using
TCP/IP protocol. There is no limit to the number of Clients that can be connected to the Server, and each Client will
have its own settings, specific to the user.

Once installed, the Client connects to a Serendipity Megarip Server and loads the settings from the Server into the Client
interface. Any Client can access the job management information and view the current status. The configuration can be
open to all users or protected via Secure Mode, which allocates specific access for created users and user groups. For
more information on how to setup access see the Secure Mode section of the manual.

Look and Feel

There is a common theme and functionality to the Client. There are many ways to complete the same task, such as
configuring a Pagesetup from the QueueManager. Various options are available using the right mouse click to bring up
other contextual menus. This will vary depending upon the section of the Client interface being used.

Anywhere there is a chooser to select an item from the database, a search field will be indicated by a magnifying glass.
Entering text in the search fields filters the list, showing only the matching items. [ 2}
The search can be inverted with CMD+SHIFT+I (Mac) or CTRL+SHIFT+I (Win) to T -
hide the matching items. The search box will turn black to indicate inverse A
searching. Pressing Esc will dismiss the search.

Search

There are three (3) main sections to the Client - The Workbench, the Monitor and the Applications.

* The Workbench is used to configure the various parts of the Server. This is used to create queues, setup input
paths and various calibration functions.

* The Monitor (an application) is used for managing and viewing jobs as they pass through the system.

* The Applications add functionality and provide tools for managing the Server and the jobs passing through it.

There are also various menu options containing system utilities and preferences.

000 Workbench - NFR (not for resale)@localhost:9100
Workbench A -

The Workbench is where the main software configuration |

Calcheck Chart

takes place. Medias, Pagesetups, Output paths, Colour Sets and | {acner

Colour Correction Curves can all be setup here. i
Output
Pagesetup

Pagesetup Pool

When items are created or changed in the Workbench they are || e
saved to a database read by the Server each time at startup. fi.f”
The database can be backed-up and copied to other (Version | oo

W Signature Group

4) Servers.  Specal Colour Set

The Workbench has a split window. The left side shows Data
Types (database groups) and allows you to select items from
the database. The right side shows the item information,
allowing you to make any changes.

Nothing Selected

The Data Types section has two (2) views - Browse & Search.

Browse allows the user to view and select any of the database
items for display. The tab containing the magnifying glass flips
to a Search window, which acts like a filter, showing any items
containing the search text.

e 00 Workbench - adn|
| Browse &} | Items & Type Modified
% serendipity specials Special Colour Set  5/03/09 11:29 AM
Find items containing serendipity tiff output RIP 5/03/09 11:29 AM
— % serendipity tiff separated Job Genie 23/10/08 5:04 PM
seren
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Menu Options
File

* New - Create a new item in the database.

* Save - Save changes to the database.

* Duplicate - Make a copy of the currently selected item.

* Revert - Reload the last saved version of the currently selected item.

* Delete - Delete the currently selected item.

*  Print - Print the details of the currently selected item.

* GetInfo - Displays a popup window with two panels - General & Ownership. General displays the type, created
and modified dates for the selected item. Ownership displays the User and User Group permissions for the
item.

* Show Orphans - Shows any item currently in the database not being used by a Pagesetup.

Edit

* Undo - Undo the last change. There are multiple undo options and this is configured via the System Settings
section.

* Redo - Redo the last undone change. There are multiple redo options, depending on the undo status and
configuration in the System Settings.

* Find - Opens a text box at the bottom of the Workbench panel to locate the search text on the screen.

*  Split Vertical/Horizontal - Changes the view to either Vertical or Horizontal split on the screen.

¢  Show Type Column - Used in conjunction with Show Usage to display the type of data listed.

* Show Modified Time Column - Displays the last modified time for the items listed.

* Show Usage - Displays the items within the database the currently selected item uses, e.g., a selected Pagesetup
would show the Media and Output it currently uses.

* Reverse Usage - Reverses the usage shown above. (Was called Show Referrers previously).

Window
* Bring All to Front - Shows any open window of the Client and can be selected to bring it to the front.
Help

* Server Info - Provides information about the Server, including version, platform, speed, processors, hostname,
IP, product and vendor.
*  What's This - Select this and click on any part of the interface to display a short help description.

Contextual Menu (Right Click)

* Add to Archive - Add the selected items into a new Archive window. See the Archiver section for further
information.

* New Folder - Folders are a great way to organise the configurations if there are a lot of items. The folders are
based on a Client’s use, which means each user can have their own folder setup if they desire.

* New Folder with Selection - Places any selected items into a new folder.

Note: The folders are stored internally, inside the database and are not real, physical folders. Users can only create,
remove and manage items from within the Serendipity Client.
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Workbench Data Types

There are nine (9) data types (databases) within the Workbench that can be used and configured to accurately process
jobs. Each will be explained in detail. The data types are:

¢ Calcheck Chart - Used to provide a validation check for a hardcopy proof or a monitor. Dtavpes

* Gradation Curve - Used to adjust colour in a job by applying a curve to the individual |4 GradationCure
process colours. -

* ICC Tweak Set - Allows you to build up a library of colours that need “tweaking” for Pagesetup

Pagesetup Pool

accurate output.

* Media - Used to control configuration settings for Output, Colour Correction, ICC profiles,
Screen Printing & Output Screening.

*  Output - Handles processed jobs and determines where the file is going and what format
is created.

* Pagesetup - Consists of modules to be configured to process and manipulate jobs for the desired output.

* Pagesetup Pool - Allows you to print to one or more Pagesetups.

* Paper Profile - Used to define the paper and ink characteristics of the Media being used by the output
driver/device.

* Press - Contains the colour and dotgain attributes of a press. Used by the SoftProof application to show the
effects of printing a job on a particular press.

Paper Profile
Press

Data Types - User Interface and Context Menu
The Media, Output, Pagesetup, Pagesetup Pools and Press Data Types have multiple configuration panels or sections
governing the different functions they control.

These data types have a row of buttons or tiles across the top of their configuration panels allowing the user to
instantly jump to the section named. If any of the panels are not required, they can be hidden by using the “X” in the top
right corner of each. To show any hidden panels, click on the panel name in the row and it will appear. Shift+click will
hide them again.

Publish Colour Correction ICC Profiles ColourKeys Input Screening

A (right-click) contextual menu is accessible in any of these individual sections, allowing the user to access the Find
function, Jump to another section, or change the background colour of the panel for easy identification.
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Calcheck Chart

The Calcheck Chart data type allows you to setup the chart used for the validation check. The patches that
will be used are created, along with the target standards and tolerances. These items are saved to the database and can
be used and/or adjusted at any time. The Calcheck Chart is then used in conjunction with the Calcheck application to

provide a validation check for a hardcopy proof or a

monitor. 1 / :awcolnur ‘., oo ( Rename Colours ) (_Import Patches From Files... ) (Reorder patches )
Once the chart is setup, it normally never needs to be .
changed; the standards that you want to use are saved | = ~° TNt T BT BT
. . I Cyan 54.99, -37.00, -49.99 5.00 2.50 4.00
with the chart. When you come to read the chart with the . B i 7567200 S0 20 400
. . . . I 15.99,-0.06,0.01  5.00 250 4.00
Calcheck application, simply load it and measure. If you o 5226 G0
. . . . | [ 46.99, 68.03, 48.03  6.00 250 4.00
wanted to use a different standard, this is done in the chart 0 Mow BAGnin Lo im
and not the Calcheck. =8 LI
The chart can be attached to the job as it passes through
the Pagesetup or printed from the Calcheck. o maneaon 6o 2w i
e DR ———— P
The window shows a list of the patches on the right and - =_2;; wmsiae ew  am
colour information on the left. For each patch selected you E— Gnowns o Le i
can adjust its Lab values, delta tolerance and patch type. e B I e
The overall target preferences are specified in the lower T—
half of the left panel.
Toolbar Options

New Colour - Create a new colour in the list with default* values. Values and colour names can be adjusted as
desired.

Delete Colours - Deletes the selected colours from the list.

Duplicate Colours — Makes copies of the selected colours. Use shift or control keys for multi-selection.

Rename Colours - Pops up a renaming window, allowing you to change the name on one or more colours
simultaneously.

Import Patches from Files* - Allows you to import a patch set from a colour data file, such as those of colour
standards or ICC profile makers. A file chooser will display allowing you to navigate to the file location.

Reorder Patches - Allows you to reorder the patches. Selecting this will display another window where you can
select one or more colours and drag them into a new order. You can also use the up and down arrow keys and
shift or control to multi-select.

Generate Patches from ICC - Allows you to select an ICC profile from which to create a set of patches. Selecting
this option displays a file chooser for you to select an ICC profile. You are then prompted for the number of
patches to generate. The minimum number is 16 and maximum is 512.

*Note: When creating or importing new colours, they are stored with the default tolerance settings. This is user
configurable and should be set before the patch set is created.

Patch Definition
On the left are a series of controls allowing you to define each patch. Selecting a patch from the list will load the colour
into the colour match box at the top and load the Lab/CMYK values into the respective fields. To change the value,

simply type the new number into the relevant field.

L 78.88
Lab (or CMYK) - The Lab (or CMYK) value for the selected colour. - EXT
Ae tolerance - Set the maximum Ae value for the selected colour. e
AH tolerance - Set the maximum AH value for the selected colour.
AC tolerance - Set the maximum AC value for the selected colour. fe Tolerance [6.00
Patch Type - This allows you to identify important patch types from the set. The 4H Tolerance [2.50
options are: AC Tolerance 4.00
o Paper - Select the patch that represents the paper being checked. Patch Type (Generie

o Cyan/Magenta/Yellow/Black - Identify a patch for each colour from your set.
o Gray - Used to identify gray patches in the chart.
o Generic - Most patches are generic and are classified as generic if they don't fall into one of the above

types.

Note: When generating patches from an ICC profile, the patches are automatically assigned the correct type.
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Target Standards
There are three (3) standards that can be used to compare against your proof.

"Ae AH AC

These are Ae, AH and AC.

The first standard Ae is always enabled. The other two standards must be enabled for the results to appear on the
Calcheck. To enable, select the tab and tick the checkbox.

For each standard you specify the limits used for a pass and fail status. For Ae you also choose which of the Ae
standards are to be used - deltaE, CIE94 or CIE2000.

Important Note: The correct standard to be tested must be selected and saved with the chart. Only that standard will
be tested for a pass or fail. If you want to check another standard, you need to change it here and save it again. For
example, if you are checking deltaE and you want CIE2000, you need to change it, save and re-measure.

The limits are:

* Average - For all the patches in the chart that will be measured by Calcheck, the average must be below this
value for a pass.

* Maximum - This is the default value used when creating or importing patches. This value is only used for
assigning maximum tolerance for the import. When the target is measured, the tolerance set per patch is the
one used to determine a pass or fail status.

¢ Standard (Std) Deviation - The standard deviation across all the patches must not exceed this value. This is
only available in the Ae standard.

The Calcheck will only report a pass if all targets are achieved in the patch set (and therefore the proof or monitor).

Patches Per Strip - Specify how many patches are printed per line, allowing the use of existing target standards such as
the Fogra Media Wedge.

Spectrophotometer
The Spectrophotometer gives you the ability to use one of the supported online instruments to measure colours
directly into the Calcheck Chart.

To measure colours:

1. Select your instrument from the dropdown menu and click on Activate. The device must be connected and
turned on.

2. Follow the on-screen instructions, as some devices require calibration before measuring.

When complete, click the Turn Off button.

4. Ifyou chose the Lab text you will be prompted to choose a file to import. The format must be Lab values, space
or tab delimited and no header information.

w

Note: If you are importing characterisation data from one of the ICC profile packages or colour standards, you need to
use the Import Patches From Files option.

Patches
Thls SeCtlon Of the CalCheCk Chart WlndOW dlsplays the Colour A | Name Lab Betolerance | AH tolerance | AC tolerance Patch Type
1 i i s 01 56.97, -22.34, -27.03 3.00 2.50 4.00 Cyan

patches in the set. Each patch sh_ows its respective | E==—— shor a3 203 500 250 40 e

colour, name and Lab values. There is also a patch type 03 68.16, -13.02, -14.24 3.00 250 400 Cyan

04 74.15,-7.32, -6.82 6.00 2.50 4.00 Generic

and the tolerances for each standard. The tolerances are 0s 77.72,-383,-224  6.00 250 400 Generic
. . N os 53.22, 44.38,-0.48  3.00 2.50 4.00 Magenta

assigned when the patches are created or imported and | E———" o 57.68,36.88,-158 600 250 400 Generic

. 08 65.10, 25.08, -1.35 6.00 2.50 4.00 Generic

are based on the settlngs on the left. 09 72.37,13.85,009  6.00 250 4.00 Generic

10 76.82,7.22,1.36 6.00 2.50 4.00 Generic

11 81.68, -0.01, 3.00 6.00 2.50 4.00 Generic

12 77.73, -3.08, 47.98 3.00 2.50 4.00 Yellow

A tolerance setting can be altered by selecting the colour
and entering a new value in the relevant box.

The Chart type can be altered via the dropdown menu above the patches and
Chart type | Lab $ Press ICC Profile a Press ICC Profile will appear if allocated. The Press ICC Profile button only
becomes available for CMYK chart types.

Further details on how to configure a Calcheck Chart are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support
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Gradation Curve

A Gradation Curve is used to adjust colour in a job by applying a curve to the individual process colours.

There are six (6) process curves available - CMYKOG.

The Gradation Curve can be applied to a Media either as a

Linearisation Curve or as a Correction Curve.

A Linearisation Curve is normally applied as part of the early
calibration stage and this is recommended. A Correction Curve is
applied if a small amount of fine-tuning is required after normal

calibration procedures.

Toolbar Options
e Trace Saved Curve

where the curve has been edited.
¢ Invert Curve - Inverts the selected curve.

- A green line appears, showing
where the curve was last saved. This allows you to see

Black

600

GradationPreview

* Bigger/Smaller Curves - Increase or decrease the size of the graphs as they appear on the screen.

* (Gradation Table - Allows you to enter values manually to adjust or create a curve.

* Preview Curves - Displays a window with all curves in their respective colours so you can assess them in
relation to each other. This is updated dynamically as changes are made.

* Lineariser - Loads a Linearisation Curve directly into the Lineariser application.

Further details on how to configure a Gradation Curve are available on our website, under the HowTo Guides section:

http://www.serendipity-software.com.au/support

ICC Tweak Set

A

The ICC Tweak Set section allows you to build up a library of colours that need “tweaking” (adjusting) for

accurate output. A tweak set alters colours during the ICC mapping stage from input to output profile and is

selected on a per Media basis.

The ICC profiles are not edited in any way and the tweak set
can be selected as desired. Each colour requiring alteration
is selected and adjusted by adding to or subtracting process
colours from it, or making it lighter or darker. An accurate
visual representation is shown on the screen and the point
in the colourspace can also be viewed. Colours can be
created manually or by entering the CMYK or Lab values, or
input automatically using an online Spectrophotometer.

The interface is split into two parts - the left side shows the
input values and the right side shows where any
adjustments (tweaks) have been made.

Options
* Colourspace - Choose between Input Profile or Lab
input. If the profile selected is RGB, the sliders will
change to RGB. If CMYK, the sliders will change
accordingly.

Original

Tweak point

Colourspace [ Input Profile

c
R
v
K

ceptual | Colorimetric _Saturation

=
[mmEE

Tweaked

Zoom
( New Tweak

L-value
Change White Point...

le.. ) match/NewSample_Press_K2.icc

printers /PX9500_0714.icc

[ CGATS / 150 12642 file

* Influence - Choose the area around the specified colours to be affected. This is determined as a scale of 1 to 5,

with 1 being the least influence and 5 the greatest.

¢ Tweak Value - Use the CMY sliders to add or subtract from the colour being adjusted.

* Rendering Intent — Choose the rendering intent that the colour is to be altered in from either Perceptual,
Colourimetric or Saturation. This must match the rendering intent of the Pagesetup for the mapping to work.

* New Tweak - Create a new tweak in the rendering intent selected.

* Copy - Available via the right click menu. Used to copy the selected tweaks.
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* Paste - Available via the right click menu once an item has been copied. Used to paste the copied tweak from
the clipboard to the rendering intent selected.

* (Change White Point - Allows you to change the white point of the paper. Select the button and enter the X)Y,Z
points. If a Spectrophotometer is connected you can measure the white point directly into the system.

¢ Zoom - Zoom in and out of the Lab colourspace to see the point you are tweaking in relation to the whole
space.

* L-value - Move up and down the L-value to see the point you are tweaking in relation to the lightness. Reset the
value by clicking the ReCentre button.

* ICC Profiles - Choose the input and output profiles you are using to tweak. These must match the ones selected
in the Media, as they are stored with the tweak set and are used during the mapping process.

* Spectrophotometer - Choose an online Spectrophotometer to read values directly into the tweak set. Once
selected, press the Activate button to connect and take measurements. If the device is being used by another
application (including a Serendipity application), it will fail to connect. Quit or disconnect all others first.

Further details on how to configure an ICC Tweak Set are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support

Media

The Media data type contains all of the settings controlling the output of jobs as they pass through the
Megarip colour management system (CMS) for proofing. Settings configured here are those directly related to the
Output device, Colour Correction, ICC Profiles, Screen Printing and Output Screening.

A Media can be one of several assigned to a Pagesetup, which controls the input screening, resampling, rendering
effects and intents of incoming jobs.

All jobs are submitted to a combination of Pagesetup and Media destinations. When submitting, the user selects the
Pagesetup to be used, at which point a list of compatible (user-created) output Media types in the database become
available for selection.

A default Media is assigned to a Pagesetup, so if a job is submitted without a specific chosen Media, the job will output
to the default Media settings.

An Output data type can optionally have a Media type assigned to it, in which case only jobs submitted to the Output
using the assigned Media will be printed. All other jobs are held in the QueueManager until the assigned Media is
removed from the Output, or the held jobs’ Media type is assigned to the Output.

Important Note: Version 4 Pagesetups, when opened in version 5, are automatically split into Pagesetup and Media
types. Version 5 archives cannot be exported back into version 4.

Output
¢  Output Driver - Select the desired output driver from the available list. Those available will depend upon the
options enabled on the dongle. The selected driver affects the options made available for Resolution and
Colourspace.
* Resolution - Select or enter the desired resolution (DPI).
If the output is a printer, only the supported resolutions
are available. If it is a file format, your own value can be
entered. Bl o oo DR 0
* Colourspace - Select the output colourspace as desired. Toalsheas: 0 M e =
The selections will change depending upon the chosen E)
output driver.
* Media Width/Length - Sets the width and length of the Media. Only jobs submitted with a width and length
equal to or less than the assigned values will be printed. Jobs of greater width and length will be held in the
QueueManager until an appropriate Media, or new width and length values are assigned.
Note: Media Width/Length values override the width/length settings in the Nesting section of the Output,
meaning jobs will not nest or print until within the width/length settings of the Media to which they were
submitted.
* Cut Sheet - Enable this if the Media being printed to is Cut Sheet. The media to be used is selected from the
dropdown menu.

X-HB000/H10000 =)

Epson Stylus Pro 7900/7910/9900/9

72006y 7200 |%
cMYK =]

0.0 mm

off
Normal (3 mm)
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o Total Sheets — Enter the number of cut sheets loaded in the printer. Jobs will stop printing to the Media
and be held in the QueueManager when MediaStatus has tracked that the assigned number of sheets
have been used. A Total Sheets value of zero (0) assumes an unlimited sheet availability for tracking.
Sheet count is reset using the Reset Counter button in the Usage panel.

* Custom Settings - These options will vary, depending on which output driver has been selected. For example, if
JPEG is chosen, the customise section allows you to select the quality. If an Epson device is selected, items such
as paper types, ink types and cut methods become available.

Calcheck Info

A Media can have its calibration status checked using the Check Media option within the Calcheck application (see
Applications - Calcheck for more information).

This panel displays the current Calcheck calibration status of the Media, with the following information displayed:

¢ Chart - The Calcheck Chart used for verification. Cekheckinto
¢ Date - The date and time of the Calcheck. i EgaGR RET
. . Score: 71.41 11/06/09 5:15 PM
* Score - An internal calcheck rating from 1 to 100. e
AE, AH and AC tabs show the following data for each of the standards (if feyan 2.28 «

Ae Magenta 2.58
measured):

Be Yellow 4.06 Ae Average  2.07

e ACyan, AMagenta, AYellow, ABlack, APaper A: B:(k ;':; feMaximum 479
* Passor Fail - As designated by a green tick or red cross. . pap:, 206 e OEG
*  AAverage, AMaximum, AStandard Deviation

U Sage Usage

The Usage panel shows the amount of media used based on the values s ==
entered for Media Length (above). e

Printed: 13 Jobs (423437.47 mm’)

* Usage Meter - Bar showing the amount of media used. Text under the bar shows the exact amount as “Used X
Units of Total Units” (percentage %).

* Logged Period - Time period (date and time, from and to) the Media has been tracked since the last reset.

* Printed - Number of jobs and total printed area of jobs tracked since the last reset.

* Reset Counter - Reset the usage count for the Media.

Colour Correction
There are three (3) options for use to manipulate or fine-tune the colour to achieve the desired results:

¢ Correction LUT - Select a Correction LUT to be applied in the form of
a Gradation Curve. You can preview the curves, edit them or create

Colour Correction

@ Paper Profile ... Epson7900-EpsonProofing
new curves. 000 .
. . . . . . . . A Linearisation LUT ... Epson? -EpsonProofing
* Linearisation LUT - Select a Linearisation LUT to be applied in the
A Correction LUT ... None

form of a Gradation Curve. This is normally done as part of the
standard calibration process with the use of the Lineariser. You can
preview the curves, edit them or create new curves.

* Paper Profile - Select a Paper Profile to be applied. If the output is to a printer, this is also part of the standard
calibration process.

ICC Profiles
ICC Profiles are used to match colours from one device to another, for example, a Press to an Inkjet. It does this by
mapping an input to an output colour.

ICC Profiles

Output

*  Output ICC Profile - Select an output profile. This is the printer _# Choose CC Proie.._ 7800 ook semnatter 7200p e
or other output profile and is used to convert the Lab data into SRR nERY)
the output colourspace. This output could be RGB, CMYK or N

CMYKOG, depending on the output device chosen and the
detected colourspace.

* Output ICC Tweak Set - Select a Tweak Set from the available list. Lists can be previewed, edited or new ones
created.

* Device Link Profile — Select a device link profile. If the job passing through does not match the colourspace of
the Device Link Profile, the standard input and output profiles selected will be applied.
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Upload ICC - This option is available on all of the ICC choosers. If the ICC profile is located somewhere other than the
default ICC folders, use this function to upload it to the Server ICC folders in order for it to be used. As this is a Client-
side option, this function can be used to move ICC profiles from the machine they were created on to the Server. This
can be either on the LAN or WAN as a remote machine.

Screen Printing

The Screen Printing mode separates a job into single plates and prints them as black. This is designed to print with a
halftone dot onto a clear film media. To increase the density of the output, choose a combination of inks. This option can
be used to produce films for use in the Screen Printing industry.

e Enable Screen Print Mode - Turns the Screen Print mode on or Screen Printing

off. ") Enable Screen Print Mode
¢ Ink Combination - Select the inks to be combined for a single Ink Combination
separation output. " Cyan ‘_‘ Magenta I Yellow || Black
" Light Cyan || Light Magenta 1 Light Black

s . I Light Light Black
In Screen Printing mode, all jobs are separated and you must have a e

Paper Profile where only one dot for each colour is turned on.

Output Screening
You can apply screening to the output file if desired. This is only available if the output driver selected supports
screening.

There are two (2) methods available - FM Screening or Halftone.

FM Screening Variations T ——
¢ Stochastic - Standard Stochastic Screening. R
* Stochastic-2 and 3 - Stochastic Screening with progressively increasing amounts of Method: (M Screening 1§
noise mixed in. This is done to overcome some artifacts caused by Inkjet printers.

* Stochastic Fast - A fast version of the Stochastic Screening mode. Slightly lower @ Stochastic
quality than Stochastic. Q:::z::::zi

*  Error Diffusion - Error Diffusion Screening. May enhance edges within images. O Stochastic Fast

¢ Ordered Dither - Ordered Dithering Screening. Applies a threshold map on the pixels O Error Diffusion

displayed, causing some of the pixels to be rendered at a different colour. O Ordered Dither

Halftone Options (Traditional Rosette Dot) Outputsereening
* Dotshape - Choose the dot shape to suit your requirements from it C—_
Round, Inverted Round, Elliptical, Inverted Elliptical, Diamond, N — - N
Euclidean or Line. Pp— Sereen, 171
¢ SuperCell - Select this to choose SuperCell screening instead of Gz [ 1500000
. Magenta:  75.00 150.0000
standard halftone. Produces a much better quality output than i S
standard halftone. Back: 4500 1500000
*  Angle,Degrees - Enter the desired angle for each plate. e i -
. . Defaults
* Screen,LPI - Enter the desired screen ruling for each plate. Special 31 45,00 1500000 -
* Defaults - Use this to select the default values based on the output e oo
resolution. Special 6 45.00 1500000
Special 7:  45.00 150.0000
Special 8: 45.00 150.0000
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Output

The Output data type handles processed jobs and determines where the file is going and what format is

created. The Output Driver determines the format produced and the method of delivery is determined by the
Destination. The Collating section has details for Nesting and Duplexing features.

Queue

Queue

Output Driver: | Epson Stylus Pro 11880 / PX-20000 )

Output Driver - Select the desired output driver from the | 7™
dropdown list. Those available will depend upon the options
enabled on the dongle. The selected driver affects the options in
a Pagesetup and Media pointing to it.

Change Media - Select this to optionally assign a Media to the
Output. A chooser window will appear with Media displayed
matching the Output driver type. The options as set in the selected Media are displayed for view, can be edited
or a new Media can be created.

Status - Choose whether the Output queue is Active or Inactive. This can also be controlled from the
QueueManager.

AutoClean - Determines the number of jobs to keep in the Output queue. Once the set limit is reached, the
oldest jobs are removed. Default is Off (no jobs are removed).

AutoPause - Select a time duration the queue should pause after processing a job. Used for double-sided
plotters so there is a pause in sending the next job, giving the plotter time to turn a sheet ready for the back
side to be printed, or time to load another sheet.

[ Enable AutoClean

Jobs to Keep:

0 Job:

Note: The Change Media option is used as both a safeguard against paper waste and a workflow control method. If a
Media type is assigned to the Output, only jobs submitted to the Output using the same Media will be printed. All other
jobs are held in the QueueManager until the Media they were submitted to is assigned to the Output. If no Media is
assigned, all jobs sent to the Output are printed.

Destination
The Destination determines the method of delivery of the output job to the final destination. Depending on the
destination driver selected, there may be some additional options available.

Destination Drivers Destination

Destination Driver: [ LPR port B

Command/Script - Select a script or command to be run once a job has
completed.

Epson FireWire — Only available on the Mac OSX version. Windows users
should use the Local Print Queue option and print to an installed printer,
configured to use FireWire.

Epson XIO - Print to an Epson connected via FireWire using Epson XIO interface on the Mac OSX. This requires
the Epson driver to be installed on the Mac first. This option is only available for Mac and required on later
model Epson printers and newer versions of OSX. Use XIO if the FireWire driver does not work.

FTP - Send your completed job to remote machine using FTP.

Local Device - If you have a printer connected as a serial or parallel printer, send your file directly to the device
with this option.

Local Folder - Choose a local folder to send the output file to. Enter the path or select Choose to browse and
select a folder. The folder must exist and have write permissions.

Local Print Queue - Print to a local print queue. Use this to print to a Windows printer on another machine. In
the path location enter \\machine\printer where <machine> is the name of the Windows machine with the
printer attached and <printer> is the exact name of the printer. The printer must be shared.

LPR Port - Use LPR to print jobs to printers accepting it. Enter the Hostname/IP address of the printer and the
path. Not all devices require a path to be entered. This is a good option for Epson printers with a network card.
This method is faster than TCP/IP printing for these devices.

Nowhere - This is used for internal testing purposes or for softproofing workflows. Files created by the print
driver are not sent anywhere; they are left in the default raster location. A print time for simulation can be
entered.

PAP (AppleTalk) - Select a networked AppleTalk device to print to. The Change button displays any valid
AppleTalk devices.

Secure FTP (sftp) - Send the job to a secure server using FTP.

TCP/IP Port - Print to a networked device over TCP/IP.

USB Printer - Print to a printer connected via USB.

Hostname/IP:  192.168.5.23

Path:  serendipity
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Collating
Collating is a method of gathering various outputs and grouping them together. There are two (2) methods of collating
available, depending on the output driver selected. If an output driver that supports Duplexing is selected, the
additional Duplexing collation method becomes available. Otherwise, the only option is Nesting.

Duplexing

You can
This is o

Nesting
You can

duplex jobs with multiple pages to form double-sided printing.
nly available for printers supporting duplexing modes.

Add Separator Page - Adds a blank page between duplexed sets.
This is useful when de-imposing and duplexing perfect bound
jobs. A blank page is inserted after the Maximum Jobs is reached
for duplexing to begin.

Top Page - Determine if the top page is an odd or even number.

Collating

Collation Method: | Duplexing |4

"1 Add Separator Page

Top Page Maximum Wait Time

@ o0dd () Even oh i 0m

Maximum Jobs

Maximum Wait Time - Set the time to wait before duplexing
begins. If the MWT is reached and the back side of the pages has
not yet been processed, the queue will begin to duplex any
available pages. This will result in single pages where the back
are not yet completed.

Maximum Jobs - Set the maximum number of jobs for duplexing. If this value is reached, duplexing will begin.

©

0 Jobs

nest multiple jobs together for a single output to save media and time.

Enable Automatic Nesting - Set the queue to nest jobs
automatically when the configured conditions (such as
Maximum Wait Time) are met.

Auto Rotate When Nesting - Enable auto rotation when nesting
occurs. If this is enabled, make sure the option in the Pagesetup
is set to None. There is no need to spend processing time
rotating a job if it is rotated at nesting time.

Copies - Specify the number of copies you want to nest. For
example, if you have 7 jobs making up a nest and enter 5 in the
copies field, you will get 5 copies of the same 7 jobs nested and
printed.

Maximum Wait Time - Specify how long to wait before nesting
begins. Once reached, nesting will begin and any job waiting to nest will be nested into a single job. The start
time is determined by the first job that appears waiting to nest.

Minimum Paper Coverage - Specify the minimum paper coverage to be reached by jobs waiting to nest before
nesting will begin. Once reached, any waiting jobs will be nested into a single job.

Maximum Jobs - Specify the maximum number of jobs in a nest. If there are more jobs in the queue than the
number specified, that number of jobs will nest and the remaining jobs will stay waiting to nest until the
criteria is met again.

Media Width - Specify the media width. This is required for nesting to work.

Gap Between Jobs - Enter the size of the gap between jobs in the nest.

Minimum Total Height — Specify the minimum total height of a nest, i.e., if the combined height of the jobs
waiting to nest reaches this value, nesting will begin.

Maximum Total Height - Specify the maximum total height of a nest, i.e, if the combined height of the jobs
waiting to nest reaches this value, nesting will begin.

Collating

3]

Collation Method: | Nesting

") Enable Automatic Nesting [ Auto Rotate When Nesting

Copies Maximum Wait Time

o [ oh  Lliom [ :os

Minimum Paper Coverage Maximur Jobs.

—
O—

Pt
©

80% 0 Jobs

Media Width: 420.0 mm Minimum Total Height: 0.0 mm

Gap Between Jobs: 0.0 mm Maximum Total Height: 0.0 mm

Note: If

a Maximum Height is set, the Nesting algorithm will look at all the jobs waiting to nest and fit the most jobs

between the minimum and maximum heights.

If the available jobs can not cover the defined Paper Coverage (if set) of paper without exceeding the maximum height,
jobs will not nest.

If no Paper Coverage minimum is set, any job that would make the nest exceed the maximum height will be left in the
queue - the other jobs will be nested.

Any single job exceeding the Maximum Height will also not print. If a job is too large, either the nesting parameters
and/or the printing media but be changed.

This makes it possible to effectively and efficiently nest using Cut Sheet media.

Further

details on how to configure an Output are available on our website, under the HowTo Guides section:

http://www.serendipity-software.com.au/support
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Pagesetup

A Pagesetup consists of many configurable modules to manipulate your job for the desired output. This is

where the Input Screening and ICC Profiles, Render Effects, Colour Keys and other Colour Management
options are setup.

Output
* Change Output - Selects the Output method and assigns its configured properties to the Pagesetup.

* (Change Media - Allows you to select the default Media settings and assign its properties to the Pagesetup. If a
job is submitted to the Pagesetup without a specific Media, the job will output using these default Media
settings.

¢ Output Settings:

o Antialiasing - Choose from 2x2, 3x3, 4x4 or None. & Change Output... ). Epson 7880
Antialiasing is designed to smooth jagged edges and is used - change e =R B
when the Output does not have sufficient resolution to cupsatneE

Antialiasing: [ None |4
display edges smoothly. The values increase the amount of piorty o[

pixels used for Antialiasing. The default setting is None. 0 Auto Publication Name

o Priority - Assign a priority to a Pagesetup. The higher the 16t pocessing
number, the higher the priority. Numbers can be negative
for a higher priority. The default is 0. Jobs waiting to Image or Render will process through a higher
priority Pagesetup over jobs submitted to lower priority queues.

o Auto Publication Name - Create unique publication names for each job passed through the Pagesetup.
Use this feature for duplexing from PDF or PS files. Submitting a multi-page document as one job will
allocate all pages with the same publication name.

o 16 Bit Processing - Enable or disable 16-bit processing for jobs submitted to the Pagesetup.

Output

Note: Megarip V5 is able to accept files submitted in a 16-bit format. The files are normally processed and rendered in
standard 8-bit colour, which for many workflows is sufficient for proofing. 16-bit processing improves render quality
and can be useful for finding artifacts within a job. When enabled, files submitted to the Pagesetup in 8-bit are upscaled
to 16-bit for processing. 16-bit mode requires more system memory for imaging/rendering jobs and produces larger
output files.

Publish
* DropFolders - Allocate a folder where files can be dropped in for [mm
processing. Valid File Types include Postscript, PDF, JPEG, TIFF Image, oo
Serendipity Megarip Image, EPS, PNG. PR
o Macor Windows - Choose to publish a folder for Mac or Windows.
* Location - Select a folder as a DropFolder. The folder must exist and have 1G5 pore I Acivte port namber
read/write permissions. Flow Control: (] Hold AferImaging ] Hold Afer Rendering
* Default - Reset the DropFolder location to the default one (Serendipity
Megarip installation directory/drop/<”"Pagesetup Name”>)
* Printers - Choose to publish the Pagesetup as a printer so machines on the network can select it and print to it
directly from applications.
o Mac or Windows - Choose either Mac (AppleTalk) or Windows. The Pagesetup name is used as the
printer name.
* TCP Port - Publish the Pagesetup as a TCP Port to allow Unix based computers or other Serendipity Megarip’s
to print to it.
* Activate Port Number - Select this to show a text field, allowing you to enter a port number. The hostname or
IP address of the computer is used and each Pagesetup has it’s own port number.
* Flow Control - Select whether to hold the submitted file after Imaging or Rendering, allowing you to prioritise
jobs or make rendering attribute changes before releasing.

(1 Location ... ) Default Default

Printer: [ Mac ) Windows

ICC Profiles
* Always Use ICC - Enable this to always use the assigned ICC profiles for jobs submitted to the Pagesetup (and
Media). If this is not enabled, the ICC profiles selected are only used in colourspace conversion.
* Honour Embedded ICC Profiles - Enable this to use an ICC profile embedded in a submitted TIFF, JPEG or EPS
file as the input match profile. When enabled, embedded file profiles will always take precedence over any
Match ICC assigned to the Pagesetup.

Note: The TIFF Image output driver has an option to embed an ICC profile into TIFF files that are output by Megarip.
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* Black Point Compensation - This setting is designed for use when processing input from large gamut sources
such as photographs and RGB images. Black Point Compensation ——
enhances shadow details in these images; assists when viewing o ——
shadowed areas in non-ideal or everyday lighting conditions; and fHonour Embedded CC rofies
prevents flooding in CMY grey areas. o Compeen
This setting only functions when using colourimetric intents, and R s
when Always Use ICC is checked. (3 RGs (cCPofie )
Black Point Compensation should not be used for normal CMYK

monitors/sRGB_v4_ICC_preference.icc

Rendering Intent: | Perceptual =]

Press

proofing jobs, which are generally well within the gamut of an (o TECPoTe) fogre-atoma-testuitelIS0conted o2 ecF391cc
output device (Inkjet printer). B e o =
* Intent - Select the rendering intent to use. Options include: O pin Calheck
o Perceptual - All colours are moved proportionally to each =i (T

None

other so the eye perceives the colours to be correct (i.e.,
colours out of gamut move into gamut, and those in gamut
move proportionally to those out of gamut).

o Relative Colourimetric - Those colours out of gamut are moved into gamut, and those in gamut are left
untouched.

o Absolute Colourimetric - The colours are left alone so those out of gamut cannot be reproduced.
Adjusts the white point of the media to match that in the input ICC profile.

o Saturation - Those colours out of gamut move into gamut, but all colours increase in saturation as a
result.

* Retain Pure Black - When ICC profiles are used, all colours, even solids, are made up of a mix of different
colours. Selecting Retain Pure Black uses only black for areas containing just black. When enabled, the
following options become available:

o All - Uses black ink only in all areas defined as Black.
o Text - Uses black ink only in elements defined as Black text. This can improve the clarity and
sharpness of the text.

Note: This option is not always suitable for use with printers using light black inks, as many of these inks tend to have a
non-black hue.

* RGBICC Profile - Select an RGB Input profile. This is used to convert input data from RGB to Lab and should be
a scanner or digital camera profile.

* Press ICC Profile - Select a Press profile. This is a Match profile and is used to convert input data from CMYK to
Lab. This can be a multicolour profile or CMYK. If you select a multicolour profile, an additional option will
become available - Press Inks.

o Press Inks - For multicolour press profiles you must specify the plates used in the ICC and the order of
those plates. Selecting this option displays a Special Colour Set chooser, allowing you to select a pre-
defined set or create a new one.

Important Note: For multicolour profiles to work, you must create the same colour names used in the ICC and have
them in the same order. The order for the ICC is specified during ICC creation. This is independent of the actual press
order. Change the order by dragging the colours around the set. The order is specified as the Colour (left column), order
descending.

* Upload ICC - This is available on all of the ICC choosers. If the ICC profile is located somewhere other than the
default ICC folders, you can use this function to upload it to the Server ICC folders in order for it to be used. As
this is a Client-side option, you can use this function for moving ICC profiles from the machine they were
created on to the Server. This can be either on the LAN or WAN as a remote machine.

* Print Calcheck - Select this to attach a calibration strip to every job passing through this Pagesetup.

o Device - Choose the device you will use to measure the strip with. This creates the chart for the correct
device.
o Chart - Choose the chart for use from the popup window of Calcheck Charts.

Note: The Calcheck Chart is a Data Type in the Workbench. This is where you create the chart. Use the Calcheck
application to measure it and produce a report.
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ColourKeys

This module allows you to merge some plates and separate others from [Gomes
a single job submission. For example, you can merge the CMYK plates C)Enable Colourkeys
together and print the 3 specials as separate jobs, or you can create oo e Conbnstons
progressive proofs with C, CM, CMY, CMYK, CMYKS1, etc. Voo Cwy
Black C, MY, K

* Enable ColourKeys - Select this to turn the module on. % o S

¢ Plates - Shows a list of available plates. “

* Add - Adds the selected plates to the Plate 56

e Combinations list. ( Desdect ) (Remere ) CRemove A1)

* Progressive - Used to make progressive proofs. After adding the
first plate to be used in the proof, click the Progressive button one or more times to cumulatively add plates to
the Plate Combinations list. The progression will start with the first plate on the Plates list by default if a first
plate is not selected.

* Deselect - Deselects any plates currently selected in the Plates list.

* Remove - Removes the selected Plate Combination from the list.

* Remove All - Clears the Plate Combination List.

Input Screening
Input Screening determines how the screening on the input data is [ screenme
handled. There are two (2) choices - Preserve and Descreen. Handiing: (Presere W) [ o -
Cyan Magenta Fast-2
* Preserve - Preserves the dots from the incoming data so o yogenta
the same dots on the final job are shown on the proof. S ot Bl
Further choices are: o amoon? 2
o Real Dot Technology - Used to preserve the dot s
structure. s6
o Fast-2 - Similar to RDT but a faster method. (ovemde )
o RDT Smooth 1, 2 and 3 - This is RDT with

progressive levels of smoothing.

Note: Fast-2 should be used where the dot structure is not very important. It will preserve the dot but is a quick, low
quality method. The sharpest dot structure will be achieved using RDT, however you will sometimes get introduced
moire, caused by the head weaving of the printer, the resolution and the screen ruling of the original file.

* Descreen - Descreens the incoming data with either:
o D-Dot - Removes the dots; or
o Fast - Quick descreening algorithm

Note: D-Dot is used where the output job is being sent to a photocopier or similar device, with a front-end RIP that
applies a screen of its own. If you did not remove the dot, the job would be double screened, producing poor output. Use
Fast for all other methods when the incoming screening is not to be preserved.

* Plates and Plate/Type - Allows you to override the descreening mode selected with other modes for the plates.
This is needed so that, for example, if RDT is used for all plates except Black (which uses RDT Smooth-2) you
will avoid getting moire.

Postscript / PDF Options Postscript / PDF Options
The following options are only used when the incoming data is Postscript: R
") Simple RGB to CMYK conversion

* Use Bounding Box for Page Size - Some Postscript jobs do not place a (] Fail on RG8 Images
page size in the job information. Checking this will use the bounding il Sl i
bOX as the page SiZe. "] Disable PDF autoseparation

* Simple RGB to CMYK Conversion - This is a compatibility mode from (] Render in RGB
older versions of the product. Images are converted from RGB to [} Use CMYK simulation from PDF for unknown colours
CMYK quickly using a basic method. The colour is not very accurate
and is not recommended for contract proofs.

* Fail on RGB Images - Causes a job to fail if it contains RGB images. If this is not checked, the jobs will process
but RGB images will be ignored and not printed.

* Antialiased Subsampling - Used to assist in the rendering of some fonts.

¢ Allow More Than 4 Spot Colours - Enable this if PDF or Postscript files are being processed with more than
four spot plates. This option will increase processing time when enabled.

"1 Allow More Than 4 Spot Colours
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* Disable PDF Autoseparation - Turns off autoseparation for PDF files.

* Render in RGB - Allows Postscript file data to be processed in an RGB rendering mode, with a wide gamut
suitable for digital photographic proofs/prints.

* Use CMYK simulation from PDF for unknown colours - Allow the CMYK simulations from PDF files to be
substituted for unknown spot colours.

Note: An Unknown Specials colour set can now be assigned in the System Settings. This allows unknown special/spot
colours included in PDF or Postscript jobs to be automatically added to the set.

Resampling
Resampling allows you to configure the method for sampling incoming data and changing the resolution from the input
to that of the output. The options are:

* Nearest Neighbour - The fastest method but less accurate. Choices are made as the closest pixels from input to
output and can result in jagged edges or stepping effects.

* Bilinear - A medium quality sampling method and can take longer than Nearest Neighbour. Bilinear takes the
weighted average of 4 pixels from input to output. Best for use with screened data.

* Bicubic - High quality sampling method which takes longer to calculate than Bilinear. Bicubic uses the
weighted average of 16 pixels from input to output.

* Filtered - Serendipity’s own sampling method, giving the highest quality. It takes longer to process than
Bicubic and uses an averaged area from input to output. This setting provides better resampling for contone
data, such as Postscript and PDF.

Logo Logo

Position your own company logo, sign-off slugline or colour bar for checking ] Enable Logo

consistency anywhere around the job. The logo passes through the same colour ki

management as the job and can therefore be verified. The file is not rotated during i YT
output (except if Auto Rotate When Nesting is enabled). If the logo file is positioned ]
along the left or right sides, the EPS file should be created in the appropriate

orientation.

* Enable Logo - Turn the Logo effect on or off.
* Dimensions - Enter the print dimensions of the Logo.
* Logo File - Select this to choose your Logo file.

Effects
Various effects may be applied to jobs passing through the Pagesetup. Effects are applied in the order they appear here.
Some effects have separate attributes for customisation and can be edited once they are in the Applied Effects column.

The Effects are:

Effects

* Border - Place a border around the job. Line width and
colour can be specified.

[ Enable Effects

Available Effects Applied Effects

¢ Centering - Centre the job in the specified page area. —r Centering 101
¢ Convolution Matrix - Design your own filter effect Convolution matrix 1.02
according to a pre-defined mathematical operation known e doee 101 Caa)
as convolution. \aror 100
*  Cropmarks - Place crop marks around a job. Line width, enitoor i : (Removell )

Rectangle 1.02

length and clearance can be specified.

* Edge Detect - Remove all content and just leave the edges.

* Margins - Specify margins around the job.

*  Mirror - Mirrors the job.

* Negative - Renders the job as a negative.

* Pagenumber - Place the page number in the middle of the page as a watermark. Scale factor and opacity can be
configured.

* Rectangle - Draw a rectangle around the job inset at the desired distance, line width and colour.

¢ Slugline - Place job information on the job. There are a number of options available via the Edit button. If you
are using a narrow format paper and the full slugline doesn’t fit, select Custom Slugline and turn all options on.
This will show an item per line. Within Custom, fields selected will only be printed if they are relevant to the
job.

¢ Unsharp Mask - Apply an unsharp mask to the job. The Unsharp Mask affects the edges within an image and
can be controlled with the available parameters. The radius tells us how large an area to affect around the
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edges. The larger the radius, the greater the effect and the longer it takes to process. If the preview resolution
is high, a given radius will have less effect than if the resolution is lower. If the detail is quite fine, a smaller
radius should be used. Higher radius values can also cause halos at the edges. The threshold gives a level that
should be affected where 0 affects more of the image and 255 very little. The amount states the size of the
change, where a higher value is a greater change at the edges.

* Watermark - Place a watermark across the job. The scale of the watermark is proportional to the size of the
job. 100% represents the same size as the job in the smallest direction. If the stretch option is selected,
horizontal and vertical sides are stretched to the scale amount. The watermark will be scaled in an anamorphic

manner.
Media Effects
Media Effects
The attributes here allow you to manipulate the job in various ways: wethod: (None 18] @lon: O% O 0270 Ohuto
phcibg|610.0 mm ) Vertically [ Horizontally
*  Fitting Method feahti[00 o
o None - Fitting method is turned off. iciRESciagil 00000

Height Factor: 0.0000

o Fit Width/Fit Height/Fit Width & Height - Shrinks
jobs to fit within the set dimensions; proportions are

Cropping Margins Effects

[ Auto Crop 1 Mirror

maintained. Left: 00mm | Lefe 00mm | [INegative
o Scale Factor - Scales jobs by the amount specified. e o | | R
o Tiles - Tiles a job that is larger than the width & Sotom [00mm | sottom: G0 mm

height specified. If required, an overlap can also be
entered. Useful for large posters or billboards.
o Best Fit Width/Best Fit Height/Best Fit Width & Height - As Fit, but will shrink or enlarge jobs to
fit/fill dimensions entered while maintaining proportions.
* Rotation - Choose from None, 90, 180, or 270 degrees. Automatic rotation may also be selected to best fit the
job using the media width and height specified.

Note: Auto Rotation is very useful for saving media, but if a job is rotated, it takes longer to process - the larger the job,
the longer the process time. Rotation takes place at the beginning of the Rendering phase and will affect cropping,
margins and so on. If you are auto-rotating when nesting (See Nesting in the Output section), it is advisable to have
Sheet Auto Rotation turned off, otherwise the job rotation will be calculated twice, again increasing the process time.
Increasing system memory can also improve processing times.

¢ Centering - Choose between Vertically or Horizontally.
Use this if you need to centre a job at any time. In particular, you may need to use it when printing to a double-
sided printer to help match the front and back sides.

* Accuracy Correction - Compensate for media stretch or paper feed errors by specifying a correction amount
for width and height.

* Cropping - Crop the job in all directions. When specifying cropping, you will need to take into account any
rotation that has been applied, as cropping takes place after rotation.

* Margins - Specify a margin around the job. You may have to specify a margin to shift a job over or compensate
for a printer’s set margin. As with cropping, take rotation into account.

* Effects - Mirror or Negative your job by enabling either option.

Note: The Mirror and Negative effects in the Sheet panel differ to those in the Effects panel in that they apply the effect
at the Imaging stage of processing.

Further details on how to configure a calibrated Media and Pagesetup are available on our website, under the HowTo
Guides section: http://www.serendipity-software.com.au/support
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Pagesetup Pools

The Pagesetup Pools data type allows you to print to one or more Pagesetups. You can choose to load balance

between multiple Pagesetups or print to multiple Pagesetups simultaneously. These can be published in the
same way as an individual Pagesetup, or you can set the Pool to auto-proof.

PubllSh Publl)irso:romers
* DropFolders - Allocate a folder where files can be dropped in for
processing. Valid File Types include Postscript, PDF, JPEG, TIFF

"I Mac [ Windows

. . [ Location ... ) Default Default
Image, Serendipity Megarip Image, EPS, PNG.
o Mac or Windows - Choose to publish a folder for Mac or Printer: [ Mac ) Windows
Wlndows TCP Port: || Activate port number
Flow Control: || Hold After Imaging || Hold After Rendering

* Location - Select a folder as a DropFolder. The folder must exist and
have read/write permissions.

¢ Default - Reset the DropFolder location to the default one (Serendipity Megarip installation
directory/drop/<"Pagesetup Pool Name”>)

* Printers - Choose to publish the Pagesetup Pool as a printer so machines on the network can select it and print
to it directly from applications.

o Mac or Windows - Choose either Mac (AppleTalk) or Windows. The Pagesetup Pool name is used as
the printer name.

* TCP Port - Publish the Pagesetup Pool as a TCP Port to allow Unix based computers or other Serendipity
Megarip’s to print to it.

* Activate Port Number - Select this to show a text field, allowing you to enter a port number. The hostname or
IP address of the computer is used and each Pagesetup Pool has it’'s own port number.

* Flow Control - Select whether to hold the submitted file after Imaging or Rendering, allowing you to prioritise
jobs or make rendering attribute changes before releasing.

Job Queuing
Job Queuing allows you to control the way the pools work and the importance of the queue.
*  Priority - Assign a priority to a Pagesetup Pool. The lower the | Job Queueing =
number, the higher the priority. Numbers can be negative. The | Priority: 0 7/
default is 0. Jobs waiting to Image or Render will process through Pool Type
a higher priority Pool over jobs submitted to lower priority @® Load Balancing
queues. (O By Print Area
(® By Number of Jobs
* Pool type - Allows you to decide what sort of pool you are going () Prints To All Pagesetups
to use. There are two (2) options:

o Load Balancing - Spread the jobs across the Pagesetups selected in the pool.

= By Print Area - Calculate the area of each job and the queue with the least amount of print
area queued is sent the next job.
= By Number of Jobs - The queue with the least number of jobs is sent the next job.

Load Balancing is ideal for printing to multiple printers of equal quality, using the same media, with the priority being
to proof jobs to the next available printer. Each printer is calibrated separately to ensure quality. “By Print Area” is
more efficient, as the larger the print area the longer it will take to image, render and print. Queue loading is
determined at the time of imaging. If a print queue is paused, jobs will be sent to active queues.

o Prints to All Pagesetups - Choose to print to all Pagesetups selected in the pool.

The option Prints to All Pagesetups is ideal if you want a job to print locally and remotely. One Pagesetup can be
configured to drive a local printer and another can create a JPEG image and transmit it to a remote Serendipity Megarip.
Alternatively, you may want to create a PDF file to send to a customer at the same time as printing a hardcopy.

Pagesetups

This displays all Pagesetups configured in the system. The sort columns show the
Output, Input Screening and Media used by each Pagesetup. Tickboxes allow you to
select which Pagesetup will be included in the Pool. A context menu for each
Pagesetup in the list allows the user to edit any or all selections of the highlighted
Pagesetup, it’s assigned Output or Media.
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®

colourspace and custom settings of the Media.

The user interface for Paper Profile comprises of a toolbar
containing options and functions to assist in creating the profile;
and a tabbed panel where the printer’s dot sizes (Density
Patches), Ink Limits and if appropriate, ink Separation Control
are configured.

Toolbar Options

Paper Profile
Configuring a Paper Profile is a fundamental part of calibrating a printer for optimum colour output. The
profile is assigned to a Media and matches paper and ink characteristics to the output driver, resolution,

int Density Chart ) (Print Density Chart (Al patches) ) (Print Inklimit Chart )

h ) #Sift and Sort ( Upgrade )

§ ( Weasure Patches ) (Measore Patches (ab) ) (Change Media ) (P

(Print inkiimit Chart (Separate Jobs) ) (_Configure Inklimit Chart ) (

Density Paiches | Ink Limits _ Separation Control

(@ (e RIS N

100.0% max 2] Light Light Black

0:004 0204 00388 5062

00043/ ME oisss
o:00¢2] [0, 7;! o243

1 2
0:00¢2 [D0630| | 0. 1282
Vioors \ioaml| v oers.

] 0: 1202 o 2156 0,278
R Vo cse | v ozo GRS

Viboes aasa

D:1767] Dzom
IAXZEN] v: 0.437 | v: 0.600

Backdensity 18] |1

<) Light Black

Measure Patches - Use this to measure a printed density
chart using a supported instrument. After selecting,
choose an online device and desired density standard
from the dropdown menus. Consult your instrument
manual for supported types. When the device is ready,
the measuring window appears. If instructed, calibrate
the instrument and begin.

Measure Patches (Lab) - Use this to measure the Lab values of the printed density patches.

Note: Patch values may be measured, sorted and saved with either density or Lab. These cannot be mixed
within a paper profile.

Change Media - Allows you to change the Media currently assigned to the Paper Profile.

Print Density Chart - Prints a density chart containing the patches currently turned on. Where patches are
turned off, there will be a space on the output print. Selecting this displays a chooser, allowing you to select a
Media and Pagesetup to which the chart is then printed.

Print Density Chart (All patches) - Prints a density chart containing all patches, irrespective of their on/off
state.

Prink Inklimit Chart - Prints an ink density chart containing all enabled limits as one job to the selected Media
and Pagesetup.

Print Inklimit Chart (Separate Jobs) - Prints an ink density chart for each enabled ink limit colour combination
as a separate job, using the Media and Pagesetup selected.

Configure Inklimit Chart — Configures the combinations of inks to be tested for ink limits. Select which colours
will be printed, the start and end ink percentage points and step increments.

Note: If you have a combination selected but insufficient patches to fill the row, an empty chart will be printed.
For example, if you select to print 3 ink limit and have 2 colours selected, only the chart border will be printed.
Preview Graph - Show a graph of the patches currently turned on. See the Graph section for more information.
Sift and Sort - Enable or disable to option to Sift and Sort the patches in the Paper Profile.

Reorder Inks - Change the order of the inks in the paper profile to match the order used in the ICC profile.
Often used for N-Colour profiles. A list of ink channels opens for you to highlight and move using the up and
down arrows, or drag and drop inks to the required position.

Upgrade - Upgrades a legacy (pre-version 5) paper profile to the latest version.

o000 | LA

0:0047 D:0851 D:1272 n}‘m
V:0043 V:0074 V:0087 V70094

Density Patches
This area shows the patches making up the Paper profile. Each patch represents a dot size or combination of dots
available to the printer being profiled.

The number of ink channels shown and the number of patches shown for each channel will vary, depending on whether
the printer has variable dot capability; if it has light inks; and if the light inks are configured to be treated as separate or
combined channels. These options are selected in the Output and Custom Settings of the Media chosen when creating
the Paper Profile.

Before densities have been measured, all patches will be turned on and will have default density values. These densities

are updated with the data input from the Measure Patches option.

1 \3\ / g \4\ /'/

Patches can be turned on or off by clicking the upper half of the patch. 8‘1 g-gsg M D: 2505 In- 712
Clicking the lower half of the patch allows you to manually enter — 0.662 Cyan Densiy: 2505
density values for that patch number. For colours that have visual and : llnkamoum. 67%

.. . D: 0.050 - Dot percentage: 118%
colour densities, select the letter you wish to enter a value for - D for :  Dots: Medium Cyan

X X : V: 0.058 I

Density or V for Visual. When entering values manually, ensure the i Large Cyan
patch sort order is set to Patch Number. [1)_ 0051 ; 1304 ;-\f <ol | b X664
Note: If patches are measured in Lab mode, each will display an L v:0.058 | (AL RELs ,v;'/oféxas )/0(712
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value, rather than density values.

* Pressing Enter or TAB stores the value and moves to the next patch for entry.

* Hovering the mouse over the patch number displays a tooltip, providing information about the patch.
Note: Hovering the mouse over an Lab measured patch displays a tooltip with patch information, including the
Lab value.

Sift and Sort Options
When enabled, the Sift and Sort options for each active ink channel allow users to set the patch order and sift for the
optimal combination of dots for the printer to use for that channel.

* Sift - Uses one of several intelligent algorithms to select a suitable dot combination based on the density
readings taken and the output device selected. When used, the popup DotSieve Algorithm Selector presents the
available device/ink Sift options. The Sift selected patches can be switched off or changed if alternate patches
are more appropriate.

* Maximum Ink - This field sets an ink coverage limit for the ink channel by introducing white space into areas of
coverage higher than the set limit. The default setting is 100%, i.e., no limiting. Maximum Ink is a “low level”
setting applied during screening.

¢ SortOrder:

o Patch Number - Sort the patches in patch numbered order.

o Colour Density - This is the density of the colour, sometimes called Real Density. It is the colour
content of the patch.

o Visual Density - This describes how dark the colour is, i.e., how much light the colour is absorbing,
measured as Black. This sort option is not available for Black, where colour and visual density are the
same.

Note: Turning off an Ink Channel

When Treat Light Inks as Separate Channels or N-Colour options are enabled, the user has the option to turn off one or
more of the printer ink channels.

Some inks - often Cyan and Magenta - produce patches with a high colour density while not being very dense visually.
During the process of calibrating a printer, if you find that even the small dot (patch 2) of an ink has a colour density too
high to enable that colour to pass a particular calibration standard, you can turn off that ink channel by de-selecting all
the Density patches for that ink. This should only be done where multiple inks

of a particular colour are available. For example, if patch 2 of the Cyan is still .., 1 2 3 "2
colour dense, you can switch Cyan off and use only Light Cyan. Cyan  p-0.061 [D:0.693 'D:1.250 D: 1943
Switching off an ink channel will have effects through the calibration process, V:0.057 [MEOK06] WEOISON |V 0.775,
in particular, when configuring Ink Limits. When configuring the ink limit 1 2 K [ [

chart, the number of available inks will need to be reduced and the disabled ©®" p 0063 D 1207 |D: 2474| D:2714
ink channel should not be used in any of the combinations on the Ink Limit V:0.058] |V: 0.7C4] |V 1.004, |V: 1.208
Chart.

000 Paper Profile Graph

Paper Profile Graph

The graph shows the dots selected for each colour. The position on the graph gives
a proportional representation showing where the dot starts to turn on or off, and " .
their relative proximity to other dots. You can turn the individual colour graph
plots on or off by checking the tick boxes under the graph. Hovering the mouse
over a point on the graph displays a tool tip, giving you information about the dot. e

If a colour is not shown on the graph but the check box is ticked, the dots selected =
are most likely a poor choice and may not be valid; or that the ink channel has
been turned off by not choosing any of its dots (Separate Ink Channels only).

ion Control | Ink Limits |

Separation Control pperarvpacches
Separation Control gives you the ability to adjust where a light ink
mixes with its respective heavy ink. For example, control where Cyan P
starts and adjust where light Cyan finishes. e @ )

Ink start controls

Magenta: €= ox (3]

Separation Control is available when the Paper Profile is linked to a Back: @ 0% [)
Media for a printer that has light inks enabled and the option Treat
Light Inks as Separate Channels is activated. This is set in the custom o

settings of the Media. The sliders on the left show the inks where ¥ #u ¥m e A e e
control is allowed, i.e., those with light inks as well as heavy inks. The
graph on the right changes as you adjust the sliders, so you can see the
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effect of different values. To view individual inks on the graph, click the ink colour check boxes at the bottom of the

screen.

Ink Limits

The Ink Limits tab has controls for limiting the ink mix of the channels applied in the Paper Profile. The number of ink
channels varies depending on whether the printer has light inks and whether they are being treated as separate or
combined channels. The window to the right displays a summary of the driver configuration from the selected Media.

Options

*  Yule Nielsen Number - Set the YN number for the e s o
paper you are profiling (if you know it). The default
is 2. e — -

¢ Ink Limits - Set the ink limits for the Paper Profile. ey e [ Mesobon 72000 x 7200085 3
These are determined after printing a chart and R — o Ao 3
observing the percentage of coverage at which the Thee ke —6» 270% [} Mdm,w o o Luser oo aper 260 3
mixture of inks causes problems. Enter the value Rete—"> BT Fapersource el aoer 1
for each ink combination. L ]l o e st s s o f

e Algorithm - Choose the type of ink limiting. There o ;(: || [ G
are three (3) options: i ok = 400% ] o Corre Auto Cuting On :

o Standard - Simple ink limiting based on ink Nnsink = +10% () Efifi;'w EDK 1
percentages. Ten @ 4205 (] protassck

o Enhanced - Like Standard, but optimised R : [T B
for variable dot printers. It uses
intelligence to calculate the ink limits
based on dots used.

o Linear 3.0 - This setting adds the ink coverage for any area then proportionally limits, according to the
ink limit range it falls within. For example, with 3-ink set to 300% and 4-ink set to 400%, if a 6-ink
area of an image has a coverage of 320%, it will limit the area according to the 3-4 ink range.

o Linear 4.0 - This method limits ink based on the number of inks being used for an area. For example, if
5-ink is set to 390%, any time 5 inks are laid down their coverage will be limited to 390%.

o Linear, favour Black — As more ink is laid down and a colour area approaches Black, this method limits
CMY proportionally more than Black, preventing wetness and inversion in shadowed areas.

o Lowpass - No limiting is imposed until the coverage for combined number of inks reaches the set limit,
at which point any higher ink coverage is clipped to the ink limit.

o Lowpass, favour Black - The same as Lowpass, but favouring Black, limiting it proportionally less than

CMY as colours approach Black.

* Media Information - This side of the screen displays information about the driver and Media configuration
important to the Paper Profile.

Further details on how to create a Paper Profile are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support

Press

The Press data type is used to emulate the properties of a press for softproofing. Each Press configuration can
be assigned a press ICC profile, dotgain curves, press sheet dimensions, the number of ink keys, ink and paper
characteristics; all combining to produce accurate onscreen softproofs.

The Press can be switched on-the-fly while softproofing to instantly show how a job will look if printed on a different
press or on different stock.

Dimensions Colour Management

This panel allows you to enter the size of the printable sheet area of the (- Press ICCProfie ) Nane

press and its number of Ink Keys. The Key Width is calculated from these | G g ) v

values. Soureel[ None 5]

Spectrophotometer (offline)
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Colour Management
This panel is where the Press ICC profile is assigned.

* Press ICC Profile - Select a press ICC. This can be one created on your press or a printing standard ICC which is
used as the target or match profile.
* (Calcheck Chart - Select a chart to verify the SoftProof’s calibration status.
* Paper Colour - Three (3) options are available:
o None - Do not change the paper colour;
o ICC Profile - Use the white point from the press ICC profile and apply as the paper colour; or
o Custom - Allows you to enter your own value for the paper colour. You can also use the
Spectrophotometer to measure the paper white directly into the configuration.

Ink and Paper
Configure the ink and paper properties of the press to simulate their effects in the SoftProof application. This helps to
produce more accurate proofs, allowing you to build up a library of paper and press combinations.

¢ Maximum Ink Weight - Enter a value for the maximum ink weight. This value is used by the InkKeyViewer to
show excess ink.

¢ Stretch Factor - Allows you to enter a compensation factor to allow for stretch. It can be used for distortion
simulation or anamorphic scaling, where one direction will distort more than the other.

Note: The easiest way to calculate stretch is to draw a rectangle 1m x 1m and print it. Measure the rectangle and enter
the value. If the size is 98cm, enter 0.98. If the size is 102cm, enter 1.02.

* Back Page Opacity - Enter a value between 0 and 100%. This controls the amount of show through of the back
page through the front page when reverse page viewing in SoftProof.

* Back Page DotGain Curve - Select a DotGain Curve to apply to the back page when using the Show Back Page
option in SoftProof.

* Top Page - Choose Even or Odd. This is used to determine which page backs onto which, so the correct back
page is shown when requested.
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Screen Printing

The Screen Printing functionality within the Media data type is designed for printing film separations on an Inkjet
printer.

Files submitted for processing are separated into individual plates. Each plate is printed as a black separation with a
halftone dot applied at the colour’s respective screen angle.

Printing to film generally requires the output density to be higher than that for normal proofing. Higher densities are
achieved by increasing the print resolution, or by assigning one or more inks to be laid over the black dots.

Configuration

The configuration is very similar to a standard setup to print to a device. The Output configuration is the same and the
appropriate Media and Pagesetup’s are created to control the page parameters. A very basic Paper Profile and
Linearisation are also created to complete the setup.

Output Configuration
The Output for the printer is set up normally.

An Output Driver is assigned; Destination Driver selected; and Collating options are enabled (if required). Once the
Output is created, the Media configured for screenprinting (see below) should be assigned so only screen print
separations will print to the film.

Media Configuration
*  Output Driver - Select the driver as set up in the Output created for the screen printing configuration.
* Resolution - Choose an appropriate resolution.
A higher density can be achieved with a higher resolution, however, it is slower to process and print. A lower
density may produce sufficient density, depending on the printer and media used.
* Colourspace - Select CMYK
If using the Black Ink Combination only, choose Gray as the Colourspace, as this may result in slightly faster
processing. However, in this mode inks cannot be mixed to produce a denser output. Selecting CMYK and
configuring a Paper Profile will allow the choice to use Black only of a mix of colours at a later stage, without
having to recreate a Paper Profile.
* Custom Settings - Select the appropriate media, choose Uni-directional or Bi-directional and turn the Use Light
Inks option off.
Bi-directional is faster but may produce slight banding or may not be as dense as printing Uni-directionally.
Using Light Inks will affect the patches in the Paper Profile. In Screen Printing mode, only one patch can be on
per colour.
* Screen Printing - Enable Screen Print Mode and select Black for the Ink Combination (and any others
required).
Once this option is selected, jobs submitted to this Media will always be separated and printed using the
selected colours. One or more inks must be selected from the available choices. If Gray is selected as the
Colourspace, only Black will be shown as a choice.
*  Output Screening - Select Halftone and tick the SuperCell option. Choose the preferred dot shape and enter the
screen angles and rulings.
SuperCell gives a better-shaped dot and the round dot tends to be more commonly used. The default angles of
15, 45, 75 and 90 are shown by clicking the Defaults button, however, these can sometimes produce
undesirable effects, mostly caused by the Yellow plate. To counteract this, offset all angles by 7.5 degrees to
make them the following:
o Cyan-22.5 degrees
Magenta - 82.5 degrees
Yellow - 97.5 degrees
Black - 52.5 degrees
Special - 52.5 degrees

O O O O
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Paper Profile Configuration
In Screen Printing mode only one patch can be turned on per colour. Therefore, the value for the patch does not matter
- which one chosen does.

For a variable dot printer, when the Use Light Inks option is turned off, there will be four (4) patches for each colour.
The first patch represents the media and the other three the dot sizes (small, medium and large). A dot size for each
colour must be chosen. If the Colourspace is Gray, Black will be the only available ink.

The image here shows an example using the patch 4 of Black and patch 2 of each Cyan, ' N P4
Magenta and Yellow. There is no need to measure the value for the patches, the default D: 0.067 | | B 0.782 | 0% 1550 [HPRIE
values are sufficient. Comparative densities are not relevant when only using one dot 1 2 NN
(patch). D:0.065 | BRI |D: 1853 | D 2217

v: 0.065 | NARRLEN | v71.853 | |V 2.21%
In testing it was found that a combination of large Black (patch 4) and small Magenta ! 2 3 1N
(patch 2) produced good results. If too much is used, for example - large Black, large T ooes [ Ef’ifﬁg 551182
Cyan and large Magenta - the result is wet output and the dots tend to “fill in” the L ) SN M S
shadow area. Large dots of a colour like Cyan will produce film looking blue instead of b: 0.061 | [DIOT0% D;i-.;;:\m ol;:,r}}{;o
black. Black should always be the dominant colour. V:0.061 V:0.704 V01410 ¥ 1.410
Ink Limiting

There is no need to enter any Ink Limiting as the plates are separated, so there is no mixing of 2, 3 and 4 inks. This is
different to ink combinations in the Screen Printing mode.

Linearisation
As Screen Printing mode prints only Black separations, the creation of a simple Linearisation (Gradation) Curve to be
applied to the Media is all that is required.

Follow the steps below to make a simple Linearisation Curve:

1. Open the Lineariser application.

2. Select the Media used for screen printing and print a chart for your Densitometer to read. Only the Black
channel patches will be printed and measured.

3. Measure the values using your connected instrument and save the chart.

4. The curve will be automatically allocated to the selected Media. You can check this by viewing the Media in the
Workbench to make sure the curve is attached to the configuration.

Summary
The above is a guide to configure a setup to print film separations for use in the Screen Printing industry.

Run some test jobs to choose the most suitable patches, ink combination and resolution for the device and media being
used. If a different resolution or colourspace is selected or the light inks are used, a new Paper Profile will need to be
created. Trying different dot sizes will mean adjustment of the Paper Profile - changing which patch is turned on in
each channel.

During the testing period many combinations of ink (colours), dot sizes and resolution were tried. Different output
devices and media will produce varying results, so a combination of patches and ink mixing may work better. The
higher resolution (1440dpi) produced the most dense output at around 4.18D, but takes longer to RIP and print. By
running at a lower resolution (720dpi), the jobs processed quicker but the density drops to just under 3 at around 2.8D.
This is often acceptable for many applications, but will vary depending on the media and device used. Testing will prove
the most suitable setup.

The most commonly used settings were CMYK colourspace, with an ink combination of Black and Magenta. This used
the large Black (dot 4) and the small Magenta (dot 2) in the Paper Profile and gave a slight reddish tinge to the Black,
which is desirable in the Screen Printing industry.
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The Monitor application is central to the Megarip Client
interface. It displays jobs before, during and after
processing and allows users to manage jobs through the
system to plot their progress. The Monitor provides
feedback from the Server and Client via logs. Modules can
be added and configured to suit specific requirements.

The Monitor consists of one or more user-defined tabs.
Modules are added, positioned and sized according to
individual preferences. Settings are saved at the Client level,
enabling Serendipity Clients on different systems or in
different departments to display information appropriate to
their location.

The Monitor can be in one of two modes - Edit or Use.

Edit

This mode allows the user to move and resize modules on a tab. The mouse pointer changes to a cross when in Edit
mode. Resize a module by grabbing the corners or sides and dragging to the preferred size. Click anywhere in the
modules and drag it to the desired position. Modules close together will snap-to each other.

While in Edit mode, all Monitor Modules have a contextual menu available (right-click) with the following options:

* Remove (Module) - Removes the module from the Monitor tab.

* Set Size For (Module) - Allow the user to enter a width and height (in pixels) for the selected module via a
resize popup.

* Duplicate (Module) - Duplicates the selected module. The duplicate has all the size, layout and configuration
options of the original.

* Use Layout - Switches the Monitor to Use Mode.

Use
This is the normal user mode. It locks the module sizes and position and allows you to configure the modules
preferences and manage jobs. Select this after Editing to use the configured layout.

Menu Options

Layout
¢ Edit - Switches the Monitor to Edit Mode (see above explanation).
¢ Use - Switches the Monitor to Use Mode (see above explanation).
* Dynamic Update - Enables or disables updates to the modules while in Edit mode.
* Show Titlebars - Shows or hides module titlebars.
* Add Modules - See the “Monitor Modules” section for further information on each module.
* Load - Loads a previously saved Monitor configuration.
* Save As - Saves the current Monitor configuration.
* Search Ul (User Interface) - Activates a search bar for finding buttons and functions in the current Monitor tab.
Note: Module Toolbar functions can only be searched if the toolbar is open.

* New Tab - Creates a new tab.

* Rename Tab - Renames the currently selected tab.

* Duplicate Tab - Duplicates the currently selected tab and all modules within it.

* Choose Tab Colour - Allows the user to select a colour for the currently selected tab.

* Choose Tab Image - Allows the user to select an image for the currently selected tab background. Valid types
are PNG and JPEG. It is recommended a large image not be used, as it will take up memory.

* (lear Tab Colour/Image - Reverts to the default background colour.

* Remove Tab - Deletes the currently selected tab.

* Remove All Tabs - Deletes all tabs.

* Next/Previous Tab - Switches to the next or previous Monitor tab (right or left).

Reordering Tabs
Tabs can be moved to a new position by clicking on and dragging the tab to the desired place in the order. A red pointer
appears, showing the drop point between two tabs.
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Monitor Modules

Modules are used for managing jobs as they pass through the system and to monitor Server and Client activity. The
modules can be added to a tab as part of a Monitor layout, or selected as a Floating module, where the window is stand-
alone. Modules are added to a Monitor through the Layout menu; floating modules are available from the Modules
menu.

There are nine (9) modules to choose from:

* (ClientLog - Displays a log of Client messages that may be generated during normal Client operations.

* ClusterStatus - Monitors the progress of Imaging and Rendering tasks on the Server and any active Cluster
Nodes.

* DropZone - A place to drag and drop files for processing.

* MediaStatus - A window showing the current calibration status of a Media data type and a progress bar
showing the amount of media (e.g. Paper) used.

* QueueManager - View and manage jobs after they have been submitted for processing.

* QueueStatus - A progress meter showing the current status of active jobs on the selected queue.

* ServerLog - Displays any system, error and polling messages from the Server.

* Status - Shows the disk status (usage) of the Server processing areas.

¢  Thumbnail - Displays a thumbnail of jobs as they image or render.

ClientLog
The ClientLog displays any messages that pop up during normal Client operation. There are different levels of message,
from informative to serious errors. All messages are held for a user-determined length of time.

* Fetch back log - Displays the log for the
time specified. For example, it retrieves e ok g (S CTimoerios) (Boo) o 0 1B N
and displays the last 4 hours of messages.
Choose the time from the pull down list.

* Trim older lines - Trims the log based on
the time selected in Fetch back log. If this
is set to 60 minutes, the log file is trimmed
back so only the last 60 minutes remain.

¢ Export - Allows you to export the log to a
file.

Type Date ¥ source s rror ction
10/0..9AM  ICCOpenProfile sslib 0 0 oK

Note: When you export the log file you can choose to export everything in view or select entries to export. Use the
filtering options and Fetch back log choice to limit the view before exporting. Selecting export displays a chooser,
allowing you to enter a name and select the location to save the file. You can choose to save the file as html or as a tab
delimited text file.

Filtering Options
You can choose which messages to display in the log and which to hide by ticking checkboxes for one or more of the
following filters. All messages are saved to the log, even if filtered.

* Question - Used for messages that ask questions, for e.g., “Job contains unassigned colours. Do you want to add
them to VirtualPress.”

* Information - Used for messages that tell you something, for e.g., “Job has a duplicate plate.”

*  Warning - Used where the message has a higher importance and (usually) the Client failed to do something,
but operation can continue, for e.g., “Failed to save new password. Old password will continue to be used.”

¢ (Critical - Used for serious errors that will most likely affect operation, for e.g., “Failed to load rendering .dll.”
You will normally be required to take action to rectify these errors before continuing.

¢ Search - You can search the log for jobs or messages. Enter the text of characters you want to search for and
the ClientLog only displays the lines that match the search.

Display Options
The following sort columns can be selected using the contextual (right click) menu on the sort column header bar in the
log:

* Type - The level of the message reported. For e.g., Question; Information; Warning or Critical.
* Date - The time the message was reported.
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Source - The module or application that reported the message.

Summary - A summary of the message that was reported.

Command - Internal command used to communicate messages to and from the Server by the Client.

Error - An error code reported by the Server. This is useful for de-bugging problems.

Action - The action taken by the user relating to the message. For e.g., the button pressed when the message

popped up.

The order of the columns can be changed by clicking and dragging them to the desired position, or by using the
Configure Headers option under the contextual (right click) menu.

ClusterStatus
The ClusterStatus is a monitor allowing you to see the current Imaging and Rendering status of jobs on any active
Master Servers or Cluster Nodes:

ClusterManager - Open the ClusterManager application to manage the Cluster.
Refresh - Update the status.

Increase Inset (+) - Increases the gap between the list items.

Decrease Inset (-) - Decreases the gap between the list items.

Font Options - Allows you to change the size of the text.

DropZone

A DropZone is a place where you can drag and drop files for processing. The user selects Pagesetups, Pagesetup Pools
or the Studio application Asset queue to add to the DropZone as a DropSpot. These DropSpots accept the same file
formats as the DropFolder (Postscript, PDF, JPEG, TIFF Image, Serendipity Megarip Image, EPS, PNG).

The available contextual menu options are:

Add DropSpot - Select one or more Pagesetups/Media to add to the DropZone. Selecting this displays a chooser
window, showing all available Pagesetups/Media.

Add Asset DropSpot - Adds a DropSpot for the Asset queue. Assets are then manually laid out, nested and
printed using the Studio application (see Applications - Studio for more information).

Reorder DropSpots - Displays a reorder window. Select one or more DropSpots in the list and drag them to a
new location, or use the up and down arrow keys to move the position. Click OK when finished.

Increase DropSpot Inset (+) - Increases the size of the DropSpot.

Decrease DropSpot Inset (-) - Decreases the size of the DropSpot.

Font Options - Allows you to change the size of the text.

Additional contextual menu options are available for individual DropSpots:

Remove DropSpot - Remove the selected DropSpot.

Edit Pagesetup - Allows you to edit a section of the selected Pagesetup, all sections or create a new one.
Edit Media - Allows you to edit a section of the selected Media, all sections or create a new one.

Change DropSpot - Allows you to change an existing DropSpot.

Set Copies - Set the number of copies for every job dropped on the zone.

Set Colour - Select a colour from the list for the currently selected DropSpot.
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MediaStatus
The MediaStatus module has two (2) functions:

1.

To show the current calibration status of a selected Media data type.
For the calibration status to be shown or updated for a Media, it must have been Calchecked using the Calcheck
Media menu option (see below) or the Check Media option in the Calcheck application.

To show how much of the media (e.g. Paper) has been used.
A meter is displayed graphically, detailing the percentage used. For the Usage meter to function, values for the
Media Length or the number of sheets loaded must be entered in the Output section of the Media data type.

Each Media displayed in the MediaStatus window has the following information:

® O O Medi —admi lo.swdevel dipity-software.com.au:9100 - NFR (...

Media Name
Calcheck Status - Toggled via the Calcheck Info option (see © 3880 PPPGtab1440
below). Displayed as one or more Ticks/Crosses to the right
of the Media name, showing a Calcheck Pass or Fail against
the user-defined AE, AH, or AC. Hover the mouse over each Chart: GRACoLCoated1_IS012647-7_ControlStrip2009

to show a tooltip displaying the AMax and AAvg values. Seore 788 L]

Used 4.32 m of 431.80 mm (1000%) Reset Counter

Usage Meter - Bar showing the amount of media used. Text —

under the bar states the exact amount used as a percentage of e Coan 169 J
the total units. Sehiagernlo =2

Reset Counter - Resets the usage count for the Media. fe Yellow 137 feAverage 159
Logged Period - Time period (date and time, from and to) the Ae Black 166

Media has been tracked since the last reset. This information fetmimim 555

is shown/hidden using the Show Extended Info option.
Printed - Number of jobs and total printed area of jobs
tracked since the last reset.

Calcheck Info - Displays the complete Calcheck summary
information for the selected Media resulting from the last Calcheck. Includes the Calcheck Chart used, internal
Calcheck score, Date/Time of Calcheck and Avalues.

Ae Gray 0.00

Qe Paper 0.98 feoc 123

A contextual (right click) menu has the following options:

Change Media - Change the selected Media for display in the status window.

Edit Media - Edit all or part of the selected Media. Copy it, or create a new one.

Calcheck Media - Opens the Calcheck application. Once a chart has been printed and measured, the results are
saved to the Media and the Calcheck Info for the Media is updated in the MediaStatus window.

Media Order - Allows you to configure which queues are viewed by the MediaStatus window. Move Media
between the Available and Showing columns in the popup chooser.

Show Extended Info - Show/Hide the Logged Period and Printed information for the selected Media.

Show Calcheck Info - Show/Hide the full Calcheck Info summary for the selected Media.

Metric Units — Toggle between Metric or Imperial units for measurements shown in the MediaStatus window.
This is enabled by default.

Increase /Decrease Status Width - Increase or Decrease the width or all Media panels in the window.

Font Options - Allows you to change the size of the text in the window.
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QueueManager

The QueueManager views the jobs in the system after
they have been submitted. Queues can be viewed
simultaneously, showing a job’s progress through the
system. From the QueueManager, jobs can be
manipulated in a number of ways, such as holding,
promoting and deleting.

View Options
There is a lot of information available for viewing about
each job as it passes through the system.

The following sort columns can be selected using the
contextual (right click) menu on the column header bar
in the QueueManager display panel:

* Name - Job name.

* Process Time - Time taken to process the job.

¢ Status - The jobs current status.

*  Source - The source of the submitted job.

* Date - The date and time the job was
processed.

* Media - The Media used to process the job.

* Pagesetup - The Pagesetup used to process the
job.

*  Queue - The output queue the job was sent to
for processing.

* Size - The size of the job (disk space used).

*  Width - The width of the job

¢ Height - The height of the job.

¢ DPI- The imaged resolution of the job.

Toolbar Options

~ admin@gols 9100 - NFR (not for resale)

ails ) (~ Smaller Thumbnails ) eue Thumbnails (| Show Idle Queues ¥ Group By Queue

(" Delete )

ve To Pagesetup... ) (_Copy To Pagesetup... ) (_ Nest Jobs

T T TT—
Calculate Ink Weight...

Name 4 |Process time
FODCO7E2EBES4BBC 00:00:00 Done

FA3F2947CE3C490500:00:00

10f 2 jobs

Show: [ Jobs 4] ™ Active ™ Waiting ™ Done RN

Refresh All Queues ) (" Export. Calcheck job.

ssssss Date & Media size
10/03/09 11:00 AMNone 15.32M8

6/03/09 11:11 AM 8-bit tiff convert 52.28MB

Source
JPEG
Done JPEG

Output Colourspace - The colourspace of the
output file.

Copies - The number of copies of the job.
Screening - The screening applied to the job.
Thumbnail - Shows a thumbnail of the job.

Job ID - The internal Megarip ID number for
the job.

Node - The Server or Cluster Node the job was
processed on.

Page - The page number of the job.

Publication - The publication name.

Notes - The number of notes saved with the
job.

Section - The section of the publication.

*  Queue Order - Allows you to configure which queues are viewed by the QueueManager - Available & Showing.
* Render Queue Thumbnails - Enable or disable thumbnails for the Render Queue in the Thumbnails view of the

QueueManager.

* Show Idle Queues - Show/Hide entries in the QueueManager for idle processing queues.
*  Group by Queue - Enable/Disable the grouping of jobs by Queue before other column sorting is applied.
* Show - Show certain jobs in the QueueManager. Select any or all of the options to filter jobs. Choose from:

o Jobs - Display all jobs as text line entries.

o Thumbnails - Display all jobs as thumbnails. This is the same as the Print Gallery mode.
o Publications - Only display jobs belonging to a publication.
For any of the above display modes, further filtering is available:

= Active - Jobs currently processing.

=  Waiting - Jobs with a status of Waiting,.

= Done - Completed jobs.

* Search - Find jobs that are in the queue. All jobs matching the search text will be displayed. All elements of the
jobs are searched against, not just the name, so this can be a useful filtering tool. The search can be inverted
with cmd+shift+] (Mac) or ctrl+shift+] (Win). The search box will turn black to indicate when the inverse

search is selected.

There are a number of actions that can be performed on a job. Options become available when one or more jobs are
selected. Only actions valid for the job status are shown. For example, the action to Nest Now is only available if the job

has a status of Waiting to Nest.
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The following are available in the Toolbar or by selecting job(s) and right clicking to access the context menu:

Job Info - Shows information about the currently selected job. The Job Info contains all details of how the job
was processed and displays a thumbnail preview of the job and its configuration. Right clicking on the window
and selecting Print can print the Job Info to a system printer.

Note: Job Info & thumbnail can also be displayed by double clicking on the job. If multiple jobs are selected, double
clicking will display info about all in the window. Holding the control key (Win) or command key (Mac) will allow the
font size to be adjusted via the mouse wheel for easier viewing.

Job Ownership - Displays two panels - General and Ownership - showing the type, created and modified dates
of the job plus the user and group permissions (See Accounts Admin/Secure Mode for more information).
Modify - Allows various attributes of the job to be modified. These include:
o Name - Change the name of the job.
o Publication Name - Change or add a publication name.
o Page Number - Change the page number of the job.
o Copies - Change the number of copies of a job.
o Change Media - Change or assign a Media associated with the job.
Submit - Displays a submit window to print a job or jobs.
Cancel - Cancels the currently processing jobs.
Delete - Deletes the currently selected jobs.
Hold - Holds the currently selected job. Only available when the status is “Waiting”.
Release - Releases a currently selected Held job.
Retry - Retries a failed job.
View Errors - Views the errors of the selected job if the status is listed as Failed.
Rush Jobs - Moves the currently selected jobs to the top of the current queue for processing next. The status
must be listed as Waiting. Jobs currently being processed will be completed first.

Note: Rush Jobs will move the job up the current queue only. If the job is in the imaging queue and Rush Jobs is
selected, the job moves to the top of the imaging queue. Once complete, it will move to the bottom of the rendering
queue. You will need to Rush Jobs again to move it to the top of the rendering queue.

View Imaged - Views the Imaged file for selected jobs in the SoftProof application.
View Rendered - Views the rendered file for selected jobs in the SoftProof application.
Render Again - Submits the selected jobs to the rendering queue for processing. Only available when the status
is “Done”.
Move to Pagesetup - Moves the selected jobs to another Pagesetup. This will send the jobs to the rendering
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one prior
to submitting the job.
Copy to Pagesetup - Copies the selected jobs to another Pagesetup. This will send the jobs to the rendering
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one prior
to submitting the job.
Nest Jobs - Submits the selected jobs to be nested. This sends the job to the rendering queue to re-render for a
nest. The Collating section of the Output is used for the nesting parameters.
Nest Now - This is available when the selected job has a status of Waiting to Nest. Only one job needs to be
selected and all jobs with a Waiting to Nest status will be nested.
Duplex Now - Duplexes any job that has a status of Waiting to Duplex. Only one job needs to be selected and all
jobs with a Waiting to Duplex status will be duplexed.
View FlipBook - Opens the selected job or publication in FlipBook. If the selected job is part of a publication, all
pages will be shown.
Select Publication - Selects all the pages/jobs in the QueueManager belonging to the same Publication as the
selected job.
Refresh All Queues - Updates the queues.
Export - Allows you to export data from the selected job. The available formats are:
o CIP3 - Exports job information to a file in CIP3 format at the selected resolution. You can also select
the orientation before exporting. Further options are:

= Version 2.1

= Version 3.0

= Rotations

=  Surface - Choose front or back.

=  Compress Preview - Choose if the preview should be compressed. Some presses are unable to

handle files in compressed format.
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o PDF - Exports the selected job in PDF at the resolution entered. Further options are:
=  Compressions - JPEG, ZIP or LZW. For JPEG and ZIP you also have control on the level and
quality of compression.

o Postscript (separated) - Exports the current job as a separated PS file.

o Tiff Multichannel - Exports the current file as a multichannel Tiff.
Calcheck Job - Launches the Calcheck application to check a job’s calibration status. The jobname is stored and
the results can be exported or printed. Measurement results from the Calcheck are stored in the Job Info.
Calculate Ink Weight - Displays the Ink Weights window with the selected job’s ink weights and coverage
shown.
Pause/Resume Printing/Processing - Pause or Resume the output queue of the selected job at their current
stage of processing or printing (Imaging, Rendering, Nesting or Printing). Incomplete jobs in paused queues
will display in red.
Change Output Media - Change the Media assigned to the output queue for the selected job. Once re-assigned,
all jobs held awaiting the new Media will begin processing.

Configuration Options
The following options are available from the right click (contextual) menu within the QueueManager window:

Queue Colour - Select a colour for the currently selected Queue for easy identification.

Queue Order - Allows you to organise the queues into your preferred order, or adjust any settings.

Joblist View - View the queue in Joblist mode. This is the same as selecting Show > Jobs.

Publication View - View any publications in the queue. This is the same as selecting Show > Publications.
PrintGallery View - View the jobs as thumbnails. This is the same as selecting Show > Thumbnails.

Edit Output - Allows you to edit the Output and not the job. For changes to be effective, resubmit the job for
printing or rendering, depending on the attribute changed.

Edit Media - Allows you to edit the Media the job was processed with. For changes to be effective, resubmit the
job for imaging or rendering, depending on the attribute changed.

Edit Pagesetup - Allows you to edit the Pagesetup the job was processed with. For changes to be effective,
resubmit the job for imaging or rendering, depending on the attribute changed.

Important Note: When editing any of the items from here, you are editing the queue for all future jobs, not just the
currently selected job.

QueueStatus

The QueueStatus module is a progress meter that shows the current status of active jobs on the selected queue. The
look and feel can be adjusted for the QueueStatus module and the queue it is monitoring. The options are available by
right clicking on the window.

Note: Not all options listed are available on all QueueStatus windows. Some are only available while the job is in
progress.

Cancel Job - Cancels the currently active job and is only available when a job is active.

Job Info - Displays info about the currently active job.

Pause Printing/Processing - Pauses the queue so no further jobs will process. Any job currently active in the
queue will finish. The text in the window changes to red, showing it to be in a paused state.

Resume Printing/Processing - Takes a queue out of a paused state so any waiting jobs can be processed.
Change Queue - Allows you to choose which queue the status window will show.

Edit Output - Allows you to edit the output or create a new one. You can only edit if the queue is showing an
output. If the queue is set to Spooling, Auto Detect, Imaging or Rendering you can only make a new output.
Thumbnail - Turns on/off a mini thumbnail on the printer queues only, which gives an indication as to how
much of the current job has printed.

Font Options - Allows you to change the size of the text.

Queue Order - Select which queues you wish to view. Selecting this presents you with a chooser window
showing two lists - The Available queues on the left and the Showing queues on the right. To move queues
between lists, select one or more and drag from one list to another. Alternatively, double click to move between
lists. The order of the queues in the Showing list determines the order of display. Queue Order can be used to
show multiple Queues in a single QueueStatus window.

Increase/Decrease Indent - Increases or decreases the size of the QueueStatus in view.
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Double clicking the QueueStatus window displays a floating QueueManager window showing that queue. This has the
full functionality of the standard QueueManager.

ServerLog
The ServerLog shows messages from the Server.

* Fetch back log - Displays the log for the time : o)
specified. For e.g,, it retrieves and displays the
last 4 hours of messages. Choose the time from
the pull down list.
e Trim older lines - Trims the log based on the | =i
time selected in Fetch back log. If this is set to
60 minutes, the log file is trimmed back so only | *w&rss ?

the last 60 minutes remain.
¢ Export - Allows you to export the log to a file. Selecting this displays a window with further options as detailed
below:
o Destination File — Choose the filename and location where the file is to be saved. Use the Browse
button to navigate to your preferred location.
o Message Lines — Choose to save all messages in the log window or only those that are highlighted. This
way you can save just a few lines if desired.
o Format - Choose the format to save the file in, either html or plain text. The plain text file is saved with
tab characters between the columns.
o Cancel - Revert to the Server window without saving any changes.
o Save - Save the file based on the settings selected.
*  Configure Filter - You can filter messages in the log. Choose between the following options:
o Completed Jobs - Shows messages about completed jobs.
o Polled Jobs - Shows messages about polled jobs.
o Errors - Shows errors from the Server.
* Search - You can search the log for messages. Enter the text of characters you want to search for and the
ServerLog will only display the lines matching the search.

Display Options
* Module - This is the function that the Server used.
* Routine - This is the operation inside the function.
* Date - The time the Server called the module.
* Message - The message resulting from the routine.

Status
Status shows the current disk status (usage) of the Server processing areas, such as spooling, temporary directories and
DropFolders. Editing the ss.conffile in the installation directory under the “etc” folder can change disk locations.

The available options are:

Spool &
¢ Update - Checks the disks and updates the view. orint =

* Preferences - Sets the Status window preferences. A further option
available is: 5]
o Update Interval - Sets the time between updates. OSTemp &
* Colour Scheme - Changes the colour of the Status window. Dropfolders &

* Font options - Allows you to change the size of the text.

Thumbnail
This module displays a thumbnail of jobs as they are imaging and rendering. Thumbnail progress is updated at the
same time as the Imaging or Rendering QueueStatus is updated.

The following options are available from the contextual menu (right click):
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¢ Show Imaging - Show the Imaging thumbnail, denoted by “gears” in each inset.

* Show Rendering - Show the Rendering thumbnail, denoted by a “paintbrush” in each inset.
¢ Normal Thumbnail - Displays a small thumbnail.

¢ Large Thumbnail - Displays a large thumbnail.

Each active Thumbnail module may only show either Imaging or Rendering, not both.

The module window displays as many Thumbnail insets as there are simultaneous Imaging/Rendering tasks
configured in the Server Settings.
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Applications

The applications available within Serendipity Megarip add functionality to the Client and provide additional tools for
managing the Server and your jobs.

There are eleven (11) Applications available, including the Workbench and Monitor. All are accessible via the
Applications menu in the Client. Some, such as Calcheck, can be launched via other Applications or Monitor Modules.

The available Applications are listed here with further details on each following:

Archiver - Make partial or complete backups of your Workbench configurations.

Calcheck - Verify the calibration status of a printer or monitor.

ClusterManager - Allocate and manage Imaging and Rendering tasks across multiple computers and
networks.

Densitometer - Measure and display density readings taken with a Densitometer or Spectrophotometer.
FlipBook - Display a publication as a 2D or 3D virtual book.

Lineariser - Create a Linearisation curve for use with a Pagesetup or Media.

Monitor - Display and manage jobs as they pass through Megarip (see the “Monitor” section for more
information).

MonitorCalibrator - Create ICC profiles for system monitors for accurate onscreen colour softproofing.
SoftProof - Proof jobs onscreen.

Spectrophotometer - Display, compare and/or save colours measured using a Spectrophotometer.

Studio - Designed for the manual nesting or tiling of jobs.

Workbench - The principal configuration tool for Megarip (see the “Workbench” section for more
information).

Archiver

The Archiver allows you to make backups or archives of [@a5 e e T N ot Tor e

your Workbench configurations. Individual items or mfif,ﬂ?i?ﬁln‘?;;’éiﬁ?z; lTEEQ'SZZIZEZZZ

complete systems can be archived for safekeeping. Stored Qomginsamrle | Oaancure 0 e e
items can be loaded into the Archiver for adding to the 800 OIRECT NESTING Ot e o
Megarip database. This can be used for copying a database 335%35522353% et o s .

to another Server, or for recovery from failure or corrupt | .= Qupur e s
configurations. You can configure the Archiver to R Sgnare Grove B :iz‘“?éiséyﬁl%’i%‘#%“"
automatically backup your settings on a regular basis. "ot trea " o L oce Sols o 780 / 75008

> Epson 11880 Fogra3d  Pagesetup Media Type Premium Semimatte Photo Paper
@ Epson 11880-Fuji Paper Profile 250 (Roll)

Important Note: Archives cannot be back-ported to 1 Ereon 7800 Kodak Rai.. Papr Pl

previous versions, i.e., version 5 archives cannot be used son 7880 Ot i
) . . . . @ Epson 7880 Semigloss ... Paper Profile Sheet width for user 0.0000
Wlth version 4. VerSIOH 4 arChlVES can be used Wlth 'Epsan 7880 Semimatte .. Paper Profile defined page sizes
. K » " Epson 7880-Fuji1440x... Pagesetup Sheet height for user 0.0000
Version 5 however, and will be automatically allocated to |, & serunse. e none e
their respective databases when loaded. s @Erson 7080 Semimate. e ConorComiol Ao Cutine O

@ Epson 11880-Fuji1440... Paper Profile Paper source Roll Paper

Sheet size Roll
» @ Epson 7800-Kodak Rap... Pagesetup

Epson 7900 Output

File Menu Options

Open Archive - Open a previously saved archive. A chooser window allows you to browse and select an archive
(.sdb file) to load. You can also load an archive by dragging the database into an open Archiver.
Save Archive - Saves the archive to a (.sdb) file.

Close Archive - Closes the currently opened Archive. Frequency.  Never —

Perform Full Backup - Adds all Workbench data types to a new What day: § v ey B 1 | ) (o -
Archiver window. Once done, you are prompted to choose a name What Time: 000000 |

and location to save the file. Once saved, the Archiver window is Location

dismissed automatically. (Cibirectory... )

Automatic Backup Prefgrences - Allows you 'Fo configure the o —
frequency, time and location that a system backup is performed. The = Concel) (D

options are:
o What Day - Choose a day of the week, every day, every number of days or never.
o What Time - Choose the time the backup is performed.
o Location - Choose the location the archive should be saved to.
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A check is performed when the Client is first started and every hour afterwards to see if a backup should be performed.

The Client must be running for a backup to take place.

The table below gives you a guide as to when a backup would occur in different scenarios.

Auto Backup Time Client Started Client Quit Time Backup Performed
Monday 2am Monday 9am No When Client is started - 9am
) Tuesday Tuesday 12:30pm
Tuesday 12:10pm 9:30am No
Everyday Tuesday o Whle; 2C(l)lent is s}:a;ted -
12am Midnight 8:20am -vam each day
The following
Thursday
Wednesday 11pm 8:30am No Wed at 11:30pm
Sunday 10pm Monday 8am Friday 5pm Never

Edit Menu (and Context Menu) Options

* Add to Archive (All) - Select everything or all of a particular data type, for e.g., All Pagesetups.
¢ Add to Archive (Selection) - Allows you to select individual items from the database to add to the Archive.
Selecting the type, for e.g.,, Gradation Curves, displays a chooser with all the Gradation Curves allowing you to

choose one or more to add to the Archive.

¢ Add to Database - Choose to add items from the Archive to the database. You can add the whole Archive or

selected items.

¢ Remove from Archive - Remove the selected items from the Archive.

* Collapse - Collapses the selected items if they are expanded.

* Expand - Expands selected items if the item contains references (denoted by a ‘+’). For example, a Pagesetup
will contain at least a Media, an output and ICC Profiles. Expanding the Pagesetup will display the other items

connected with it.

* Open/Save/Close Archive - Open, save or Close the Archive as mentioned previously.

Calcheck

The Calcheck application is used to verify the calibration status of a printer or monitor, ensuring proofs are printed

and/or softproofed accurately.

The user manually defines or imports Lab or CMYK values from a
number of sources to create a Calcheck Chart. The chart represents the
print/press standard against which the printer or screen are to be
checked (see the Workbench - Calcheck Chart section for more
information).

For printers, the selected Calcheck Chart is printed from Calcheck to the
Pagesetup and Media being used to proof jobs (or a chart can be
assigned to a Pagesetup to print with each proofing job). The chart is
then measured using a supported Spectrophotometer.

For monitors, the Calcheck Chart is selected, a supported display
Spectrophotometer is placed on the screen to measure the patches from
the chart as the Calcheck application cycles through them.

After the measurement phase, the results are displayed in the Calcheck
window. A pass (green tick) or fail (red cross) is determined by whether
all the measured patches fall inside the tolerances as defined in the

800

Calcheck - admi devel

:9100 - NFR (not for resale)

A012
A01S
Ao011
18016
A007
18007
A010
A013
A0L7
A008
A004
18005
A009
A002

Summary for (fogra media wedge)

VoBed AH  AC

BeCyan 1.79
Be Magenta 2.63
e Yellow 3.57
BeBlack 1.08
BeGray 0.00
Be Paper 2.18

Epson7800-
Media | ineara

Date 16/06/09 12:00 PM

Score: 74.03

Colour (ref) Colour (meas) Lab (cef)

I 2 40, 40.30, 21.90
[ [ .00, -40.90, 14.50

I I /1.40, 23.10, 16.60
(N . +3.90, -20.90, -49.80
89.70, -4.50, 94.70
[ I 8.60, -67.50, 28.00
(N . 53.50, 38.40, 28.80
[ I 360, 44.60, -1.80
N I 2120, 3.40, -23.00
91.30, -4.60, 63.10
(N I 47.20, 75.90, -3.80
[ ——58.90, 47.70, 37.00

93.30, -3.30, 30.60
[ R 67.60, -27.10, -36.50
22022107320

18011

=)

@ rint

O Monitor

Spectrophotometer (offiine)

CGATS / 10 12642 file

v

BeAverage  2.13
OeMaximum  4.44
sec  0.90

Lab (meas)
33.17, 38.20, 18.07
34.13,-39.20,10.45
38.82,25.58, 14.16
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Calcheck Chart. The results can be printed as a label to a system printer, or depending on how the Calcheck was
initiated, saved with the Job or Media (see below).

The Calcheck window is made up of a Summary Panel (top), Display Panel (centre) and a Device/Spectrophotometer
panel (bottom).

Summary Panel

The Summary panel contains information about the completed Calcheck. This information is available for view within
the MediaStatus module, the Calcheck Info section of a Media, or the Job Info window of jobs that have been calchecked.
The following information is displayed:

* Summary for - The panel title shows the Calcheck Chart used for the check.

* Ae/AH/AC - These tabs switch between summaries of the three respective A standards. The tabs available
depend on which A standards are defined in the chart for the Calcheck. The Ae summary values listed are CIE76
by default. This can be changed to CIE94 or CIE2000 by setting either as the measurement standard in the
Calcheck Chart.

* Job/Media (Print mode only) - The Job or Media being calchecked. The field displays N/A if a Calcheck is done
without assigning a Job or Media to it.

¢ Date (Print mode only) - The date and time the Calcheck was completed.

* Monitor Area Toggles (Monitor mode only) - A 3x3 grid of buttons can be toggled to include or exclude the
Calcheck results for each area of the monitor in the Calcheck summary. Once a monitor area has been
calchecked the button will be marked with a tick (pass) or a cross (fail).

* ACyan/AMagenta/AYellow/ABlack/AGray/APaper — The A values for the significant CMYK process, gray and
paper (substrate) patches are displayed here.

* Pass/Fail - Displays a green tick (pass) if all the measured patches fall within the A tolerances as defined in the
Calcheck Chart. A red cross (fail) is displayed if any patches measure outside the defined tolerances.

* A Average - The average delta of the patches measured in the Calcheck.

* A Maximum - The maximum delta measured for any patch in the Calcheck.

* Ao - The standard deviation of the patches (from the A Average).

* Score - The relative quality of the print or monitor Calcheck as compared to the reference values. Rated from
1-100.

Display Panel
The Display panel contains the detailed reference and measurement data for each colour patch in the Calcheck Chart
being checked. Colour patches that pass are shown in black, those that fail are shown in red.

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the
display panel. The columns can be reordered by using drag and drop, or by using the Configure Headers option in the
contextual menu.

Headers available for sorting are:

* Name - The name of the colour patch.

*  Colour (ref) - A colour swatch of the reference colour in the Calcheck Chart.

* Colour (meas) - A colour swatch of the measured colour.

* Lab (ref) - The reference Lab values of the colour patch in the Calcheck Chart.

* Lab (meas) - The measured Lab values of the colour patch.

* Ae max - The maximum Ae (CIE76, CIE94 or CIE2000) tolerance value for the patch as defined in the Calcheck
Chart.

* Ae - The measured Ae (CIE76) of the colour patch.

* (CIE94 - The measured Ae (CIE94) of the colour patch.

* CIE2000 - The measured Ae (CIE2000) of the colour patch.

* AH max - The maximum AH tolerance value for the patch as defined in the Calcheck Chart.

* AH - The measured AH of the colour patch.

* ACmax - The maximum AC tolerance value for the patch as defined in the Calcheck Chart.

* AC - The measured AC of the colour patch.

* DeltaL - The measured delta L of the colour patch.

¢ Deltaa- The measured delta a of the colour patch.

¢ Deltab - The measured delta b of the colour patch.

* Location - Used in monitor Calchecks. Shows from which of the nine screen positions the patch was measured.
For print Calchecks this field will read “N/A”.
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Device/Spectrophotometer Panel
This panel allows you to choose whether a Print or a Monitor Calcheck is required and which measuring instrument is
to be used.

e Device - Choose whether to Calcheck for a Print or a Monitor.

Print Mode

* Spectrophotometer - Choose which Spectrophotometer is to be used for measurement from the list of
supported instruments.

* Measure - Initialises the chosen instrument and opens a popup window to select which Calcheck Chart is to be
measured. Measurement begins after the chart is selected. The data from a chart measured by a third party
software package can be loaded for a Calcheck be selecting CGATS/IS012642 file from the instrument list. The
file must have been saved in an appropriate format.

¢  Print Chart - Opens a chooser window to select the Calcheck Chart for printing, and the Pagesetup and Media
to submit the chart to. The chart will be printed in a configuration suitable for reading by the chosen
instrument.

Monitor Mode
* Instrument - Choose which display Spectrophotometer is to be used for measurement from the list of
supported instruments.
* Measurement Type - Select which of the nine (9) areas of the monitor to Calcheck, or choose 3x3 grid of screen
to sequentially check all areas of the screen. Pass or fail results will be displayed on the Monitor Area Toggles
as each area is calchecked.

Note: Before calchecking a monitor, it is recommended that the monitor be calibrated to the required ICC profile using
the MonitorCalibrator application (see the “Applications - MonitorCalibrator” section for more information).

Menu Options
The following options are available from the Calcheck menu or the contextual menu (right click) from within the
Calcheck application:

* Load Media - Select a Media to load into Calcheck. Any Media that have been calchecked previously will display
complete results of their last Calcheck. A new chart can be printed and/or new measurements taken and the
results updated to the Media.

* Check Media - Select a Media to be measured. This options assumes a Calcheck Chart for the Media has been
printed. It immediately opens a window to select the chart for measuring and initiates measurement on the
selected Spectrophotometer. On completion, results are saved to the Media and previously calchecked Media
will be updated.

* Load Job - Select from a list of previously calchecked Jobs sitting in the QueueManager. Once loaded, complete
results of the job’s last Calcheck are displayed. A new chart can be printed and/or new measurements taken
and the results updated to the Job Info.

* Check Job - Select any job currently in the QueueManager to be measured. This option assumes a Calcheck
Chart for the job has been printed. It immediately opens a window to select the chart for measuring and
initiates measurement on the selected Spectrophotometer. On completion, results are saved to the Job Info and
previously calchecked jobs will be updated.

* Print Label - Print a summary label of the currently displayed Calcheck results to a system printer.

¢ Show Graph - Displays a representational graph of the Ae for each patch of the currently loaded Calcheck
result. Checkboxes toggle pass/fail views. Results can be displayed in one of three formats, selected via
dropdown menu:

* Show Error Bars - Shows two (2) coloured spheres, joined by a bar for each patch positioned in a 3D Lab
colourspace. The dull sphere represents the reference value for the patch; the shiny sphere is positioned based
on its Lab values in the colourspace. The relative distance between spheres shows the Ae between them.

* Error Plane - Shows a line of coloured spheres representing each patch, lined up in order. The larger the
sphere, the higher the Ae.

* Error Spheres - Shows a coloured sphere for each patch position in a 3D Lab colourspace. The larger the
sphere, the higher the Ae.

Contextual Menu Options
* Export - Export the colour patch data from the display panel to a text file.
¢ Import - Import colour patch data into the Calcheck application from an exported text file.

Further details on how to use the Calcheck application are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support
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ClusterManager
Clustering is the ability to share the workload of processing jobs across multiple devices. Slaves or cluster nodes can be
installed on other machines on the network and jobs can be sent to them from the Master for processing.

The ClusterManager allows you to add and manage these cluster nodes. They can be enabled for use in imaging,

rendering or both.

As a node device starts up, its speed is calculated. When a job is
submitted for processing, the Master machine has priority as no
network traffic is required. If the Master is busy processing
another job, the job can be sent to the fastest available node. The
node processes the job and once completed, sends it back to the
Master. It is then ready to accept another job. Nodes can be
installed on any machine on the network.

9100 NP (ot for resae)

Running a Cluster Node requires a separate Megarip dongle. If you have extra Megarip dongles, any Server can act as a
node if it is started as a Cluster Node (see “The Megarip Server” section for more information).

Note: In this mode, the Server can only be used as a Node (slave) for another Server. It is recommended that the
database be backed-up and job queues cleared before a Megarip Server is started as a Cluster Node. This avoids any
conflicts with existing job IDs or settings.

Master Panel
This panel displays information about the Master Server machine.

Product - The Serendipity Megarip software in use.

Version - The Server software version.

Hostname - The network name of the Master Server.

IP Address — The network IP address of the Server.

Speed - The relative speed of the Server, calculated by Megarip.

Processors - The number of CPUs in the Server machine.

Platform - The operating system/kernel version of the software.

Process Imaging/Rendering/Schedule Last - Check whether the Master Server is to perform any Imaging or
Rendering Jobs. The Schedule Last option allows nodes to have priority over the Master when jobs are
processing. This is advantageous when polling large RIPs, as it allows the Master to concentrate on gathering
the list of jobs and displaying them.

Cluster Nodes
This list shows nodes that are available and running on the network. Information about each node is displayed in the
window. Online nodes are displayed in green; offline nodes in red.

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the
Cluster Node panel. Columns can be reordered by dragging and dropping them into the desired order, or by using the
Configure Headers option in the contextual menu.

The sort options are:

IP address - The network IP address of the Node. Checkboxes become available to enable the node and select if
it is to be used for Imaging and/or Rendering tasks. Once enabled, the Master handles the clustering in the
most efficient manner possible.

Hostname - The network name of the Node.

Speed - The relative speed of the Node calculated by Megarip.

Platform - The operating system/kernel version of the Node machine.

CPUs - The number of CPUs in the Server machine.

Product - The Serendipity Megarip software being used for the Node.

Version - The Server software version of the Node.

Processing Pool - Optionally choose a Pagesetup Pool (see the Workbench - Pagesetup Pool section) for which
the Node will perform image and render tasks.

Image - Shows the number of simultaneous Imaging tasks that can be performed by the Node. Click on the field
to change the number.

Render - Shows the number of simultaneous Rendering tasks that can be performed by the Node. Click on the
field to change the number (see the System Settings — Server section for details on Imaging and Rendering task
settings).
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Refresh - The Refresh button polls the network for active Nodes and registers any Nodes in the list that are offline.

Cluster Node activity can be monitored in the ClusterStatus module (see the Monitor Modules - ClusterStatus section
for more information).

Menu Options
The following options are available from a contextual (right click) menu within the Cluster Node panel:

¢ Add Node - Add a Cluster Node that cannot be seen. Sometimes Nodes on subnets cannot be detected. Selecting
this allows you to enter the hostname or IP address of the Node and add it to the list manually. The Node to be
added must be running.

* Add Processing Pool - Select, change or remove the current Pagesetup Pool for which the Node performs
Image and Render tasks.

* Remove All Offline Slaves (Nodes) - Remove a Node from the list that has gone offline.

* Remove Node - Available for offline Nodes only. This option removes the selected Node from the list.

Further details on how to use the ClusterManager are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support

Densitometer

The Densitometer application allows you to measure and display density readings with a supported
Spectrophotometer. When measuring a patch, the densities of all four process CMYK colours making up the patch are
read.

The Last Measured panel in the top half of the application window shows the density and dot percentage values for the
dominant process colour of the measured patch, with the values of the other three colours to the right. The values can
be recorded and saved to a file if desired.

Note: The Densitometer application is a utility allowing you to use a Densitometer or Spectrophotometer that does not
have a display to read values. This can be as a one-off reading to compare densities, or you may want to read values and
export them for plotting on a graph. There is no requirement to use this for the normal operation of Serendipity
Megarip.

Densitometer/Measurement/Paper Options
*  Yule Nielsen Number - Enter the YN number for the paper you are reading (if known). The default is 2.0.
* Densitometer - Choose one of the supported instruments from the available list.
* Instrument Default Density Standard - Select your desired density standard from the available list.
* Activate/Deactivate - Connect or disconnect the chosen device.
* Add - Add the measured values to the list. This appears after the Densitometer has successfully connected.

To being measuring, select a Densitometer from the dropdown list and click the Activate button. The status field is
shown when the device connects without error. Follow any instructions when prompted - Calibrate, Measure Cyan
Solid, etc.

Measure Targets
In order to read percentage tint values of any plate, you must first read the paper white and the solid density value for
that colour.

The Measure Targets menu or contextual (right click) menu allows you to measure the solid reference densities for the
process colours and the paper white. With these values stored, colour percentages can be calculated and displayed. You
can measure or update an individual Solid density or Measure All Targets.

Colour List
This is a list of readings taken if the Add is enabled. Each reading is appended to the list and the values measured are
displayed. The columns can be resized or reordered as required by dragging the header to the preferred position.

The columns are:

* Name - The name of the colour read. Defaults to “Untitled” but can be changed by selecting the name and
entering a new one.
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Export
You can export the values from the Colour List to a file. The available options are:

"] Colour Density ] Colour Percentage
7] Cyan Density 7] Cyan Percentage
Selecting either of these options displays a window allowing you to choose the values O Magenta Density. [ Magenta Percentage
to be saved. The choices are: [ Yellow Density [ Yellow Percentage
7] Black Density 7 Black Percentage
¢ Name - Save the name of the colour. _
*  Colour Density - The highest density reading regardless of colour. Order Values: e
Separate Values With: Tabs s

Colour - Shows the dominant colour read, i.e., the one with the highest density value. This may not be the
colour you perceive it to be, but the contents making up the colour are recorded and the colour is calculated
and shown.

Density - The density value for the colour. This is the highest density read from C, M, Y and K. It shows the
density of the colour stated in the Colour column.

Cd/Md/Yd/Kd - The C, M, Y and K densities of the colour read.

Dot% - The dot percentage of the colour shown in the Colour column.

C%/M%/Y%/K% - The C, M, Y and K percentage values for the colour measured. If any of the % columns are
blank, the reference paper white or solid density for that colour has not been measured.

[:] [6] Export Measurments

Export Values

All - Saves all entries in the list.
Selected - Save the selected entries in the list only.

"] Name

Cyan/Magenta/Yellow/Black Density - The density reading of the chosen
colour. For e.g,, if Cyan is selected, the Cyan density for each reading is taken. Cancel ) (@ExBore)
This is the value displayed in the Cd column of the list.
Colour Percentage — The percentage reading of the highest density read as displayed in the Dot% column.
Cyan/Magenta/Yellow/Black Percentage - The percentage reading of the chosen colour. For e.g., if Cyan is
selected, the percentage of Cyan for each reading is taken. This is the value displayed in the C% column of the
list.

The percentage values must be present for the values to be exported. If they are not, the exported file will show a 1%
value in place of the reading.

Order Values - Choose whether to export the file in CMYK or KCMY order.

Separate Values With - Choose to separate the values with either a tab character or a space.

Cancel - Cancels the Export action.

Export - Displays a file chooser allowing you to enter a name and select a location to save the file to.

Table 1 - Supported Density Standards

Density Standard - Status
Instrument A E I T Default
DTP41 v v v v v
DTP34 x x x x v
DTP22 v v v v v
DTP20 v v v v v
Spectrolino v x x v v
EyeOne 4 x x v v

Not all instruments support all density standards.
This table is not a complete list. Consult your instrument user guide for more information.

Further details on how to use the Densitometer are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support
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FlipBook
The FlipBook application allows you to view a publication as a virtual book. In Megarip, a publication is defined as a
group of pages with the same publication name. This is a collection of book or magazine signatures that have been de-
imposed, but a publication may consist of any number of pages.

® O O FlipBook<2> - i devel ipi ft .com.au:9100 - NFR (not for resale)

Publication Pagination

FlipBook allows you to load the publication and flip through
pages as you would with a real magazine or book. This enables Al GRS Ot | Y S Bl S @ (et
you to check that your de-imposition has worked correctly, that
pages are in the correct order, orientation and if there are any 14
duplicates. Larger views of the pages can be called up and the
whole publication can be exported to PDF or as a QuickTime
movie.

FlipBook can be opened in three ways:

1. From the Application menu of the Serendipity Client.
Publications can be dragged and dropped from the
QueueManager into the FlipBook window and will open
automatically. 19532 GOLF TEXT.job (IMPOSITION) Page 6 [[06.1] [[07.1] 19532 GOLF TEXT.job (IMPOSITION) Page 7

2. From the QueueManager application by selecting a job € >
and choosing View Flipbook. The View FlipBook option 3 s /Ml sl o] o] 11[ 2 53] 14 15[ 1] 17] 18
is only available if the job has a publication name.

The FlipBook window comprises of four (4) main panels - Publication, Pagination, Page View and Page Navigator.

Publication Panel
This panel contains the name of the Publication being viewed.

Pagination Panel
e Start - Enter the page number for the starting page or use the arrows to select the first page number of the
FlipBook. If the first page loaded is page 1, you cannot alter the start page number. If the first page loaded is
greater than 1, you can enter a lower value as the start page number. This can be used if you are viewing a part
publication where the first pages have not been processed.
* Top Page - Choose whether the top page of the FlipBook is Even or Odd.

Page View Panel
This panel is where the FlipBook pages can be viewed. When a FlipBook is opened, the pages of the publication are
loaded and displayed in 2D (two-dimensional) view. There are various ways to navigate through the publication:

* C(Clicking on the page of the image - If you click on the right page, you move forward through the publication.
Clicking on the left page moves backwards.

* C(Clicking on the pages in the Page Navigator Panel - displayed below the Page View panel. The view jumps to
the page (pair) you select.

* Space Bar - The space bar moves forward to the next pair of pages. Hold the shift key and press the space bar
to move backwards.

¢ PageUp/PageDown - Use these buttons on the keyboard to navigate forwards and backwards through the
publication.

* Arrow Keys - Use down or right arrow keys to move forward through the publication and left or up to move
backwards.

* Scroll Bar - Moving the scroll bar below the image moves forwards or backwards through the publication.

Page View (Contextual Menu)
There are various options available from the context (right click) menu:

* Open Publication - Opens a QueueManager showing all jobs processed in the system. Select a job or publication
job to load and click OK.

* Reload Publication - Reloads the current publication with files from the queue. This is used if additional files
have been processed as part of the publication, or changes have been made and the publication needs to be
updated.

* Choose Press - Select a Press configuration to apply to the job currently (and subsequently) loaded into the
FlipBook. (see Workbench - Press for details)

* Job Info - displays the Job Info information about the currently selected page. (see Workbench - QueueManager
for details).
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* Swap Page with - This allows you to swap the page currently selected with another page from the same
(currently loaded) publication.

* View Imaged - opens and views the imaged file of the selected page in the SoftProof application.

* View Rendered - opens and views the rendered file of the selected page in the SoftProof application.

¢ View 3D - toggles between a 3D or 2D view of the publication. Three dimensional viewing shows the page
turning as you navigate through. The turning speed can be adjusted FlipBook Settings.
3D mode adds 2 sliders on the right side of the Page View. The first alters the angle at which the 3D virtual
book is viewed, the second zooms the view in and out.

Note: The performance of the page turning may vary depending on the size of the thumbnail being viewed and the
performance of the graphics card.

¢ View as Calendar - Only available in 3D mode. Changes the flip axis to horizontal so pages flip up and down in
the same manner as a calendar.
* Export - Exports the FlipBook as a PDF. Select the resolution, compression type and quality. Choose between
exporting the whole book or a range of pages.
* Export as Spreads - Exports the FlipBook as a PDF but as spreads. The same options as above apply.
* Export as Movie (3D view mode only) - Exports the FlipBook as a QuickTime movie. After selecting this there
are three further options:
o Codec Type - Choose the preferred compression type from the menu.
o Quality - Choose the preferred quality.
o Keyframe Spacing - Choose how often a keyframe is saved.

The settings you choose will affect the size of the movie, the quality and the compatibility with other applications.
There are many Codec types available and not all work on all systems. Commonly used types are Apple MPEG4 and
H.264 avcl. Increasing the quality setting also increases the file size. This is also true for the keyframes. The more
keyframes, the better the quality but the larger the file size. Trial and error will provide you with the desired result.

* Render Queue Thumbnails - View the Rendered thumbnails in rather than the default Imaged thumbnails.

Page Navigator Panel
The Page Navigator displays a numbered box for each page making up the loaded Publication. It allows for direct
navigation to any page by clicking on it.

The page boxes are colour coded:

Light Green indicates the pages are loaded into the FlipBook and can be viewed. These show as dark

green when selected.
2 3

Purple indicates there are duplicate pages, i.e., they have the same publication name and page I‘
numbers. Dark purple indicates the pages are selected. v, 4w %

Clicking on these pages allows you to select and view the alternative page:

19532 GOLF TEXT.job (IMPOSITION) Page 7
19532 GOLF TEXT.job Page 007 (IMPOSITION 07)

22 2
38/ 3

Light Red indicates the page is not in the FlipBook. This occurs when there are other pages
116 11/| greater than the numbers displayed. This could be due to the imposition signature not yet being
rendered. As they render, you can simply reload the publication to update the pages.

The status colours are updated whenever Reload Publication is selected.

A bar directly above the Page Navigator displays the Job Name for each currently viewed page on the left and right sides
respectively. Pages with more than one version will show a dropdown to select which version to view. The Page
Numbers being viewed are shown in the centre of the bar.
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Menu Options

The following are available from the FlipBook File Menu:

¢ OpenPu

blication

¢ Reload Publication

e Export
e Exporta
e Exporta

s Spreads
s Movie

Other options are also available:

* FlipBook Settings - Configure the FlipBook viewing options and press configuration.

View Options

(e]

O O O O

Allow Multiple Windows - Enable or disable. Allows multiple Publications to be opened and viewed in
separate FlipBook windows. If disabled, a newly opened Publication will replace the one currently
being viewed.

Page Order - Choose between reading left to right or right to left.

Flip Time (3D) - Select the speed for the flipping of pages when in 3D mode.

Render Queue Thumbnails - Enable or disable render queue thumbnails.

Show Borders (2D) - Enable or disable the borders when viewing in 2D mode.

Press Configuration

(e]

View Menu
These options ar

e View 3D
e Viewas

This panel allows you to view or change the Press configuration FlipBook uses to display Publications.

FlipBook Settings FlipBook Settings
View Options | Press Configuration | [ View Options | Press Configuration
Window
T r—
(] Allow Multiple Windows W Press Configuration ... ) alpha covers
Book
Page Order: | 2 3]
ageOrderi (21 9 Press Width 1016.00mm
Flip Time (3D): === 00.8 seconds Press Height 762.00mm
" Render Queue Thumbnails RUmueronRevER 30
\ Replace Colour Set None
" Show Borders (2D) -
Cyan Dotgain None
Curve
Magenta Dotgain  None
urve
Yellow Dotgain  None
Curve
(“Cancel ) (0K ) (cancel ) oK )

e also available from the FlipBook View Menu:

Calendar

* Ink Weight - Opens the Ink Weights window displaying the FlipBook publication’s ink weights and coverage.

Further details

on how to use the FlipBook are available on our website, under the HowTo Guides section:

http://www.serendipity-software.com.au/support
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Lineariser
The Lineariser application creates a Linearisation Curve for an output device (printer). Assigned to a Media after paper
profiling, it brings the output device to a known (linear) state. This means a 50% Cyan will print at 50%.

The user first prints a stepped wedge chart for a selected Spectrophotometer/Densitometer to the output device in the
colourspace specified by the Media. The chart is measured
and the resulting curve is saved, assigned to the Media and

a History recorded. EDCEDEEDEE
> 15 2 I R
At this stage, ICC profiles can be created and applied for DD DOEE DB

accurate colour representation. If the printer output varies
due to ink batches or head wear, a quick re-linearisation
process is all that’s required to get back to the same linear
state initially created. The original ICC profiles can be re-
applied to achieve the same colour output.

The Interface
The Lineariser window is made up of a Toolbar and a number of panels - Available Media, Linearisation History,
Measurement, Advanced Options, Spectrophotometer or Densitometer information and Curves display.

Toolbar
The Toolbar has the following options (also available via the Lineariser Menu): [ « [+ [« [o [

1 12|13 1a 15|16 ] 17] 18] 10 [F500

21| 22 | 23 | 24 [25] 26 | 27 | 28 | 29 [T507]

31 [ 32|33 34 35 | 36 | 37 | 38 | 39 [Wa0"|

* Customise Patches - Allows for the selection of patches to be used in the Linearisation o [ [ 55 [ [r o[ o [0

51| 52|53 [ 545556575850 [Feon|

Chart. Choose which Patch Percentages using the numbered buttons. Total number of slalalulslslos-m

patches selected is displayed. T o ——
o Restore Defaults - Restore the patch selection to the default 23 patches per | .,
channel. (o) (G GO0

* Use Lab - Toggles between Density and Lab measurement modes. Lab mode for
linearisation is required for printers with built-in Spectrophotometers.

* Measure Patches - Initialises the connected Spectrophotometer. Follow any instructions in the status bar to
measure the chart.

*  Submit Linearisation - Save the data in the Measurement panel to the Media being linearised. A popup will
request a name for the curve.

Note: The Customise Patches and Use Lab options are new to Megarip Version 5. If viewing curves loaded from a
Version 4.x or earlier database, the options will be unavailable until the Update Legacy Curves option is selected from
the Measurement panel contextual menu (see below).

There is no need to update Version 4 curves if your printer is performing satisfactorily. However, there have been
significant improvements made to the Lineariser so it is worth considering re-linearising with Version 5.

Available Media
This panel displays a list of available Media. Select a Media to view its current linearisation curves and data, or to
linearise a new Media.

Any changes made are applied to the currently selected Media.

Linearisation History
Shows a list of all the linearisations performed for the selected Media, allowing the user to track the performance of the
output device.

The following sort columns can be selected using the contextual menu on the column header bar. Column order can be
changed by dragging and dropping the columns into the desired order, or by using the Configure Headers option in the
context menu:

* Date - Date and time the linearisation was measured.
¢ Type - Shows whether each linearisation curve was measured in Density or Lab mode.

The panel has two (2) buttons:

e Trim To - Trims the number of stored histories to the value shown from oldest first.
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¢ Show Charts - Launches a separate window that plots the linearisation history of the Media/Gradation Curve
on various charts (See below for further information on the available charts). Checkboxes at the top of the
window allow you to choose which ink channel to view. Shift+click to view another channel at the same time.
Double click a channel to see all.

The following options are available from the context (right click) menu within the History list:

* Show Charts - Launches a separate window that plots the linearisation history of the Media/Gradation Curve
on various charts (See below for further information on the available charts). Checkboxes at the top of the
window allow you to choose which ink channel to view. Shift+click to view another channel at the same time.
Double click a channel to see all.

* Revert to this Date - Reverts the linearisation curve assigned to the Media to the selected, historical
(previously measured) curve.

¢ Unload - Unloads the historical curve data being viewed in the Measurement panel and loads the currently
assigned curve.

Measurement
* Curve Name - Displays the name of the Linearisation Curve currently selected. This can be the saved curve
assigned to the Media or a selected History item.

The display shows the colour-coded linearisation patches for each ink channel. The patch number and the Dot % it
represents are listed across the top of the panel. Measured Values (Density or Lab) are shown within each patch. If no
values are present, the Media has not yet been linearised.

Advanced Options

*  Yule Nielsen Number - Enter the YN number if you know what it is for the media in use. The default is 2. The
Yule Nielsen number or N-Factor is used to compensate for dot spread on different media types. This is
basically a “fudge factor” added to the standard Murray-Davis formula used to calculate dot area from a density
reading. An N-Factor of 1 means no compensation is made and just the Murray-Davis equation is used. An N-
Factor of 2 seems to work well with most media types. As adjustments are made, the curve preview on the
graph will change, showing the effects of the value entered. Further information on the Yule Nielsen Number
can be found below.

* Maximum Densities Override - Enter a value to limit the top end density for each of the process colours. The
default is 0 (no override). As adjustments are made, the curve preview on the graph will change, showing the
effects of the value entered. Further information on Maximum Densities Override can be found below.

Densitometer/Spectrophotometer
* Device - Select the appropriate instrument from the pull down list of devices.
Note: The Embedded Printer Spectro option is only available when in Lab measurement mode (Use Lab
enabled).
* Instrument Standards - Choose from the list which instrument standard is to be used for measurement.
* Measure - Connects to the selected instrument and prepares to read patches. The patch window changes to a
measuring window and the instrument list changes to a text field where instructions are displayed.
¢ Print Chart - Print the appropriate chart for the selected instrument to the Media selected. You will be
prompted with an options window with the following:
o Cancel Printing - Cancels the action and returns to the previous window.
o Don't Apply. Print to Linearise - This will disable all colour management except for Paper Profile. Use
this to make a Linearisation Curve.
o Yes. Print to check Linearisation - This applies all colour management so you can check a
Linearisation.

Curve
This panel shows the Linearisation Curves for each ink channel.

Select individual channel checkboxes to view a channel. Shift+click to add more channel curves to the view. Double click
a channel to show all curves.

Show Charts

Selecting Show Charts will display another window with a chart for each channel in the linearisation curve. At the top of
the window is a series of tick boxes, one for each colour. Selecting one displays the single colour and hides all others.
Selecting another box changes the graph to that colour. Select the same colour again and all graphs will be displayed.
Use SHIFT+Click to show more than one graph.
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Chart Types

There are five (5) chart types available for selection:

Density / History - Plots the date of the curve on the X-axis and the density
values for each patch on the Y-axis. If the density begins to drop off, it will be

displayed in the chart.

Patch Number

Dot % / History - Plots the date of the measurements on the X-axis against the
dot percentage on the Y-axis. The points on the chart represent the patches. For
any patch, the effective dot % and how it varies across the history is shown.

Dot %

Patch Number

Dot % Delta / Patches - Plots the patch number along the X-axis against the dot
percentage delta on the Y-axis. It shows the percentage difference from the target.
For example, if the target is 40% and the measured value for that patch is higher
or lower, the error is shown in the graph.

Yule Nielsen Number
The Yule Nielsen Number is essentially a “fudge factor” applied to the standard Murray-Davis formula used when
calculating dot percentage area from density.
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Density / Patches - Plots the patches along the X-axis and the density on the Y-axis.
For each patch in the history, a point is placed on the graph. If the density for a
given patch does not vary greatly, the points will appear on top of each other.
Where there is some change, a line will appear between points.

Dot %

Dot % / Patches - Plots the patch number along the X-axis against dot percentage
on the Y-axis. A diagonal line from 0 to 100 is shown as a guide to a linear curve.
This graph will show if the patches are generally higher or lower than a linear
measurement, as well as differences over the course of time.

Dot % Delta

Patch Number
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The value is used to compensate for various media types, as some react differently to others in the way a dot will
spread on a particular media and thus affect the dot percentage value. It is sometimes helpful to change the YN number
(and some manufacturers will quote a YN number for a given media) but this is rare.

The YN formula used for calculating the dot percentage is:

-dot
YN
1-10 dot is the value of the density being measured

Dot %= —— x100%

solid is the density of the solid patch

Therefore, a YN value of 1 has no effect on the dot percentage area. A value other than 1 will compensate for the dot
spread on the media. If the YN is greater than 1, the Dot % decreases and if the YN is less than 1, increases.

T.hlS can be seen from the graph on the YN=1 1 yn=2 7 YN=0s5
Lineariser: A

The curves display the compensation; therefore if the YN number is less than 1 the dot percentage calculated is
increased so the curve applied will go down. The reverse is true for a YN number greater than 1.

For most of the testing done during initial development, the value of 2 (the default setting) seemed to work well. It was
also noted on occasions, better results were obtainable by setting different values for each process colour.

Note: As the ICC profiles are created after Linearisation, any value entered will be used for printing the ICC chart and
will affect the output. This means when the ICC profiles are applied, the same YN number must always be used in the
Lineariser to obtain correct results.

Maximum Densities Override
The Maximum Densities Override allows the user to cap the top end density to any value less than the maximum value
read.

If a value less than the highest value measured is entered, the curve will change. The top end will move down and the
rest of the curve will adjust to compensate for the new end position. The values in the middle of the curve will also
change.

Pros and Cons

There are various arguments for and against setting a maximum density override. In general, the Match ICC profile
would set the maximum density values so there should be no need to set them here. However, some users have found it
to be an advantage to set the values to the target densities required for the final proof output and in doing so, have
achieved very good results.

Reducing the density of the output used to print the ICC chart will affect the gamut. However, as the gamut of a press is
generally smaller than that of a proofing device, this may not have any noticeable effects.

It is desirable to drop the top end densities of the output prior to ICC creation, as sometimes there is a need to boost the
values after ICC is applied. This should only be used as a last resort and is not desirable as a general rule. If the top end
densities drop, the ICC profiles are generally to blame and therefore should be corrected.

Note: It is the Match ICC profile that has the biggest bearing on the output and sets the output top end densities.

Further details on how to use the Lineariser are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support
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MonitorCalibrator

The MonitorCalibrator application uses a supported Spectrophotometer to create an ICC profile for a selected monitor.
This allows quality graphics monitors to be calibrated to a chosen print standard for colour accurate softproofing of
print material. SoftProof accuracy can be verified at any time using the Calcheck application.

Creation of the profile is very simple, requiring one of the supported devices and a few minutes of time. The
Spectrophotometer is placed on the screen and a series of measurements is taken from which the ICC profile is created.

Note: The MonitorCalibrator creates a profile for use with the Match ICC profile assigned to the monitor in System
Settings. Ensure the correct match profile is set before creating the monitor profile (see the System Settings - Colour
Management section for details).

Monitor Profile

Adjust brightness Measure ambient Create Profile Save Prc " Override video card gamma

Monitor Calibrator (offline)

Instrument | ColorVision Spyder oé ] [Lco ]

The MonitorCalibrator is launched from the Application menu. If the Match and Monitor profiles have not been set
previously, a prompt will appear to select both. A default monitor profile should be selected until a unique profile is
created.

Options
¢ Adjust Brightness - Calibrating a screen to an established standard often requires that the screen be set to a
particular brightness. This function uses a Spectrophotometer to measure the current Brightness (in cd/m?2)
and Colour Temperature (in °K) of the monitor. Measurements are displayed in the bottom left of the screen.
Hit Esc to exit the function. The brightness settings can be adjusted using the monitor’s own hardware or
software controls, until the correct level is achieved.

Note: This function does not have any control over monitor brightness; it is a measurement tool.

* Measure Ambient - Uses a Spectrophotometer (equipped with a filter) to measure the Ambient light in the
proofing environment. The ambient light level (in cd/m?2) is displayed in the bottom left of the screen. Ambient
light levels can be important when meeting proofing environment standards. Hit Esc to exit the function.

* Create Profile - Calibrates and profiles the monitor using an online device. The device must be selected from
the dropdown menu, be connected and turned on. Follow the onscreen instructions (press Enter to start).
When the profile is complete, you will be asked to save it. It is recommended profiles be saved in the default
ICC/Monitor directory.

* Save Profile - Saves the current measured profile. This will save the last profile measured/created by the
MonitorCalibrator. This data is lost if the application is closed. It is recommended the profiles be saved in the
default ICC/Monitor directory.

* Override video card gamma (Mac OS X Only) - Selecting this disables the video card gamma, making it linear.
This produces a more accurate ICC profile and is only available on the Mac platform.

Note: If a profile is created with this option, the resultant ICC can only be used in Serendipity Megarip. With
this option disabled, the ICC profile can also be used as the System ICC. Windows does not have this option and
will always use the ICC created as the System profile.

* Instrument - Choose one of the supported devices from the list.
* Display - Select your display type for calibration - LCD, CRT, RAW

Further details on how to use the MonitorCalibrator are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support
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SoftProof

The SoftProof application is used to proof a job on the screen.
There are many tools available to check every aspect of the job at
any stage of production or processing. SoftProof can be used in
conjunction with or instead of a hardcopy proof.

Using a calibrated monitor and configured Press settings, proofs
can be viewed with precise colour accuracy and verified onscreen.

All job plates are shown and can be turned on or off, or changed as
desired. Colour attributes and plate characteristics can be changed
to see the effects of different printing processes, including paper
types and the effects of show through from the reverse side. The
data can be exported to various formats including CIP3 and PDF.

An InkKeyViewer (below) can display a job as it would be on the
press, with the values for each Key. The ink weight can be
calculated and over ink areas identified. The proof can also be
verified using the Calcheck application to give a pass or fail status
in accordance with colour standards.

File Menu Options

SoftProof - Epson N-Color2 1.eps (Imaged preview) 5.88235%

[ Epson N-Color2 1.eps (Imaged preview) |

Open Files - Load an image file directly into SoftProof. Supported file types are Canon RAW format (CRW),
JPEG, PNG, PPM, Serendipity Megarip Image and Tiff.

Open Jobs - Load completed jobs into SoftProof. A QueueManager window will open showing available jobs.
Once selected, choose whether to load the Imaged or Rendered file.

TWAIN Acquire - Use a connected scanner to import directly into SoftProof. The scanner must be connected
and operational for this to work. The manufacturers driver is used for the capture.

Save - Save the preview as a Megarip Image file. This can be submitted or placed in a hot folder, or on a
DropSpot.

Export - Export data from SoftProof. The available formats are CIP3, PDF, Postscript (Separated) and Tiff
Multichannel.

Submit - Submit the current job to a Media and Pagesetup with any current changes. This re-images and re-
renders the file. When submitting the image to be processed again with any relevant changes, the current
image resolution is submitted. If the resolution is restricted in the System Settings, this is the resolution that
will be used.

SoftProof Settings - Opens the preferences for the SoftProof application, allowing the selection of default
viewing conditions. See below for further information.

SoftProof Settings
The SoftProof settings allows you to select viewing preferences, including how to load a job, the quality and press
settings to produce accurate proofs. The settings window is split into two (2) tabs - View Options and Press

Configuration.

View Options

SoftProof Settings

Allow Multiple Windows - Check this box to enable or disable. Allows jobs to
be opened and viewed in separate SoftProof windows. If disabled, a newly
opened Publication will replace the current one being viewed.

Rotation - Control the orientation of jobs when they first load. The option
None leaves the job in its imaged or rendered orientation.

Zoom Level - Select the default zoom setting. All Fitting zoom modes
calculate the size based on the monitor resolution. This is set in the Colour
Management tab of the System Settings.

Enable Pager Thumbnail - Enable or disable the thumbnail viewer in the
Page Navigator panel of a softproofed publication. When enabled, a
thumbnail of a page appears when the mouse pointer hovers over the page
number box. The shortcut key of shift+T in the SoftProof window can also be
used.

Back Page Rotation - Set a default rotation for a back page when using the
option Show Back Page.

View Options | _Press Configuration |

Window

] Allow Multiple Windows

Rotation | None )
Zoom Level | 50% v
Publications
M Enable Pager Thumbnail
Back Page Rotation | None I
Image
Resampling Algorithm | Bicubic [
PR

Screening LPI 140

Cancel ) oK

Resampling Algorithm - Set the resampling algorithm for jobs as they are viewed in SoftProof.
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Press Configuration

This tab allows you to select a Press configuration from the database to be applied to
the loaded job, and for all subsequent jobs opened in SoftProof. The results of the ERERRTRE 1< oo
press settings can be seen on the output job and should match the printed copy. Mmool 30

Set
An information window shows the settings of the currently loaded press setup. Press om0
configurations are managed in the Workbench and contain information such as size, S

number of keys and colour information.

Navigator Menu
The Navigator is a small preview window showing the whole job, irrespective of the zoom level of the main SoftProof

Screening LPI - Enter the desired value for screen ruling for SoftProof in SoftProo Setings
Lines Per Inch (LPI). The default is 150lpi. View Options | Press Configuration )

B Precc Confiauration . )
W Press Configuration ... ) alpha covers

Yellow Dotgain ~ None
Curve

(_Cancel oK

window. 5 Tt
When the Navigator is open, moving the mouse pointer inside will display a red EEEEEEEEN
box showing the respective area shown by the main window. If the main
SoftProof window is zoomed in, the red box will be smaller than the navigator II- . ..
window size. A single click (or click & drag) will reposition the main window to [ [
show the portion of the image selected. o
.
The Navigator window can also be used in conjunction with some of the SoftProof
tools: -
* Zoom - Click and drag to view a particular area and the main window changes to the selected area.
¢ Crop - Click and drag to mark a crop area. Reposition the marked area as desired and crop by pressing Enter,
double clicking, or right clicking and selecting Crop. To cancel the crop, right click and select Cancel, or press
the Esc key.
* Large Navigator - Toggle between the default or large sized Navigator window.
View Menu

Tabs - Control the tabbed viewing of images in SoftProof.
o New Tab - Opens a new, empty tab ready for a job. Use the Open Job option or drag a job from the
QueueManager into a new tab to load it.
o Close Tab - Closes the currently selected tab. If there is a job loaded it is closed and the next tab is
selected.
Next Tab - Loads the next tab containing an image into the main window.
Previous Tab - Loads the previous tab containing an image into the main window.
Text - Enables text tab guides at the top of the window.
o Thumbnail - Displays the thumbnail viewer on the right of the main window.
Get Info - Display information about the softproofed job and how it was processed.
Show Page Boundary - Places a red line around the page area of the job. This is viewable when the SoftProof
window is large and the image reduced in size.
Ink Weights - Opens an Ink Weights window displaying information regarding the Source and Print Inks for
the selected job.
Zoom In/Out - Zoom in or out of the image.
Show All - Show the whole job in the window.
Show Actual Pixels - One pixel of the screen is equal to one pixel of the job. This is shown at 100%. This view
mode has the quickest load time as no resampling for scaling is required.
Show Actual Print Size — Show the print size of the job.
Fit Width / Height - Fit the job to the height or width of the preview window.
Full Screen - Change between full screen mode and window mode.
Loupe - Display a virtual loupe on top of the image loaded. The Loupe can be resized and magnification
changed if required. The current magnification is shown at the bottom of the Loupe; 100% means 1 screen to 1
job pixel.

O O O

Tools Menu

Palette - Show or hide the floating tool palette. The position is remembered the next time SoftProof is
launched.
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Pan - Navigate around the image by clicking and dragging the job around the screen. The cursor displays as a
hand.

Zoom - Zoom in or out of the job. Clicking the mouse zooms twice the current percentage factor. Holding
SHIFT+Clicking zooms out to half the current percentage factor. Click and drag over an area to zoom in. This
works in both the main window and the Navigator.

Note - Create, manage and delete notes.

Measure - Take a measurement on the image. The cursor displays as a rule. Use the shift key to draw straight
lines.

Crop - Crop and image and resubmit it.

Guide - Display guide lines on the image to check for alignment. Change the orientation by pressing SHIFT. Esc
will remove the guides and change to Pan mode for general navigation.

Spectro - Take measurements of the job being viewed. A popup window will appear displaying the
Lab/Lch/XYZ/Density values at the point the Spectro cursor is onscreen.

Panels - Open the Panels window featuring the Channel View, Notes, Publication and Effects panels. Panels can
be shown or hidden as required using the buttons at the top of the window.

Channels - Opens the Panels window, showing only the Channels section (see Channel Viewer below).

Notes - Opens the Panels window, showing only the Notes section (see below).

Publication - Opens the Panels window, showing only the Publication section (see below).

Effects - Opens the Panels window, showing only the Effects section (see below).

The Channel Viewer

The Channel Viewer shows the channels or plates of the job currently being viewed in SoftProof. Plates can be turned
on or off by clicking the relevant checkbox to the left of the plate name, and can be reordered by clicking and dragging
them to a new position. The plate colour and associated attributes can be changed by double clicking and choosing
another Special Colour Set from the library, or edited for that SoftProof instance only. Columns can be reordered by
using the Configure Headers option in the contextual menu, or by clicking

and dragging them to the new location. Channais

Channels

Name Value
¥ Mcyan
@ MMagenta
™ Yellow
™ MBlack
[ Paper Colour (alpha covers)
] Total ink

100%
100%
100%
100%

Name - The plate name. The checkbox indicates whether or not the
plate is displayed.

Value - The percentage of colour at the point of the cursor in the
SoftProof window. Total ink displays the total amount of ink at the
point of the colour selector, i.e., the sum of all plate percentages.
For RGB, it will show the relative RGB values only.

Mode - The paint mode of the colour as defined in the Special Q
Colour Set or Replace Colour Set. If it is not defined, the default is
Overprint.

Tint - The intensity or tint value of the colour.

DotGain - The name of the dotgain curve applied to the colour. This is blank if a dotgain curve has not been
applied.

The contextual menu (right-click) in the Channel Viewer reveals additional menu options:

Notes

Notes gives users the ability to draw a text box on the imaged or rendered
SoftProof to make a note. The note is attached to the job file and remains
attached until it is either deleted or the job is removed from the system.
There is no limit to how many notes can be created, and they can be shown or
hidden as required.

Notes cannot be attached to files opened in SoftProof via File Menu > Open

Choose Plate Colour - Select a plate colour from a Special Colour Set for the selected channel. Double clicking
will display the same Special Colour Set window.

Choose Paper Colour - Select a colour from the Special Colour Set to use to simulate the paper colour. Once set,
the option to unset becomes available - Revert Paper Colour.

Edit Plate Colour - Displays a colour editing window to edit the selected colour for the current SoftProof
instance only. The edits are not stored in a library.

Apply a Replace Colour Set - Select a Replace Colour Set to apply to the job. Any plates matching the set will be
replaced.

Revert All Plates to Press Settings - Changes all plates back to the
press configuration currently selected.

Notes
(] Hide Notes.

Type A |Text
Imaged Check colour ...

Modified Created User | Group
24/03/09 11:12... 24/03/09 ... admin admin
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Files. The file needs to be submitted as a Megarip job before any embedding of notes can take place.

When creating a note with the Note Editor, a configurable arrowhead pointer option is available along with the existing
area marker for a more precise commentary on the job. The User and Group of the note creator are also displayed (see
Secure Mode). Notes can be edited or the pointer adjusted by double-clicking on the Note.

The Note panel displays any notes attached to the job currently selected in the main viewing window. There is also a
Note column in the QueueManager showing the number of notes attached to a particular job.

* Hide Notes - Show or hide the notes on the preview. By default, loading an image will display any notes.

* Type - Lists whether the note was made on the Imaged or Rendered file.

* Text - The text making up the note.

* Modified - The date and time the note was last modified.

* Created - The date and time the note was created.

* User / Group - The User and Group responsible for the note.

¢ Search Box - At the bottom of the window a search box can be used to locate specific note information. All
fields in the Note channel are searched.

Publications
When softproofing a job forming part of a publication, additional controls and view options are available.

The Publications panel has the following options:

Publications

* Single Page - Display just the single page selected. De-selecting this enables the S

" Single Page

options below: O Show Back Page
o Show Back Page - Display the reverse side of a page through the page © Show Page Spread
currently loaded, as if the final print was being held up to light. The e
Back Page Opacity setting in the Press Settings controls the amount of Edit.. ) Golf Magazine
show through. o

o Show Page Spread - View the spread of the selected page, for example,
pages 2 and 3 as a spread.

Page Navigator Panel

Positioned along the bottom of the main SoftProof window, the Page Navigator displays a numbered box for each page
making up the loaded publication. This allows for direct navigation to any page by clicking on the page number.
Hovering the mouse over a page number will pop-up a thumbnail for the page.

The page boxes are colour coded:

Light Green indicates the Publication pages are loaded and can be viewed. These show as dark green

when selected.
2 3

Purple indicates there are duplicate pages, i.e., they have the same publication name and page
numbers. Dark purple indicates the pages are selected.

. 2ll= 3]

Clicking on these pages allows you to select and view the alternative page:

19532 GOLF TEXT.job (IMPOSITION) Page 7
19532 GOLF TEXT.job Page 007 (IMPOSITION 07)

38 3

Light Red indicates the page is not yet available for viewing in SoftProof. This normally occurs
116 11/] when there are page number gaps if pages have not yet imaged or rendered; or when processing

a de-imposed publication with known (signature defined) page numbers. As the missing pages
image/render, close and re-open SoftProof to update the publication pages.
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Effects

The Effects panel contains the basic effects that can be applied to the
image, These are simple actions to either improve the view or to | = s || 82| || B,
adjust the job and resubmit it with the change. o

* Invert - Negate theimage. | e

e Mirror - Mirror the image. | ™ :

* Auto Crop - Remove white space around a job. There must siess G
be a completely clear area on any one side of the job.

* Blueline - Replace all colours with varying shades of blue to see any traps.

* Revert Channels - Revert to the original channel values.

* Rotate - Rotate the image in various ways.

¢ Sharpen - Apply an unsharp mask. This will affect the edges within an image and can be controlled with the
parameters available.

InkKeyViewer
Launching the InkKeyViewer (via the Tools menu) will open a new window containing the loaded image.

At the bottom of the window will be a series of ink keys. Colour bars give a graphical display of the proportion of each
ink contained within the job across the keys. For each key selected, the relative percentage of ink for each of the plates
is displayed. An information panel runs down the right hand side of the window. The top of the panel shows
information about the currently loaded Press settings. Job view and placement can be changed and ink weight can be
calculated for any job.

800 InkKeyViewer

¢ Colour Check Boxes - Positioned above the image,
these show the inks or plates used in the job. Clicking
on one will turn the others off and leave the ticked
colour on. Click each in turn to view another colour
or double click one to show all colours. Shift+Click to
add or subtract colours from the view.

* Ink Keys - The keys at the bottom of the window | 8 |
show the inks selected to be viewed on a graph. The ' I i
scale of the graph varies, depending on the amount of By T
ink in the job. Hovering over or clicking on an Ink Key IE’}QE%’L E’}QE%’L "
will display the Key number and its ink values at the ‘
bottom of the information panel. 1

* Press Settings - Shows the values for the currently 14.8%
loaded Press. Click the box to hide or show the
details. Press settings used are selected in the 20%
SoftProof Settings (see Workbench - Press for details q
on press configuration).

* Show Excess Ink Weight Area - Display areas exceeding the Maximum Ink Weight setting as defined in the
Press configuration.

* Max Ink Key Value - Set the size of the ink keys to match your press. Ink values are calculated based on the size
entered. If the size is 100, percentages are displayed.

* Sheet Placement - Show the job as positioned on the press sheet as defined in the Press configuration. The job
can be centered (selecting the Centre checkbox) or offset from the left (X) and bottom (Y). De-selecting this
displays the whole job in the viewer and changes the ink keys to show total ink amounts for the job.

* Ink Weight Calculator - Use this to calculate the amount of ink required to print x number of copies.

o Print Run Size - How many to print.

o Ink Weight (g/m?2) - Enter the weight of the ink used in grams per square metre.

o Calculate - Based on the values entered for ink weight and print run size, the total weight of ink for
each colour can be calculated for the job loaded and displayed in the ink value area.

¥n ¥m ¥ m

Contextual Menu Options (right click)
* Show Ink Key Table - Shows a preview listing the ink key values of all keys for each plate. These can be printed
using a local printer if required, or exported to PDF.
¢ Export Tab Delimited - Exports the values for the keys and ink values to a tab delimited text file.
¢ C(lose - Close the InkKeyViewer.

Further details on how to use SoftProof are available on our website, under the HowTo Guides section:
http://www.serendipity-software.com.au/support
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Spectrophotometer
The Spectrophotometer application allows for the measurement of colours with a Spectrophotometer. The accuracy of
the measured value can be viewed against an imported value when mapped through a selected ICC profile.

® O O Spectrophotometer - NFR (not for resale)@pomelo.swdevel.serendipity-software.c...

The window is split into two sections. The right side

allows for the import and viewing of a Special Set, Lo Xemmmm 1 ae 10 | [ M Show all swatches

S . i R s . .
which is used as the comparison base. The left side bo— z: . || [ESSSSName |Space |Mode |Tint |@ Dotgain Curve
displays the measured values. Colour| Name |Space |Mode |Tint

Selecting a particular measured value matches the
closest colour of the imported set, giving it relative
deltaE values. These can also be filtered to only C— 2) s

o 0 col
show the closest matches for better viewing. colours
% Load Set ...

None

Options / Applications/ Serendipity/
: Match ICC...
* Load Set - Select a Special Colour Set to —— el oth

. . ﬁ PRES
108d. ThlS 15 the _Set USEd to Compare 0 colours Rendering Intent: | Relative Colorimetric ‘:]
measured values with. Choose from any of
the Special Colour Sets created. Spectrophotometer (offline)
*  Match ICC - Select a Match ICC profile. [From Lab text file (Lab sample order) Rev 1.03 3] (Activate

* Rendering Intent - Select the rendering
intent for the Match profile.

* Spectrophotometer - Select your device from the list of supported Spectrophotometers.

¢ Activate - Connect to your selected device. Once connected, the pulldown device list will change to display any
status messages from the device and the values measured.

*  Turn Off - Disconnects the connected Spectrophotometer. Alternates with the Activate button.

* Add - Select this to append to the list for each reading. If this is not selected, the last reading is updated. This is
available after the device has successfully connected.

* Ae - Select the value of deltaE to display for when comparing measured colours with those in a loaded set. This
is used in conjunction with the Show All Swatches option.

* Show All Swatches - Select this to view all swatches. By de-selecting this, only those swatches below or equal
to the deltaE value entered will be displayed. Colours within the defined tolerance values will show in blue.

Measured / Loaded Set Panels
The Measure and Loaded Set panels show the following information:

* Colour - A swatch visually representing the colour.

* Name - The name of the colour. This can be edited by clicking in the name field.
¢ Space - The colourspace of the colour (Lab or CMYK).

* Mode - The paint mode of the colour.

¢ Tint - The tint value of the colour.

* DotGain - The dotgain curve assigned to the colour (if any).

In addition, the Loaded Set panel displays the following:

e Ae/CIE94/CMC (1:1)/CMC (2:1)/Delta L/Delta a/Delta b - These columns list the relative delta’s of the loaded
set colours when compared to the selected, measured colour.

Export Menu
The Export menu allows for the measured values to be exported to a space or tab delimited file. Save all or only selected
entries and select the format for export:

* Lab - Exportjust the Lab values.

* XYZ - Export just the XYZ values.

* Lab XYZ - Export the Lab values followed by the XYZ values on the same line.

* XYZ Lab - Export the XYZ values followed by the Lab values on the same line.

* Separate Values With - Choose if the values are to be separated with spaces or tabs.

A contextual (right-click) menu in the Measured / Loaded Set panels has the option to Delete (a selected colour); Delete
All (measured colours); Print (the measured/loaded set to a system device); and Font Options.
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Studio et s s o s
The Studio application is designed for the manual nesting T T
or tiling of jobs being processed and output by Megarip.

Property

Document

seeid 5

Width: 1180.0 mm
Height: 10000 mm
Tiling ()

Tiling Overlap: 10.0 mm

Jobs to be nested/tiled using Studio are submitted to an

Asset Queue using the Submit Files as Asset... option in e
the Application Menu, a button in the RIPMonitor toolbar, B
or by dragging files into an Asset DropSpot in a DropZone. ) e

Media

Width: 610.0 mm

Height: 20000 mm
- Box )

Left: (6.6 mm
Top: (32491 mm
Width: [225.18 mm

Submitted Assets are visible in the Asset queue in the
QueueManager and remain in the queue even after
printing, until deleted from the QueueManager. Unlike
other queued jobs, assets exist only as placeholder
thumbnails until a manual nest or tile is submitted from
the Studio application. The submitted jobs are then
imaged, rendered and the nest printed, appearing in the

appropriate queues.

Scaling: (ToF 8

EIEES

DSC00014.PG DSC00033.PG DSC00038JPC. DSC00087.PC.

The Studio user interface window is made up of four (4)

panels - the Nest Area, where jobs are placed and nests created; the Library panel, where frames and nest templates
can be saved for repeat use; the Property panel, defining tiling document area, the Media selected, and editable
properties of the currently selected frame; and the Asset panel, showing thumbnails of the Assets available for nesting
or tiling.

Submitting a Nest or Tiles

The Submit Nest button beneath the Nest Area opens a Submit Chooser to send the manual nest to a Pagesetup (if a
Media is already selected - see below) or to a Pagesetup and Media (if none was selected for the Nest).

If Tiling mode is active (see Property > Document), the button appears as Submit Tiles, opening a chooser with the
same options as above.

Selecting and Nesting with a Media
The Media button beneath the Nest Area opens a chooser to select the output Media to be used to print the manual nest
or tiling job.

A Media to be used in Studio, need not have a defined sheet size, or width/length in the case of roll media. If no size has
been saved in the Media, it is useful to enter dimensions into the Studio interface to use as a visual guide when placing
jobs.

The Media guide sheet will appear to scale in light grey in the Nest Area, allowing clear and simple placement of assets
to be nested. When submitted everything on the media sheet is printed.
(see Workbench Data Type > Media for details on Media configuration).

Note: If nesting using a roll sheet Media, the Media may include the entire roll length for the purposes of usage tracking,.
Users may find it more practical, particularly when tiling, to enter a more manageable length into the Media Height field
in the Studio interface.

Nesting Without a Media

It is not necessary to select a media when creating a manual nest. When no Media is selected a submitted nest prints
from the top left origin point, printing as much of the width or length of the nest as the paper in the printer will permit,
cropping the remainder of the nest.

Cloaking and Nesting with Large Format Flatbed Devices

One of the Studio application’s primary functions is laying out jobs for print using large format, flatbed printers. When
activated via the Studio Menu, the cloaking feature of Studio locks images and frames after they have been submitted as
a nest to the printer.

Cloaked images appear shadowed in the Nest Area, are static and non-editable unless de-cloaked. This allows for the
easy placement and printing of new jobs onto blank areas of the flatbed media. Cloaked images are not reprinted when
a new nest is submitted.

If desired, it is certainly possible to place jobs over others that have already been printed. Any new image prints exactly
where placed, regardless of whether anything has already been printed in the area.
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Important Note: The cloaking feature is turned off by default and is not recommended for use with printers using roll
media unless the device has the ability to roll back to previous areas of the media.

Tiling with Media

A Media with a defined width and height must be selected when tiling using Studio. If using roll sheet media, the length
of paper to be used for each tile can be entered into the Length field in the output settings of the Media itself.
Alternatively, the tile length can be entered in using the Studio interface - via the Height field of the Property Panel's
Media area (see below).

Menu Options
Studio has the following options available through its menus and contextual (right-click) menus:

Studio Menu

Save Nest as New - Saves the current layout in the Nest Area to the nest library. The untitled nest can be
renamed by clicking on the text “Untitled”.
Note: Only frames and layout are saved, not the images within them.
Save Nest - Saves the current layout in the Nest Area to the selected library nest, overwriting the existing data.
Submit Nest — Opens a chooser to submit the jobs currently in the nest area for imaging, rendering and nesting
to the selected Media/Pagesetup.
Studio Settings - Opens the preferences for Studio.
o Display Units - Choose the measurement units to be used in Studio from the dropdown list.
o Cloak Submitted Boxes - Locks images and frames after they have been submitted to a nest,
preventing them from being edited. Cloaked images appear shadowed (See Submitting a Nest or Tiles
for further information).

Edit
* Undo - Undo the last change made in the Nest Area. The amount of available undo levels is configured via the
System Settings (0 = operating system default).
* Redo - Redo the last undone change in the Nest Area. The amount of available redo levels is configured via the
System Settings (0 = operating system default).
¢ Cuts - Cuts the currently selected frames to the clipboard.
* Copy - Copies the currently selected frames to the clipboard.
* Paste - Pastes the frames in the clipboard to the Nest Area. Paste is centred at the current mouse pointer
position.
Box Menu
* Bring to Front - Move the selected frame to the front/top of the layout.
* Bring Forward - Move the selected frame one layer forward/up.
¢ Send Backward - Move the selected frame one layer backward/down.
* Send to Back - Move the selected frame to the back/bottom of the layout.
*  Group - Group multiple selected frames for movement, deletion, locking or asset multi-drop.
* Ungroup - Ungroups currently grouped frames.
¢ Align Left - Aligns grouped frames along the left edge of the leftmost box in the group.
¢ Align Right - Aligns grouped frames along the right edge of the rightmost box in the group.
* Align Top - Aligns grouped frames along the top edge of the uppermost box in the group.
¢ Align Bottom - Aligns grouped frames along the bottom edge of the lowest box in the group.
¢ Align Horizontal Centre - Aligns grouped frames along the averaged horizontal centre line of the frames in the
group.
* Align Vertical Centre - Aligns grouped frames along the averaged vertical centre line of the frames in the group.
* Lock - Lock the selected frames. Locked frames appear transparent and cannot be moved, edited, deleted or
have assets assigned to them.
¢ Unlock All - Unlock all currently locked frames.
* Decloak All - Decloaks all frames. Allows for movement, deletion or editing of frames locked/cloaked after
submission (only available in Cloaking mode).
¢ Select All - Selects all the frames in the nest area for grouping/ungrouping, movement, locking or deletion.
* SelectInverse - (Toggle) Deselects current frames while selecting all previously unselected frames.
View Menu
¢ Zoom In - Zooms in the nest area view.
* Zoom Out - Zooms out the nest area view.
* Fit All - Scales the nest area view to show all frames currently in the Nest Area.
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Nest Area
The Nest Area is where jobs (Assets) are laid out for nesting or tiling.

The area is surrounded by a ruler marked with the user-selected units |4
appropriately scaled to the current zoom level. All assets and frames are ;]
shown at accurate relative size. ] 0

The dark grey area is the work surface onto which assets and frames are
placed and positioned.

Blue reference guides intersect at x 0/y 0 co-ordinates (the top left corner |4
of the nest).

If tiling (see Property > Document), the edges of the total area to be tiled -
appear on the work surface as a red box. TIIED ) il el

Fit Document - Scales the nest area view to show all assets and frames within the dimensions defined in the
Document panel.

Print Size - Shows the nest in the Nest Area at actual print size.

Fill with Document - Scales the nest area, filling the view to the shorter width or height dimension defined in
the Document panel.

Full Screen - Toggles Studio between a windowed or full screen view.

Library - Toggles the view of the Library panel.

Asset — Toggles the view of the Asset panel.

Property - Toggles the view of the Property panel.

Solo Nest Area - Toggles the Studio window between regular multi-panel view or filling it with the Nest Area
only.

Section Headers - Toggles the Library, Property and Asset panel views on/off.

o, o

=

Placing Frames
Frames can be created (with a double-click), then configured and sized.
Stored pre-configured frames can be dragged into the nest area from the Frame library (see Library).

Placing Assets
Assets can be placed in the nest area by dragging them from the Asset panel. Assets dragged onto blank areas are
automatically placed in a frame with native dimensions of the asset.

Assets dragged into an existing frame are resized to fit or fill, rotated and cropped according to the frame’s settings.
Assets dragged into a selected group of frames is duplicated and placed into every frame in the group.

Positioning Assets for Nesting
The following mouse controls are available within the Nest Area:

Left click (on a frame) - Selects the frame for editing, movement, locking or deletion. Currently selected frames
are shown with a magenta border.

Left click (on empty nest area) — Deselects all frames.

Left click (hold) + drag (on empty nest area) - Creates a temporary framing square for selecting multiple
frames. Any boxes wholly or partially within the square when the mouse button is released are selected.

Left click (hold) + drag (on a frame) - Moves the selected frames around the nest area. Release the mouse
button to drop/place the frames.

Right click - Opens the contextual menu with options depending on where in the nest area the click occurred.
Double click (in an empty area) - Creates a new frame in the nest area (default size 6in x 4in).

Double click (on a selected frame containing an asset) — Activates/Toggles Crop mode for the selected frame. A
frame in Crop mode appears with a green border. (see Cropping below).

Spacebar+left click (hold) - Activates the grip tool allowing the nest area work surface view to be dragged
around.

Frame Resizing
The following resizing options are available when clicking at the borders of a frame:

Left click+drag - Enlarges or shrinks the frame. Proportions are maintained. Resize is anchored at the opposing
edge or corner of the frame.

Alt+Left click+drag — Enlarges or shrinks the frame. Proportions are maintained. Resizing is anchored in the
centre of the frame.
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¢ Shift+Left click+drag - Free resizing of the frame ignoring locked width/height ratios. Assets within the frame
will fit or fill the resized frame dependent upon box settings. Resize is anchored at the opposing edge or corner
of the frame.

e Ctrl/38 +Left click+drag - Snaps the frame proportions to asset’s native proportions and resizes. Resize is
anchored at the opposing edge or corner of the frame.

Cropping Assets
Cropping Mode is activated or deactivated by double clicking (left mouse button) anywhere within a frame containing

an asset image. When active, the asset is separated from the frame and appears with an orange border - the Crop box.

Asset Panel

This panel shows named thumbnails of all the jobs
submitted to the QueueManager as Assets to be manually
nested or tiled.

The Asset title bar has the following options:
* Small Thumbnails button - Shows available Assets
as small thumbnails with job names listed beside

them.

* Large Thumbnails button - Shows available Assets as large thumbnails with job names listed below them.

* Search field - Enter text in this field to find job names containing the search text. Non-relevant assets are
temporarily removed from view as the string is typed.

Assets dragged and placed onto the dark grey work surface of the Nest Area are scaled to their native size.
Assets dragged and placed onto a frame scale, fit or fill, rotate and crop to the defined box parameters. This also occurs
when a frame is dragged from the frame library onto an Asset in the nest area (see Library panel).

Library Panel

The Library panel is where saved frames and nesting templates are stored. It is comprised of two (2) areas - Nests,
containing the library of stored nests and boxes; and Frame, which displays the properties of the currently selected
library frame.

Nests
The top half of this panel displays a list of the available saved nests (saved via the Studio or contextual menus). Nests
can be renamed by selecting, then clicking on the name text.

Nests function like Workbench Data Type items.

A contextual (right-click) menu is available including the following options - New Folder, New Folder with Selection,
Remove Folder, Remove From Folder, Open Selected Folders, Close Selected Folders, Add to Archive, Save Nest as New,
Save Nest and Remove Nest.

Using a stored Nest
To use a stored Nest, simply double-click on it, and the nest will appear in the Nest Area.

Note: Selecting a stored Nest for use will overwrite any nest and assets currently in the Nest Area.

The bottom half of the panel shows a list of stored frames (saved via the Save button in the Property - Frame area).
Nests can be renamed by selecting, then clicking on the name text.

Using stored Frames
To use a stored frame, drag it onto the Nest Area.

Note: A frame dragged onto an existing asset in the nest area will replace the frame the asset is in.

Frame (Library)
This information panel displays data for the currently selected Library frame. Stored frames can [only] be edited from
within this panel.

Note: Configurable measurements can be input using any support unit (e.g. 6 in) but will be automatically converted to
the chosen default units on entry.
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The following fields and options are available:

* Save button - Saves any edits to the currently selected frame.

*  Width - Width of the frame.

* Height - Height of the frame.

* Lock button - Locks the current proportions of the frame if resized along one dimension.

Contents
* Left - Offset distance of the asset image from the left edge of the frame.
* Top - Offset distance of the asset image from the top edge of the frame.
¢ Width - Width of the asset within the frame.
¢ Height - Height of the asset within the frame.
* Lock button - Locks the current proportions of the asset if resized.
* Scaling - The method of scaling used for any asset placed within the frame.
o To Fit - Entire asset image is rescaled and shown within the frame.
o To Fill - Asset expands to fill the frame, rescaling to show as much of the image possible given the
proportions and centring options of the frame.
o Custom - The dimensions and frame offset of the asset are independent of the frame. This scaling is
selected automatically when Crop Mode is activated.
* (Centring - Centres the asset within the frame.
* Orientation - The rotation angle (02, 902CW, 902CCW, 1809) applied to both the frame and asset.

Note: If custom scaling is used and the asset has different dimensions to the frame, rotation is only applied to the asset.

Property Panel

This panel displays information on defined elements being used in the Nest Area.

The panel has three (3) areas: Document, used to activate Tiling mode and define the total area to be tiled; Media,
shows the width and height of the Media selected for nesting or tiling; and Frame, containing configurable parameters
for the current selected frame.

Note: Configurable measurements can be input using any support unit (for e.g. 6in) but will be automatically converted
to the chosen default units on entry.

Document
This area is used when using the Studio application for tiling an image or nest of images that is larger than available
print media. When active, a red document box will appear in the Nest Area defining the total area being used for tiling.

Activating Tiling Mode
Tiling Mode is activated by ticking the Tiling checkbox in the Documents area. Any asset or frame placed inside the
Document area will be tiled.

After a Media is selected, it will appear in the Nest Area tiled and overlapped to cover the entire document area. After
placing and locking an asset (making it transparent) in the document area, users can see how the image will be tiled
and overlapped onto each media sheet.

Note: When in tiling mode the Submit Nest button changes to Submit Tiles.

The following fields are available in the Document panel to define the tiling area and Media being used:
*  Width - Total width of the area to be tiled.
* Height - Total height of the area to be tiled.
¢ Tiling (checkbox) - Activates the Document area and Tiling mode in Studio.
¢ Tiling Overlap - The image overlap of each tile.

Media
This shows the dimensions of the Media currently being used in the Nest Area for nesting or tiling.
¢ Width - Width of the Media. Defaults to the width of a loaded Media but can be edited.
¢ Height - Height (Length) of the Media. Defaults to the length/height of a loaded Media but can be edited.

Note: For roll sheet media to be visible in the Nest Area and/or used for Tiling, a Height (Length) must be defined.
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Frame (Property)
This information panel displays data for the currently selected frame. The frame and contained asset can be edited from
within this panel.

Save button - Saves the currently selected frame to the library for later use.

Left - Offset distance of the frame from the left guide. Offset is measured from the top left corner of the frame.
Top - Offset distance of the frame from the top guide. Offset is measured from the top left corner of the frame.
Width - Width of the frame.

Height - Height of the frame.

Lock button - Locks the current proportions of the frame if resized along one dimension. The locked
proportions are overridden by free resizing the frame from within the nest area.

Contents

Left - offset distance of the asset image from the left edge of the frame.
Top - offset distance of the asset image from the top edge of the frame.
Width - width of the asset within the frame.
Height - height of asset within the frame.
Lock button - locks the current proportions of the asset if resized along one dimension.
Scaling - The method of scaling used for any asset placed within the frame.
o To Fit - Entire asset image is rescaled and shown within the frame proportions.
o To Fill - Asset expands to fill the frame rescaling to show as much of the image possible given the
proportions and centring options of the frame.
o Custom - The dimensions and frame offset of the asset are independent of the frame. This scaling is
selected automatically when Crop Mode is activated.
Centring - Centres the asset within the frame.
Orientation - The rotation angle (02, 902CW, 902CCW, 1802) applied to both the frame and asset.

Note: If custom scaling is used and the asset has different dimensions to the frame, rotation is only applied to the asset.
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Application Menu Items

The Megarip Application menu provides access to direct job submission options, system settings, and extra functions
and utilities.

St Fles
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Submit Files . | o e U
Select files to send to a Media and Pagesetup for processing. One or R —
more files may be selected for processing.

720,00 by 720.00 doi
v

er Settings

Epson Stylus Pro
7800/9800/7400/9400,
PX-7500/9500/75005/95005
Options

ype  Premium Luster Photo Paper (Roll)
Roll Paper

Selecting Open will present a chooser showing the Pagesetups (or
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into the system for processing. The flow control can be enabled to hold
the job after imaging or rendering; the number of copies can be set; or
jobs can be placed as pages in a publication.
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Submit Window

The Submit window is comprised of four (4) sections - a Pagesetup/Pagesetup Pools selection list; a Media selection
list; an Information panel displaying details of the currently selected Pagesetup or Media; and a Submission control
panel.

Pagesetup Selection List
This list has two (2) buttons above it. Only one can be active at any time:

* Pagesetup - When selected, this button displays a list of Pagesetups available to submit jobs to.
* Pagesetup Pool - When selected, this button displays a list of Pagesetup Pools available to submit jobs to.

An active (selected) Pagesetup is highlighted in blue.

Media Selection List
This list is only active if the Pagesetup button is selected in the Pagesetup selection list.

When a Pagesetup has been chosen, a list of Media compatible with the Pagesetup will be displayed for selection.
An active (selected) Media is highlighted in blue.

If no Media is selected, the submitted job(s) will be output to the Pagesetup’s default Media.

Note: The Serendipity Client saves the last Pagesetup and Media selection so it need not be selected every time a job is
submitted to the same Pagesetup.

Information Panel
This panel displays the settings for the currently selected Pagesetup or Media.

Submit Options
The lower section of the Submit window has the following options available when submitting files:

Flow Control

* Hold After Imaging - Check this box to hold the job after the Imaging stage has completed. Held jobs can be
released to continue processing via the QueueManager toolbar or contextual (right click) menu.

* Hold After Rendering - Check this box to hold the job after the Rendering stage has completed. Held jobs can be
released to continue processing via the QueueManager toolbar or contextual (right click) menu.

* Send to Nest - Submits the jobs for imaging and rendering, then on to be nested with other jobs. Nesting
criteria are defined in the Output for the Pagesetup/Media to which the job is sent (see Workbench - Output
for further information).

Copies
* No. of copies field - Enter the number of copies of the job to be printed.
* Copy Lock button - Locks the number of copies to be printed for any files submitted until unlocked and
changed.
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Publication
* Publication Name field — Optionally type a publication name to which the submitted file will be assigned. The
job will be viewable in the Publication View of the QueueManager.
* First Page field - Enter the page number for the submitted file in the publication. If submitting multiple files,
the page numbering will start at the defined page number and increase sequentially for each job.

Submit Files as Asset

Select files to send to the Studio application Asset queue. Submitted Assets appear in the QueueManager queue as
thumbnails, but are not processed until submitted for printing from the Studio application (see Applications - Studio
for more information).

Submit ICC Target

After selecting one or more ICC target files, a chooser allows you to select a Pagesetup and Media to submit the ICC
target file to.

Note: This option is used as part of creating an ICC calibrated Pagesetup/Media. After creating and assigning a Paper
Profile and Linearisation curve to a Media, this option is used to submit an ICC target file to the printer with all ICC
options disabled. The target is then read by third party ICC profiling software and used to generate the printer’s output
ICC profile, which is then assigned to the Media.

Test Prints
Select one or more Pagesetups and Medias and send multiple copies (if desired) of internal test prints for processing.

Note: You can add your own files to the lib/testprints directory for use as test prints. Any files you have permission to
use that are placed in this directory will appear for selection in the Test Prints chooser window.

Connect to Server

This allows the Serendipity Client to connect to a Megarip Server running on the network. The Refresh button will
search for and display any active Servers. Alternatively, you can enter the name or IP address of the Server in the
Server Address field under the Manual tab.

If there are multiple Servers (Masters) running on the network, the list is cached on the first “Connect to Server”
selection. A dropdown list of available Servers is accessible via the Auto Detect tab. If a new Server appears after this
time, the Refresh button must be pressed to find and add it to the list. Likewise, if a Server becomes unavailable, the
connection will fail and the list will require a refresh.

When the Serendipity Client is started, it will attempt to connect to the last Megarip Server accessed by default.

Server Selection Server Selection

Auto Detect | Manual {"Auto Detect | Manual

Active Servers: | golem.swdevel.serendipity-software.com.d & Refresh )

Product Name: Serendipity Megarip Server Address: |golem.swdevel.serendipity-software.com.au
Version: 5.0 (8uild 21029) Server TCP Port: 9100 8
Server Hostname: golem.swdevel.serendipity-software.com.au
Server 0S: Darwin 9.7.0 1386

(e
Cancel ) (Connect) Cancel Connect t

Accounts Admin

This menu option replaces the previous option of Authorisation. Accounts Admin allows an authorised administrator to
create, modify and manage User accounts and User Groups. Users can be reassigned to groups dependent upon the
operating privileges granted to each User Group. See the Accounts Admin/Secure Mode section below for further
information.

Log Out (Secure Mode only)

This menu item only appears while Megarip is in Secure Mode (see Accounts Admin/Secure mode for more
information). Selecting Log Out while using Megarip in Secure Mode simultaneously logs out the current user and
generates the Login window. At this point, the options available are to enter a username and password; Choose Server
before login; and to Quit the Megarip Client.

While the Login window is displayed, the Megarip Client is effectively LOCKED to all users. The Server will continue to
operate as normal.
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Chatterbox

Chat to other users connected to the same Server. The Chatterbox window will display the Clients connected to the
Server. If the user has entered a nickname in the System Settings, this name is displayed; otherwise the machine name
is used. If the user’s name cannot be selected, the user has selected the Away option and is not available.

Broadcast Message

This allows messages to be sent to all users connected with a Client to the same Server. Selecting the Broadcast option
displays a message window to type into and send. The message is displayed on the users window for a short time and
will automatically dismiss if it is not acknowledged by clicking OK.

Download PPD

This option downloads the Megarip PPD from the Server to the desired location. A chooser will appear to navigate to
the location for saving the PPD file on the drive. This saves having to get the PPD off the disk. Use the PPD when
installing a local printer. When installed, the Megarip PPD (Postscript Printer Description) is selected as the printer
driver when setting up a Megarip Published Pagesetup as a print destination for third party applications (see
Workbench - Pagesetup and the Publish to a Windows Printer sections for more information).

Quit
Quits the Client. The session is saved for the next time to start the Client. All windows and positions are saved and
remembered.
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Accounts Admin / Secure Mode

Megarip Version 4 gives users the option to login using Secure Mode, which allows the administrator to create accounts
for users and groups, with each group configured to allow or deny its users access to particular applications and
functions.

When Secure Mode is active, users are required to enter a username and password whenever the Client is started or
users are changed. The username and password are both case sensitive.

The Accounts Admin menu option is selected in order to display the
panels for configuring any Users and Groups and these should be created

prior to activating Secure Mode. sel‘elld!pity Megal'ip

The Log Out option only appears once Secure Mode has been activated.

Selecting this while using Megarip in Secure Mode simultaneously logs golem swdevel.serendipity-software.com.au:9100
the current user out and generates the Login window with options to

login as a new user and select a Server to connect to, or Quit the Rae

application. While the Login window is displayed, the Client is effectively Password:

locked to all users. The Server will continue to operate normally.

( e ) ( Chance Corver )
Quit Choose Server...

Setting up Users and User Groups
Megarip’s Secure Mode is set inactive by default. The software will continue to function normally whether or not Secure
Mode is activated.

Important Note: It is recommended all users and groups requiring access be setup BEFORE activating Secure Mode.
Secure Mode cannot be activated until at least one (1) user has been created. This would usually be the Admin account,
as this is automatically created when the Accounts Admin option is selected for the first time.

© 0 O Accounts Admin<2> - admi wdevel 19100 - NFR (ot for resale)

Select Application Menu > Accounts Admin... to display the configuration e
panels. - E

Activating Secure Mode

Once the initial user account(s) have been setup, Secure Mode can be
activated by checking the tickbox located via Application menu > System
Settings > Server (General tab).

Secure Mode can only be activated or deactivated by an administrator (a
member of the Admin group).

Configuration Panels

Users Panel
The fields within the Users panel are:

¢ Name - The username of the account. This is case sensitive. e T (e
. . . . . UserID: 0
¢ User ID - This is a numerical ID assigned automatically but may be changed —— vty
by the administrator. Permission: 775 dit...| (default)

Email

* Password / Verify - The password is entered and stored here. New
passwords must be verified by entering the details in each field. The
password is also case sensitive. L =

¢ Permission - The level of permission for the user is created here. Click Edit outatns
to make changes to the user read/write/execute permissions. e U

e Email - Enter the users email address here. e Drto

* Comment - Allows the administrator to enter a note on the particular user
account if necessary.

*  Group (dropdown) - Assign a user group to the user account.

¢ User Privileges - Privileges other than those in the user’s group can be
added here.

Comment:  gminstrator user. Has all rights. Must exist at all times.

sssg
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Notifications - Select which email notifications the user is to receive by clicking the + icon or remove any via
the — icon. Notifications are available for Job Spooling failure, Job Autodetection failure, Job Imaging/Rendering
failure, Job Printing failure, if a Dongle is removed, if the Server crashes and Media Remaining warnings.

To create a User:

Click the + icon in the bottom left of the window. To delete a user, click the - icon

Enter a username in the Name field.

Enter a User ID number or leave the default value.

Create a password for the user and verify the details. The password boxes will always display black dots
irrespective of the length of your password.

Edit the permission level to the required access level.

Enter the user’s email address (if notifications are required).

Add a comment against the user if necessary.

Assign a Group for the user.

Add any extra privileges to the user if required. This will only show privileges not included in the group
selected for the user.

Add any notifications to the user if required.

Apply the changes or select Revert to cancel.

Groups Panel
An admin User and Group are created by default with access to all permissions and privileges when the Accounts
Admin option is selected for the first time. The admin user and group cannot be deleted. It is recommended this be

the only group with access to the Accounts Admin application.

The fields within the Groups panel are: Ui oot
¢ Name - The name of the Group. e
* Group ID - This is assigned automatically but may be Ui i
changed by the administrator. bt o Conele e 1
¢ Comment - Allows you to enter a note on the particular user || ™"
group if necessary Efwi. o
* Group Privileges - This is a list of available privileges Ui btane
relating to functions within Megarip. Use Bookttonior
* Members - A list of Usernames and IDs belonging to the
Group.
To create a Group: s e e B
ress Agent Revert Apply
¢ (Click the + icon in the bottom left of the window. To delete a  [Lz2== B I

group, click the - icon.

Enter a name in the Name field.

To add privileges, click the + icon in the Group Privileges panel. A list will appear to the left with all available
items. To add, highlight the privilege and click the + icon at the top right of the window.

Once you have finished adding privileges, click the X in the middle of the right edge of the panel to close the
window.

Click Apply to save any changes to the group or Revert to cancel.

Assigning Users to a Group

Users are assigned to the groups via the Users panel.

(@& Users i@ Groups'

Once you have created the user group, click on the Users panel.

Select the User Name from the list of users.

Select the Group to assign the user to from the Groups dropdown menu.
Click Apply to save any changes or Revert to cancel.

- None -

el v (Yadmin ]

i@ Serendipity

er Privile,

Important Note: A user can only be assigned to one User Group at a time. If extra privileges are required, these must
be assigned against the user via the Users panel.
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Activating Secure Mode
Secure Mode should be activated after any users and/or groups have been created. Only an administrator or member

of the admin group can activate or deactivate Secure Mode.

SystemSettings
To activate: — —
Default Units: [ mm )
* Select Application menu > System Settings. Maximum Memor or P ;. ows
*  Click on the Server tab > General tab. T o
* Tick the checkbox at the bottom of the screen - Secure mode - J
to activate or deactivate. ememess (@ () oas
* (Click OK and close the settings when done. TR
¢ If activating Secure Mode, a login window will appear as soon as Du kv s s
you close the System Settings. i sever
If Email Notifications are setup for users:
e Enter the mail server details in the Mail Server field. This is the |~ e

outgoing SMTP server.
* Enter the email address for the Sender (From) field of the email in the Sender Email Address field.
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System Settings

The Systems Settings section contains default values and preferences configured for the Server and Client. The settings

are split

into two (2) tabs - Server and Client.

Server
Server settings are saved to the Server and are common to all connected Clients. The Server settings are divided into
three (3) tabbed categories — General, Colour Management and Working Paths.

General

Default Units - Set the units used by the Server. Options are
mm, cm, inches, points, picas, metres or feet.

Maximum Memory for PS RIP - Set the maximum memory used
by the Postscript RIP. The default is OMB (which uses the
internal default amount).

Maximum Memory for Rotation - Set the maximum memory
used for Rotation. The default is OMB (Server chooses the
default depending on system configuration).

Low Quality Thumbnail - Selecting this produces a lower
quality thumbnail. This is faster but some detail may be lost in
the thumbnail.

Compression - Control the compression for the intermediate
file format (the Imaged file). Choices are Faster or Better. The
default is Faster.

Maximum Print Preview Resolution - Set the maximum
resolution for the rendered preview. The default is 180dpi.

SystemSettings

Server | Client

General | Colour Working Paths

Default Units: | mm )

Maximum Memory For PS RIP:  OM83 8

Maximum Memory For Rotation:  OM83 B
(7] Low quality thumbnail (faster)

(Faster 13

Maximum Print Preview Resolution: 180 8 DPI

Compression:
Server Back Log: 0 | Days

Processes: Image 1 Render 1

Minimum Broadcast Interval: 0's

[ Output unknown files to printer
¥ Secure mode

Mail Server

Sender Email Address

Cancel ) [3

Server Back Log - Number of days to keep the log. Older days are trimmed when the Server starts. Zero (0)

means the log will not be trimmed.

Processes - Control the number of processes the machine will handle, i.e.,, the number of Imaging and
Rendering tasks simultaneously run on the Server. The defaults are 1/1. Up to one imaging and rendering task
can be set per CPU core the Server machine possesses. In practice, it is recommended the combined number of
imaging and rendering tasks be set to no more than the number of cores. For example, 4 CPU cores = 2 Image/2

Render.

Minimum Broadcast Interval - Set the time interval the Server sends out updates to connected Clients. The
default value is 2s. This is the minimum setting. Zero (0) disables user configuration.
Output Unknown Files to Printer - Output any unknown files direct to a printer. If this is unchecked, any

unknown files will result in errors and will not be output.
Secure Mode - Enable or disable Secure Mode.

Mail Server - Enter the details of the mail server for error notification emails when using Secure Mode.
Sender Email Address - Enter the details of the Sender (From) address for error notification emails.

Colour Management

SystemSettings

Server | Client

ICC Engine Accuracy - Select Faster or Better, depending on e T Colow st | visking 7

preferences.

Default ICC Profiles - Select the default ICC profiles used when first
creating a new Pagesetup (Input profiles) and Media (Output

profiles).

Working Paths
Working Paths lists the default location of the paths the Server uses to process jobs.

Raster — Holds all the imaged, rendered and print jobs while they

are live in the system.
Spool - The location where the job is spooled prior to processing.

Temp - After spooling, the job is moved to the temp directory

where it is worked on.
Drop - The default location for the DropFolders.

ICC Engine Accuracy: [ Better 18]
les

("% Input CMYK Profile .. )

(" # Output RGB Profile .. )

——
(% Output CMYK Profile Norne.

Server | Client

General _Colour Management | Working Paths |

The Raster directory holds all jobs while they are in the system and as such, can be very large. If this is moved it needs
to be placed on a disk with plenty of space. A Server restart is required if any paths are changed in order for the

changes

to take effect.

Serendipity Megarip User Manual - Version 5

80



Client

The Client settings are custom options, specific to the Client currently being used. Settings may vary between Clients
and Users connected to the same Server.

The Client settings are divided into three (3) tabbed categories - General, Colour Management and Application
Shortcuts.

General

Internationalisation - Select your preferred language from
those available. This displays all Client and log messages in the
chosen language. The default is English. A restart is required if
the language setting is changed.

Show Tooltips - Enable or disable tooltips within the Client.
Turn Sound FX Off - Check this to disable the sound effects.
Sounds are used for things such as drag and drop, and error
message alerts.

Undo Levels - Set the number of levels for Undo. The default is
zero (0), which means no restriction.

Instant Messaging Nickname - Enter a nickname to use when
accessing the Chatterbox application.

Memory Cache Maximum Size - Set the maximum cache size for
the SoftProof application. The default is zero (0), where the
Server chooses the default depending on system configuration.

SystemSettings

Server | Client

[ General | Colour Application Shortcuts

English |4
General User Interface Settings
¥ Show Tooltips M Turn Sound FX Off

Undo Levels: 0

SoftProof
Memory Cache Maximum Size: 0 B

Maximum Preview Resolution: 180 < oel

"2 ) (Cancel ) (0K

Maximum Preview Resolution - Set the maximum preview resolution for SoftProof for both Imaged and
Rendered options. The default is zero (0), which is the full job resolution of the output file.

Colour Management
Choose Default Match ICC Profile — Select a default match ICC profile for accurate display of CMYK data.
Calcheck Managed - Enabling this will display the current calibration status of the selected monitor. When

selected, there will be a transparent icon showing a green tick
or a red cross. This icon is shown in the corner of the monitor
and is always on top of other windows. The icon can be moved
to any corner by clicking and dragging close to the corner. Its
status depends on the expiration time of the monitor
calibration (as set below) and the Calcheck status.
Choose Monitor ICC Profile - Select a monitor ICC profile for the
display the Client is running on. The profiles are used so any
colour element viewed on the display is shown as accurately as
possible. This includes SoftProof and any colour swatch. It is
recommended the monitor be calibrated and set to the same
match profile as is used for the softproofing Pagesetup.
Resolution - Choose the default resolution to use for the
monitors. This is used in SoftProof for calculating various fit
methods. Options include:

o Use System Settings - The Client will calculate the

system’s monitor resolution.
o Custom Resolution - Specify your own resolution.

Server | Client
General | Colour Management | Application Shortcuts |
Match
(" Choose Default Match ICC Profile... ) /Applications/Serend...coated_v2_eciF39.icc
Monitor 1
[ Calcheck Managed
("4 Choose Monitor ICC Profile... ) /Library/ColorSync...ys/iMac-4272580.icc | &
Resolution
@ Use system setting: 93 x 95 oPI Calibration expires
O Custom resolution: 72 oI (Never 73]
Monitor 2
[ Calcheck Managed
("4 Choose Monitor ICC Profile... ) /home/mandy/Libra...-4247891 Golem.icc | &
Resolution
@ Use system setting: 99 x 98 0PI Calibration expires
O Custom resolution: 72 Pl Never 3]
Ld Cancel) (0K )

o Calibration Expires - Set a reminder to popup when a calibration needs updating.

Additional Monitors

Specific settings may be set for each monitor when in a multi-monitor environment. The
System Settings will show additional sections with Monitor 2, Monitor 3 etc listed. To identify

3 Z)

which monitor is which, press the monitor indicator button to display a graphic in the middle
of the screen for the relevant monitor.

Calcheck Managed
The Calcheck Managed option (under Colour Management) constantly reports the calibration status of the
monitor(s).

By enabling this option, a small, transparent icon will appear on top of other windows, giving the current

calibration status of the monitor.
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This is linked to the Monitor ICC selected in the System Settings, the time it was created with the MonitorCalibrator and
the expiration time set. If the monitor has been calibrated and the expiration time has not been reached, there will be a
green tick displayed on the monitor. If the time has expired, there will be a red cross displayed.

Hovering the mouse over the cross or tick will display

rofile information and status. ICC Profile
P Status: Expired
. L. . . . . Created: 9/03/09 12:44 PM
nght Cllelng on the tick or cross will dlsplay extra options: Filename: /Library/ColorSync/Profiles/Displays/iMac-4272580.icc

*  Opacity - Set the opacity value for the status window.

¢ (Calibrate - Opens the MonitorCalibrator and begins to calibrate. If the instrument previously selected is
connected, calibration begins. Once calibrated, select an appropriate name and click OK. This will save the ICC
to the chosen location. Select the ICC in the system settings and dismiss the MonitorCalibrator application.

Calcheck Managed is also linked to the Calcheck application, where the status is saved to a Calcheck Chart and used
when a job is opened in SoftProof.

When a Calcheck is run for the monitor, a Calcheck Chart is selected. The result is stored with the chart, which can be
selected in a Press setting. If a job is viewed in SoftProof with that particular Press and Chart selected, the status of the
proof being viewed is displayed. This condition lasts for the duration of the current life of the calibration. When a
calibration expires, all Calcheck statuses need to be updated.

Application Shortcuts
This tab displays a list of the Applications and Modules for which keyboard shortcuts can be created.

Note: It is the responsibility of the user to check the created shortcuts do not conflict with any other Megarip, third
party software, or operating system shortcuts/hotkeys.

To add a shortcut:

Server | Client

General _Colour Management |~ Application Shortcuts |

* Highlight the selected application or module in the list.

¢ Use the Edit option in the context menu (right click) or click in the
Shortcut field to the right of the application/module name.

* Type in the key or key combination for the shortcut and press
Enter.

The shortcut will now appear in the Application menu of the Client.

To remove a shortcut:

* Highlight the selected application or module in the list.
*  Use the Clear option in the context menu (right click); or
¢ (Click in the Shortcut field and delete the shortcut.

) (“Cancel) oK
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Web Server

The Server has a built-in Web Server that allows you to connect to it from a web browser. This provides status
information about the Server and jobs currently in the system. You cannot use this for submitting or managing files in
the system, but you can monitor a jobs progress and get some system information.

Accessing the Web Server
To connect to the Web Server:

1. Enter the IP address or machine name (if using DNS) of the computer running the Server in the browser
window, followed by a colon and the port number 8080. For e.g., 192.168.3.43:8080

/% ) 192.168.3.43:8080

2. Press Enter once the address has been typed in. When it connects, the browser address bar will look like this:

% I http://192.168.3.43:8080/

3. Ifyou have a DNS Server, you can use the machine name instead:

/2% M htp://papaya:8080/

4. Once you are connected, the front page will appear with an options menu on the left:

HOME BLOG CONTACT

Downloads

Welcome to Serendipity Megarip
Serendipity Meqaril Select an option from the list on the left to continue.
Queues
Log File
System Info
Support

*  Queues - Shows all the queues configured on the Server you are connected to.
* Log file - Allows you to view the log file.

* System info - Displays information about the system.

* Support - Shows various support options & information.

Available queues:

Serendipity Megari + So00l
— « Autodetect
Queues * Image
T . - . . « Printer queues
Queues - Click on any of the queues to get information about jobs in that queue. S * Showal aeues

Available printers:

Information about the job, including name and current status will be shown.
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Log File - To view the log file, select the option from the list on the left. b
From here, you can select a particular time period to fetch from the
Server. Once viewed, you can print the file or save it to disk. The log can
be printed, saved or exported from the browser.

Disk usage:
Serendity Megarip Disk
1 S0
Queues
LogFio Pt
Sysom ko ProdTemp b
Support
et | osem e
Drop
Product info:

Product Created: Jul 22 2000 13:17:22
ProductType: NFR (noL (o resale)
Operating system: Darwin 6.7.0 365
Donge serial no: 420072450011

Dongle created: Thu May 14 11:66:21 2009
Licensed modules:

Available Printers

Epson Stylus Pro 4000/ PX-5000 Rev 3.08

Used Tl Path
46,3768 505.85G8 /Applications/Serendipty/Megarip Vs/Serendipty Megarip/spoo
463768 5058568

463768 595.85G8 /Applications/Serendipty/Megarip V5/Serendipty Megarip/mp.
463708 595.85G8 /Appications/Serendipty/Megarip V5/Serendipty Megario/mp.

46,3768 595.8508 /AppicatonsiSerendiptylMiegario VSiSerendipty Megaripciop

ProduciName: Serencdipty Megarip version 5.0 (Build 21029)

Hosiname: golem swdevel serendipiy-software.com.au

Support - To access the Serendipity Support site, select this option from the
menu. This is the same as if you accessed the Serendipity Software website

directly.

From here, you can download databases, release notes, manuals, updates,

tutorials, FAQs and other helpful information.

You will need to have an active Internet connection for access to the support

website function.

[5minutes | 30 minves [ g0 Swesi| a1 1
Logile from golem.swdevel.serendipity-software.com.au

Serendipty Megarip

SSCHAECNS 13512209 et abS, recomlgurng

s e Intalsaton sirted

Systom o 2 Taskaa200

Surpon <eSecurty Key Chici Successful>>. Key Number 115 AVaid Key For
MegaRIP_MegaRIP Verson 5.0__ (c) 1996,1957,1998,1999 Serancipty
Sofware Pty Lia

moun
TesE g g e

e —
T8 Donecaciatngsever speed, S5 = 567122623
B s S ere

T Gatnglstof vata e vers

ThE L etng st of svsave ot rvers
T Getng ot of avalal destnatondvers
T Gt st of vl renceng st s

i B ———

MR intabsng web sener

Intlsing roncering angine

System info - Choose this to display information about the system.

Product Info, Licensed Modules - available printers and input filters;
and Available Destinations are shown.

Serendipity Support

ur supprs g o el nfomatn o ous Bk o

Software Updates
i o asest updaesfor your sowar 3 ko up oGt it any changs.

Manuals
Magarp ot work somening
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Publishing a Windows Printer

This section explains step-by-step how to publish a configure a Megarip Pagesetup for publishing to a Windows printer
destination. When correctly setup, third party applications will be able to print directly to the Pagesetup, as if it were a
Windows printer.

It is assumed that Serendipity Megarip is running and a Pagesetup configured.

Method
Once the Pagesetup is configured and working, it needs to be published as a Windows Printer.

Publish
1. Tick the Windows check box in the Publish panel of the selected ﬁ'T’fide Windows
Pagesetup and save it. This will make the Pagesetup available to the —Locaton .. | Desur Defaui
Windows system to which it will be published. Pinter [ Mac [¥ Windows

TCP Port: [~ Activate port number

Welcome t% the Add Printer
Wizard 2. Select Settings > Printers from the Windows Control Panel and run

Tris wized hepsyou sl ke ot ke pitr the Add Printer wizard.

To continue, click Next.

coack [TNew> | cancel
[ prinker wizard
Local or Network Printer
Is the printer attached to your computer?
I the printer is directly attached to your computer, click Local printer. If tis attached to 3. Make sure Local Printer is selected and click Next.

anather computer, or directly to the network, click Netwark printer.

@ Local printer
I~ Automatically detect and install my Plug and Play pinter

© Network printer
< Back Next > I Cancel
[add Printer Wizard
Select the Printer Port
Computers communicate with printers through pots.
Sclect e pot o wan o i e I he p s ke, you cn el 4. Choose Create a New Port and select Local Port from the pull down
new port
€ Use thefolowing port: list. Click Next to continue.
Port [ Description [ Printer [=
LPT1: Printer Port ‘webWorks Rasterizer, ForFram...
LPT2: Printer Port
LPT3: Printer Port
LPT4: Printer Port
LPTS: Printer Port
M- Gerial Port =
Note: Most computers use the LPT1: port to communicate with a local printer.
@ Create a new port:
Type: Local Port IS =
<Back Newt> |  Cancel |
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5. Enter the port to add.
Enter in the following format: \\.\pipe\<Pagesetup Name>

The “Pagesetup Name” needs to be the full name of the Pagesetup.

Port Name

6. Click OK to accept the name and close the window. [\ \pipe\Epson 7800FremSemidios]

The Server must be running and the Pagesetup published so the printer can find |[E=020E

and verify the port exists.

If not, the following error (right) will appear. This error will also appear if the

name is typed incorrectly.

Add Printer Wizard

Add Printer Wizard
The manufacturer and model determine which plirf&to use.

Add Printer Wizard

Name Your Printer
You must assign a name for this printer.

Add Printer Wizard

Printer Sharing
You can share this printer with other network users.

7. Next, choose a driver. If the Serendipity Megarip driver is not
installed on the system, select the Have Disk option and browse to
locate the PPD. This can be found on the CD or it can be downloaded
from the Server (see Application Menu Items - Download PPD for
more information).

8. Once the driver has been selected, click Next.

0

Supply a name for the printer and click Next.

10. Choose to share the printer to make it available to other computers
on the network. Enter a share name and click Next.
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|Add Printer Wizard

Location and Comment
*You have the option of supplying a location and description of this printer.

You can describe the location and capabiles of this prnter. This information may be
helpful to users.

Location:  [Back Wal

Comment:
< Back I Next > I Cancel
Add Printer Wizard

Print Test Page
To confiim that the printer is installed propeily, you can print a test page.

Do you want to print a test page?
€ Yes
& No

<Back | Next > | Cancel

| Add Printer Wizard

Completing the Add Printer
Wizard

You have successfully completed the Add Printer wizard.
You specified the fallowing prnter settings:

Name:  Epson7800

Sharedas:  Epson78lmymachine

Part 4. \pipe\Epson 7800PremSemiloss
Modet  MegaRIP Rasteriser version 36,03
Default  No

Testpage: MNo

Locatior:  Back Wal

Comment I

To close this wizard, click Finish.

< Back I Finish I Cancel

11. If the printer is shared, a prompt will appear to enter some
information in order to help identify the printer. Click Next to
continue.

12. Print a test page to confirm the setup is correct, although this is not
necessary, as the port has been validated in previous steps. Click
Next to continue.

13. The final screen shows a summary of the printer just created. You
should now be able to print to the Pagesetup from any network
computer that can see the published printer. Click Finish to close
the window. The newly created printer will be in the list.
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Printing to a Windows Shared Printer

The following provides step-by-step instructions on how to print to a Windows shared printer from Serendipity

Megarip.

The first section will outline the steps required when the Server is running on a Mac. The second will outline the steps

for a Windows environment.

Megarip Server Running on a Mac

The first requirement is to create a printer on the Windows machine that will print to the physical printer.

On the Windows machine connected to the printer:

Navigate to Control Panel > Printers > Add Printer. Install the
printer normally. Give it a useful name that can be identified
easily. This is the name that appears on the local computer.

Go to the Sharing tab and enter a share name. Again, pick
something easily identifiable on the network. It is recommended
to use lower case and no spaces. Also, try to keep names
reasonably short. This shared printer should now be visible on
the network.

For this example, the printer name is “HP Designjet T1100 24in HPGL2"
and our share name is “tanglefoot-t1100”.

The printer name is the default created when the printer was
added to the windows print system. The share name uses the
computer name (tanglefoot) at the beginning so it is easily
identifiable on the network.

At this stage, a test page can be printed to check the Windows side
is configured and working correctly.

%% HP Designjet T1100 24in

21x]

Security I Device Settings I About |
General I Shaing | Pots | Advanced |  ColorManagement |

\;é [P Desigriet T1100 24in HPGL

Location: I

Comment: |

Model: HP Designjet T1100 24in HPGL2
Features
Color: Yes Paper available:
Double-sided: No Letter
Staple: No
Speed: Unknown
Maximum resolution: 1200 dpi =

Printing Preferences... | Print Test Page |

0K | Cencel | o

21x]

Security l [% Device Settings I About I
General Sharing I Pots | Advanced |  Color Management

\:é HP Designiet T1100 24in HPGL2

Tanglefoot-t1100

~ Drivers for different versions of Windows —

If this printer is shared with users running different versions of
‘Windows then you will need to install additional drivers for it.

Additional Drivers...

0K I Cancel £pply
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On the Mac running the Megarip Server

(Mac OS X 10.4 and earlier)

Now the Windows printer is configured and shared, create the printer on the Mac in order to print to it.

1. From the Finder go to the Utilities folder and launch the Printer Setup Utility.
A window containing the existing printers will appear.

Windows Printing

- = Canon B Network
Canon FireWire (GARO)
Canon IP (GARO)
DYMO DUO USB
DYMO LabelWriter
EPSON AppleTalk
EPSON FireWire
EPSON TCP/IP
EPSON USB
FAXstf
HP FireWire
HP IP Printing
Lexmark Inkjet Networking

Location: No§

i Achvariond i i |
—

Print Using:

6 ( More Printers... )

666 Printer Browser [=)
a°N B a
Default Browser 1P Printer search
Printer Name ] Connection
£9800 Satin720dpi AopleTalk
Epson 4800 ScrPr 720x720 AopleTalk 0
Epson 4800EnhancedMatte theory3 AppleTalk
Epson 4800PremSemi250 theory3 AppleTalk
Epson 7600 Screenprinting 720 AppleTalk
Epson 7800 ScrPr 720x720 AppleTalk
Epson 7800PremLuster - Papaya AppleTalk
Epson-4800-Fuji-Olaf AopleTalk
Name: No Selection
Location: No Selection
Print Using:
@ (_ More Printers.. )
© x-
N66 Printer Browser =)
| v AppleTalk
o Bluetooth

®n0e6 Printer List
- e
Add
In Menu Name
= TRPAYE LIt T UOY TI VLT
™ Papaya Epson 9600 unscreened
™ Papaya HP 23100 Best
™ papaya-screenprint-7600
) % raw on canon8200
7 =" Stylus Pro 11880 USB Direct

»

=

Printer Setup Utility

2. Click on the Add icon. The Printer Browser window will open.
3. Click on More Printers while holding the Option Key. This will give extra

options.

4. If you are running v10.3.9 OS X hold the option key when clicking the Add icon
earlier to view the extra options.

o n

AppleTalk H
Local AppleTalk Zone 1)

| Name
1bit Screened
_-Testing
AS PDF

E9800 Satin720dpi
Epson 4800 ScrPr 720x720

. Type
PostScript Printer m
PostScript Printer
PostScript Printer
PostScript Printer
PostScript Printer

sty |

(_Cancel ) Adc

Click on the pull down menu AppleTalk and select Advanced.
From the Device pull down menu, select Windows Printer via SAMBA.

7. Enter a Device Name. This is the name that will appear in the Mac Printers list.
It should not contain any spaces, capitals or hyphens.

Note: The interface will allow the use of spaces and hyphens, but the CUPs printing will
transpose those characters to underscores. This can be confusing as you see a printer
with one name but need to use another name to print to it.

8. Enter the Device URL, which is the path to the printer on the Windows machine. This contains the Printer
Share Name, Windows machine name, user name and password to enable SAMBA to pass the job to it.

The format is: smb://<user>:<password>@<machinename>/<printersharename>

For this example, the names are:

¢ User: megarip

* Password: serendipity888
* Machine: tanglefoot (IP address can also be used)
*  Printer: Tanglefoot-t1100

The path is: smb//megarip:serendipity888@tanglefoot/Tanglefoot-t1100

(The line is unbroken)

Device:

Device Name:

Device URI:

Printer Model:

Advanced ﬂ

"hp_t1100_via_tanglefoot

Windows Printer via SAMBA ﬂ

smb://bmagic:serendipity888@tanglefoot/
Tanglefoot-t1100

Generic ﬂ

( Cancel ) Add
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A driver can be set here but it is not used when printing from Serendipity Megarip. This is simply used to deliver the job

to the printer. The driver within the Workbench is the one used.

On a Mac running the Megarip Server
(Mac 0S X 10.5)

e o6 Printer List =
g C »
Add 9.
In Menu Name A appear in the printer list.
4 @ HP 26100 - IP printing
o 2 HP-Z3100-directdriver O
[ HP4500-multi-ball-roll1
v hp_t1100_via_tanglefoot S
™ Jpeg-screen-res :
<>

Once complete, click the Add button and the new printer will

1. Open the System Preferences and select Print & Fax from the Hardware panel.
2. Click the +icon to Add a Printer.
3. Select Windows in the Add Printer window.
4. Click through the Network Name, Network Computer <machinename> and select the shared printer
<printersharename>.
5. Select the driver you wish to use for the printer from the Print Using dropdown.
6. Click Add.
On Serendipity Megarip

Now that the printers are configured for Windows and Mac, an output from Serendipity Megarip to the printer needs to

be setup.

For this example, a setup for the HPT1100 is required. The Pagesetup is the
same as if you were driving the device directly. The only part that changes is the
Destination section, as this configures the method by which the print job is
delivered to the device.

1. Open the Workbench and choose the Output to be used to print to.
2. Make sure the driver matches the output device.
3. In the Destination panel (bottom) select the driver to be Local Print

Queue.
4. Enter the path (which is the name of the printer created on the Mac).

For this example, hp_t1100_via_tanglefoot is entered.

v

Save the output configuration and test it.
6. Send a test print and check it is successful.

Serendipity Megarip Server Running on Windows

806 - NFR (not for

d m

Browse | A

Data types.
Calcheck Chart

® DotGain Curve

A Gradation Curve

A ICC Tweak Set
% Job Genie
Output
Pagesewp
Pagesetup Pool
@ Paper Profile
MW Press

Ttems

»CTiff

1bit Screened
1bit Screened
1bit Screened
1bit screened:
a3_test
A4 PDF

AS PDF
anything

Queue Destination

»(_15ep Colour Testing

» _IXante deimpositon

-separ...

A4 PDF 90 degree R...

7 T
vl | [uses ¥ Type

0 [anythind _Joutput

@HP-T110... Paper Profile

A hpt1100-... Gradation Cu...

1200dpi
AKA Bob.

Collating

Queue

Output Driver: | HP Designjet T1100

Status
@ Active

7 Inactive
AutoPause
[ Enable AutoPause

on  :om  [:os

Destination

Destination Driver: |_Local print queue

AutoClean
¥ Enable AutoClean
Jobs to Keep:

30 Jobs

Path: hp_t1100_via_tanglefoot

If the Server is running on a Windows machine, the output can be configured to print to any configured printer. This is
very simple to setup and can be used if the printer is connected to the network, or to the machine via parallel port, USB

or FireWire.

Local Windows Printer

The first section of setting up the printer on Windows is the same as that
described for the Mac above. The only difference is that if the printer is on
the same machine as the Server, there is no need to share the device.

Destination

Destination Driver: | Local print queue :_l

Path: IH P Designjet T1100 24in HPGL2

1. Inthe Workbench, select the output and choose Local Print Queue for the destination.

The path entered is exactly the same as the name of the printer.

As per the previous example, HP Designjet T1100 24in HPGLZ2 is entered in the path.
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Remote Windows Printer

If the printer is located on another Windows machine, there are two methods that can be used to print to it - either
directly to the shared printer, or install a local printer to print to it. Both still set the destination driver to be Local Print
Queue.

To print direct to the shared printer, in the path use the following format:

\\<machinename>\<printer> or Destination

Destination Driver:l Local print queue LI

Path: l\\tanglefoot\H P-T1100-on-tangy

\\<machinename>\<printer share name>

For this example, the path would be:
\\tanglefoot\HP Designjet T1100 or \\tanglefoot\HP-T1100-on-tangy

To print to the Windows printer when it is on another machine, a local printer needs to be configured on the same
machine as the Serendipity Megarip is running on.

To do this:

1. Choose Add Printer in the printer section of p
* Create a new port:

Windows. Type of port: ad

2. Choose a Local printer.

3. Create a new local port.

4. Enter \\<machine name>\<printer share name> (e.g. \\tanglefoot\HP-T1100-on-tangy)

5. Select an appropriate driver. Use the one for the printer or choose the generic one, as the Server will create the
file in the correct format.

6. Enter an appropriate name for the printer. Port Name

7. Decide if the printer will be the default and if it will be
shared, there if no need to share the printer for Serendipity Enter.a port neme:
Megarip to connect to it. I'\\tanglefoot\HP-ﬂ100-0n-lang5l Cancel |

8. In the Destination section of the Workbench, select Local
Print Queue as the driver.

9. Enter the path of the local name used. For this example it is “T1100- | Destination
on-tanglefoot”. Destination Driver: | Local print queue v |

Path: | T1100-on-tanglefoot

Note: Whenever you are printing to a local or remote printer, the QueueManager will report the job as Done very
quickly. This does not mean the job has printed successfully. As the destination is a print spooler, as soon as the job is
passed to the print spooler, the QueueManager is finished with it. Some control is lost from within the Client interface,
as jobs will be passed as soon as they are done (unless you set print pages direct on the printer properties).

If there is a problem printing to the printer, the Windows printer will alert you to this, not the Client. As far as the Client
is concerned, the task has completed and it is finished with the job.
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Troubleshooting

Clustering
Here are some suggestions of where to look if you run into trouble and experience problems when using a Cluster.

Jobs Not Processing Through a Cluster Node
The possible reasons for this are:

Here the Cluster Node called “pomelo” is currently offline. In this | >/2ve Nodes

case, you would check the node server is up, the machine is still '?3’?;2 168348 :;:/“:swdevelse '75?;‘; ";':r
connected to the network and can see the Master. If there is a "~ @ Imaging

problem with the node, check the error log. One the problem is ™ Rendering

resolved, click the Refresh button or close and reopen the vy thmaQng

ClusterManager. ™ Rendering

The Cluster Node is not configured to image, render or both. Check the ClusterStatus to see if either of the
processing tasks have been disabled. To enable them, open the ClusterManager and enable the appropriate
task.

The Cluster Node has a Processing Pool attached and the Pagesetup you are submitting jobs to is not contained
within the Pool. You can either unselect the Pool or add the Pagesetup to the Pagesetup Pool.

The Cluster Node has gone offline. To check, open the ClusterManager and check the node. If the
ClusterManager is already open, click the Refresh button. This will check for node status. If the node appears
grayed out or disabled, this indicates the node is not currently online.

The Node and Master are different versions. The node
should always be upgraded when the Master is to maintain the same versions in a Cluster.

Cluster Nodes Errors Log

The Cluster Nodes create an error log, which logs all the messages from the node. This is located in the Megarip
installation directory on the node’s own machine and is called “errors.log”. This can be viewed with a normal text editor
and can help to track a problem, or it can be sent to support for assistance in tracing a problem.

A Node Cannot Be Found
Once you have started your node successfully, you should be able to see it in the ClusterManager. If not, you need to add
the node manually. If this fails, there are a few things to check:

Verify the node is still running and the clock is still counting up.
Check the error log for any messages.
Check that the Master machine can ping the node machine. If not, there may be a network issue and you will
need to contact your network administrator for assistance.
Check the ports on the machines are open for the node to connect to the Master and they are not being used by
anything else. The port numbers for the node are as follows:

o 9103/tcp - Server connects here and submits jobs via this port.

o 9103/udp - Listens to broadcasts so the Server can enumerate available Node Servers.
Make sure the node is the same version as the Master. Nodes (Megarip Slaves) should always be upgraded at
the same time as the Master.
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Printing to a Windows Printer

Here are some suggestions of where to look if you run into trouble and experience problems when printing,.

For all of the methods documented in this guide, test each step to see where the problems arise. For example, when a

printer is created, try printing a test page.

Printing From Mac to Windows

When printing from a Mac to a shared Windows printer, there are a couple of utilities available to verify whether or not

the printer is installed correctly and working. These are:

The CUPs printing system on the Mac has a web interface that lets you view and test

printers. To access this, do the following:

1. Open a web browser and enter the following address:

http://localhost:631
a. This will connect to the local print system.

2. Choose Manage Printers and the list of printers configured on the

Mac will appear.

3. Scroll down the list to locate the printer. A detailed description of

the printer is available here.

4. Print a test page to the Windows printer. This will determine if the
connection from the Mac to the Windows device is valid. The test

job should appear in the Windows print spooler.

/" & hup://localhost:631/

HP_LaserJet_3030__

Description: HP LaserJet 3030 @ tangelo
elo

Location: tangek
Printer Driver: HP LaserJet 3020 3030
Printer State: idle, accepting jobs, not published.
IIHP

Device URI:

Laserjet_2100

Set As Default ) Set Alowed Users

_ipp._tep.local.

Description: Laserjet 2100
Location: Back shelves of office
Printer Driver: HP LaserJet 2100 Series
Printer State: idle, accepting jobs, not published
Device URI: ipp://kronos/printers/ijetd

Print Test Page Y St

xante

Print Test Page
Move All jobs
Cancel All Jobs

Set Printer Options

Publish Printer Modify Printer

Delete Printer

Set As Default Set Allowed Users

Description: xante
o

Location:
Printer Driver: Xante CL30 v3 (PS)
Printer State: idle, accepting jobs, not published.
Device URI: socket//xante/?bidi

As mentioned earlier, if a name is created with spaces or hyphens these are transposed to underscores for the actual
printing device. Below shows an example where the description appearing in the Mac Printer Utility list has spaces in

the name. Through CUPs the actual device name is shown.

my_printer_with_spaces
Default Destination: Laserjet kronos

{0 s Wil suace. Generie PostSeript Printer

Description: my printer with spaces
@ Location:

Printer State: idle, accepting jobs.
Device URL: smb?//anglefooUHP-T1100-on-tangy

Generic PostScript Printer

Description: my printer with spaces

Location:

Printer State: idle, accepting jobs.

Device URL: smb://tanglefoot/HP-T1100-on-tangy

The description still contains the spaces but the actual device being printed to has underscores. In this instance, the

path used in destinations would be “my_printer_with_spaces”.
Another way to check the status is to use the terminal.

1. Open aterminal from the Applications > Utilities folder
In the terminal type:

Ipstat -p

This will report on all printers configured on the Mac.

2. Search for your printer in the list and verify the name. The format will be like:

printer my_printer_with_spaces is idle. Enabled since Jan 01 00:00

3. Try and print from the terminal. Locate a print file (run a test job with the correct driver and find the file in the
raster folder in the installation directory) and type the following on the command line:

lp -P<printer> <jobname>

For the example of a HP printer, we can type the following: Ipr -Php_t1100_via_tanglefoot Quickcal 230166.rtl
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This should submit the rtl file created by the Server to the printer spooler.

You must be in the raster folder when the command is typed or if not, enter the full path to the file, for e.g,
Applications/Serendipity/Serendipity Megarip/raster/Quickcal_230166.rtl.

The Mac Spooler Reports “NT_ACCESS_DENIED”

This means that the print system cannot access the printer. It may be that there are insufficient privileges for the user
trying to connect, the username and/or password could be incorrect, or the username and password part of the string
have been forgotten.

Client Error
When testing with Ipr or from Serendipity Megarip and the error “client-error-not-found” is seen, it means it is unable
to find the printer the file is being sent to. Check to make sure the name of the printer is correct.

Unable to Print to Remote Windows Printer
This can happen from Mac or Windows.

If you are on a Windows machine and are creating a new printer to connect to the remote printer but it fails to find the
path, make sure the remote printer is shared and the name is correct.
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Glossary

Client - GUI that monitors jobs and allows configuration of the Server.

Clustering - The use of multiple machines on a network for distributed processing.

CMM - Colour Management Module.

CRT - Cathode Ray Tube. Describes the type of monitor.

CTP - Computer to Plate.

CUPS - Common UNIX Printing System.

Data Types - Database groups such as Pagesetups or RIPs etc.

DPI - Dots Per Inch (resolution).

EPS - Encapsulated Postscript File.

FTP - File Transfer Protocol - Method for copying files between computers across networks.
GUI - Graphical User Interface.

ICC - International Color Consortium.

ICC Profile - A colour lookup table used for converting colour of a job from one device to another.
LAN - Local Area Network.

LCD - Liquid Crystal Display.

LPI - Lines Per Inch (Screen Ruling).

Master - A Master Server, controlling Slave nodes in a Clustering environment.
QueueManager - Client module that displays job queues and jobs in those queues.
QueueStatus - Monitors the progress of a job through the system.

Real Density - Colour content of a patch as measured.

RIP - Raster Image Processor.

Server - Software module that handles the processing of jobs.

Slave (Node) - A separate processing node on the network. Used for processing jobs by a Master.
TCP/IP - Transmission Control Protocol / Internet Protocol.

Visual Density — The darkness of the patch measured (how much light is absorbed). The more light absorbed, the
darker the Visual Density.

WAN - Wide Area Network.
Workbench - Client application used to configure the Server.
YN - Yule Nielsen Number.

Yule Nielsen Number - A “fudge factor” used when calculating % tint (dot area) from density readings.
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Copyright Notices

PNG Library Copyright
Copyright © 1995, 1996 Guy Eric Schalnat, Group 42, Inc.

Contributing Authors: Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim Wegner.

The contributing authors would like to thank all those who helped with testing, bug fixes and patience. You know who
you are. This wouldn’t have been possible without all of you.

Thanks to Frank J. T. Wojcik for reviewing the documentation.

The PNG Reference Library is supplied “as is”. The Contributing Authors and Group 42, Inc. disclaim all warranties,
expressed or implied, including without limitation, the warranties of merchantability and of fitness for any purpose.
The Contributing Authors and Group 42, Inc. assume no liability for damages, direct or consequential, which may result
from the use of the PNG Reference Library.

Permission is hereby granted to use, copy, modify and distribute this source code, or portions hereof, for any purpose,
without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.
2. Altered versions must be plainly marked as such and must not be misrepresented as being the original source.
3. This Copyright Notice may not be removed or altered from any source or altered source distribution.

Compression Library Copyright
Copyright © 1995 Jean-loup Gailly and Mark Adler.

This software is provided “as is”, without any express or implied warranty. In no event will the authors be held liable
for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications and to alter it
and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original
software. If you use this software in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original
software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly and Mark Adler.

gzip@prep.ai.mit.edu madler@alumni.caltech.edu

Independent JPEG Group’s Copyright

The authors make no warranty or representation, either express or implied, with respect to this software, its quality,
accuracy, merchantability, or fitness for a particular purpose. This software is provided “as is” and you, its user, assume
the entire risk as to its quality and accuracy.

This software is copyright © 1991, 1992, 1993, 1994, 1995, Thomas G. Lane. All Rights Reserved except as
specified below.

Permission is hereby granted to use, copy, modify and distribute this software (or portions thereof) for any purpose,
without fee, subject to these conditions:

1. If any part of the source code for this software is distributed, then this README file must be included, with this
copyright an no-warranty notice unaltered; and any additions, deletions, or changes to the original files must
be clearly indicated in accompanying documentation.
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2. If only executable code is distributed, then the accompanying documentation must state that “this software is
based in part on the work of the Independent JPEG Group”.

3. Permission for use of this software is granted only if the user accepts full responsibility for any undesirable
consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library. If you
use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author’s name or company name in advertising or publicity relating to
this software or products derived from it. This software may be referred to only as “the Independent JPEG Group’s
software”.

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all
warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder,
Aladdin Enterprises of Menlo Park, CA. ansi2Zknr.c is NOT covered by the above copyright and conditions, but instead
by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you
redistribute it. (See the file ansiZknr.c for full details). However, since ansiZ2knr.c is not needed as part of any program
generated from the IJG code, this does not limit you more than the foregoing paragraphs do.

“The Graphics Interchange Format © is the Copyright property of CompuServe Incorporated. GIF (sm) is a Service Mark
property of CompuServe Incorporated.”

Copyright © 1980, 1993
The Regents of the University of California. All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following

acknowledgment:

This product includes software developed by the University of California, Berkeley and its contributors.

5. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

>

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 1990, 1994 Regents of the University of Michigan
All Rights Reserved.

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is
hereby granted, provided that the above copyright notice appears in all copies and that both that copyright notice and
this permission notice appear in supporting documentation, and that the name of The University of Michigan not be
used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
This software is supplied as is without expressed or implied warranties of any kind.

This product includes software developed by the University of California, Berkeley and its contributors.

97 Serendipity Megarip User Manual - Version 5



Code in sys/linux is developed by Alan Cox. You may redistribute it and/or modify it under the terms of the GNU
General Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

Research Systems Unix Group
The University of Michigan
C/0 Wesley Craig

535 W. William Street

Ann Arbor, Michigan
+1-313-764-2278
netatalk@umich.edu

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright © 1989, 1991 Free Software Foundation, Inc.

675 Mass Ave,
Cambridge,
MA 02139, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software-to make sure the
software is free for all its users. This General Public License applies to most of the Free Software Foundation’s software
and to any other program whose authors commit to using it. (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead). You can apply it to your programs, too. When we speak of
free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source
code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you
know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the
rights that you have. You must make sure that they too, receive or can get the source code. And you must show them
these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced by others will not reflect on the original
author’s reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we
have made it clear that any patent must be licensed for everyone’s free use or not licensed at all. The precise terms and
conditions for copying, distribution and modification follow.
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GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder

saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to any
such program or work, and a “work based on the Program” means either the Program or any derivative work
under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with
modifications and/or translated into another language. (Hereinafter, translation is included without limitation
in the term “modification”). Each licensee is addressed as “you”.
Activities other than copying, distribution and modification are not covered by this License; they are outside its
scope. The act of running the Program is not restricted, and the output from the Program is covered only if its
contents constitute a work based on the Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License along with the Program.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

c. If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a notice that there is no warranty (or
else, saying that you provide a warranty) and that users may redistribute the program under these
conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is
interactive but does not normally print such an announcement, your work based on the Program is not
required to print an announcement).

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Program, and can be reasonably considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Program. In
addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the
Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you also do one of the following:

a. Accompany it with the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

b. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,

c. Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above).

The source code for a work means the preferred form of the work for making modifications to it. For an executable
work, complete source code means all the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable.
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If distribution of executable or object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4,

10.

11.

You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their Licenses terminated so long as such parties remain in full
compliance.
You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if
you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Program or works based on it.
Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.
If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you
cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license
would not permit royalty-free redistribution of the Program by all those who receive copies directly or
indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely
from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply and the section as a whole is intended to apply in other
circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people
have made generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of
this License.
If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in
or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the
body of this License.
The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of
this License which applies to it and “any later version”, you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Program does not specify a version number of this License, you may choose any version ever
published by the Free Software Foundation.
If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will
be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting
the sharing and reuse of software generally.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO
THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
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AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Appendix: How to Apply These Terms to Your new Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve
this is to make it free software which everyone can redistribute and change under these terms.

To do so, attached the following notices to the program. It is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to
where the full notice is found.

<one line to give the program’s name and a brief idea of what is does>
Copyright © 19yy <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General
Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, write to the
Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

Also add information on how to contact you by electronic and paper mail.
If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright © 19yy name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type “show w”. This is free software, and
you are welcome to redistribute it under certain conditions; type “show c” for details.

The hypothetical commands “show w” and “show c” should show the appropriate parts of the General Public License. Of
course, the commands you use may be called something other than “show w” and “show c”; they could even be mouse-
clicks or menu items-whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright
disclaimer” for the program, if necessary. Here is a sample; alter the names:

Yoyodyne Inc., hereby disclaims all copyright interest in the program “Gnomovision” (which makes passes at
compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989

Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is
a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this
is what you want to do, use the GNU Library General Public License instead of this License.
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Copyright
The XFree86 Project, Inc.

Copyright © 1994, 1995 The XFree86 Project, Inc. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software. THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE XFREE86 PROJECT BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of the XFree86 Project shall not be used in advertising or otherwise to
promote the sale, use or other dealings in this Software without prior written authorization from the XFree86 Project.

$XConsortium: CPYRIGHT.sgml,v 1.2/95/01/16 13:17:39 kaleb Exp $

Generated from XFree86: xc/programs/Xserver/hw/xfree86/doc/sgml/CPYRIGHT.sgmlv 3.3 1995/01/28 16:01:20
dawes Exp $

$XFree86: xc/programs/Xserver/hw/xfree86/doc/COPYRIGHT,v 3.8 1995/07/24 06:52:11 dawes Exp $
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